## Contents

**About This Book** .................................................. i  
  Tracktion Waveform User Guide .................................. i  
  A Note About Illustrations & Media .............................. ii  
  Don’t Print Suggestion ............................................. ii  
  About the Author .................................................. ii  

**Chapter 1 - Introduction** ........................................ 1  
  What’s New in Waveform 8? ....................................... 1  
  What’s in this User Guide? ....................................... 1  
  Video Resources .................................................. 2  
  Setting Waveform Keyboard Shortcuts .......................... 2  
  Modifier Keys Conventions ...................................... 5  
  Assigning the Duplicate Command to the Keyboard .......... 5  
  Moving On ......................................................... 6  

**Chapter 2 - Installing Waveform** ................................. 7  
  Your Tracktion Account ......................................... 7  
  Should I Install 32-bit or 64-bit? ............................... 8  
  Installation ....................................................... 9  
  macOS Installation ............................................... 9  
  Windows Installation ............................................ 9  
  Linux Installation ............................................... 9  
  Running Waveform for the First Time ......................... 10  
  Pop-up Help ....................................................... 10  
  First Run Setup Progress ....................................... 11  
  Installing Melodyne Essential .................................. 13  
  Moving On .......................................................... 14  

**Chapter 3 - Installing the Demo Projects** .................. 15  
  Establish a Waveform Projects Folder ......................... 15  
  Project Tab: Get Demo Songs ................................... 15  
  Moving On .......................................................... 17  

**Chapter 4 - Audio Device Setup** ............................... 18
CONTENTS

Audio Device Setup Setup on macOS ........................................ 18
Audio Device Setup in Windows ............................................. 20
Choosing the Audio Interface .................................................. 21
Setting the Sample Rate .......................................................... 22
Testing for Audio Playback ...................................................... 23
About Latency ......................................................................... 24
Managing Latency .................................................................. 25
Calibrating Input Latency Compensation ................................. 25
Other Audio Device Settings .................................................... 28
Resetting to the Defaults ....................................................... 29
Moving On ................................................................................ 29

Chapter 5 - Getting Around in Waveform ................................... 31
Tabs and Menus ....................................................................... 31
Controls Panel & Toolbar .......................................................... 32
Pop-up Help ............................................................................ 33
Roll-over Help ......................................................................... 33
Creating a Project .................................................................... 34
Opening the Edit ...................................................................... 36
The Edit Tab ............................................................................ 37
Basic Navigation ...................................................................... 37
Zooming In and Out ............................................................... 37
Quick Zoom Tool ..................................................................... 38
Positioning the Cursor ............................................................. 39
Scroll Behaviour ..................................................................... 40
Changing the Tempo ................................................................ 41
Changing Tempo at a Specific Bar ............................................ 42
Offsetting and Scaling the Tempo Curve ................................... 43
Moving On ................................................................................ 44

Chapter 5b - The Projects Tab .................................................. 45
Project Tab - Three Column View ............................................ 45
Project Tab - Edit Previews ...................................................... 46
Project Tab - Get Demo Songs .................................................. 47
Moving On ................................................................................ 47

Chapter 6 - The Settings Tab ..................................................... 48
Audio Devices Page ................................................................. 49
MIDI Devices Page ................................................................. 49
Plugins Page ............................................................................ 49
General Behaviour Page ........................................................ 49
Automatically Hide and Show Panels ....................................... 52
Other Settings ......................................................................... 52
## Chapter 10 - Using Markers

- In-marker & Out-marker ......................................................... 92
- Drag to Set In-Marker & Out-marker ..................................... 93
- Timeline Drag to Set In-marker & Out-marker ...................... 93
- Navigate Using the In-marker & Out-marker ......................... 93
- Zooming to the In-marker/Out-marker .................................. 94
- Looping Playback Over the Marked Region ......................... 94
- Auto Punch and the Marked Region ....................................... 94
- The Marker Track ............................................................... 95
- Adding Markers .................................................................. 96
- Marker Clip Properties ....................................................... 97
- Navigating by Markers ....................................................... 99
- The Browser Markers Tab .................................................... 99
- Renumbering Markers ....................................................... 101
- Adjust Markers (Wave File Markers) .................................... 101
- Moving On ........................................................................ 102

## Chapter 11 - Selecting and Snapping

- Selecting a Clip .................................................................. 103
- Auditioning a Clip .............................................................. 103
- Selecting Multiple Clips ..................................................... 104
- Shift Selecting Clips ............................................................ 105
- Deselecting Clips ............................................................... 105
- Using Snap-to-Grid ............................................................. 105
- Enable/Disable Snap-to-Grid .............................................. 105
- About Snap Resolution ...................................................... 106
- Snapping Clips to the Grid .................................................. 106
- Snapping the Cursor to the Grid ....................................... 107
- Snapping Clips to Other Clips ............................................. 107
- Overriding Snap-to-Grid .................................................... 108
- Nudging Clips .................................................................. 108
- Nudging Notes .................................................................. 108
- Moving On ........................................................................ 109

## Chapter 12 - Audio Clips and Editing Audio

- Parts of an Audio Clip .......................................................... 110
- Moving Clips ................................................................... 112
- Deleting Clips ................................................................... 113
- Audio Clip Handles ............................................................. 113
- Splitting a Clip ................................................................. 115
- Duplicating Clips ............................................................... 115
- Fade-in/Fade-out ............................................................... 116
- Pitch Fade ....................................................................... 117
## Contents

Crossfades ......................................................... 117  
Drag Crossfade .................................................. 118  
Edge Fades ......................................................... 118  
Copy and Paste .................................................... 118  
Clip Gain, Mute, & Pan ............................................ 119  
Reversing Audio Clips ............................................ 120  
Merging Clips to One Clip ....................................... 120  
Group Clips ........................................................ 121  
Linked Clips ........................................................ 123  
Deleting a Section of Audio Removing Space .................. 125  
Edit with Melodyne ................................................ 126  
Moving On ......................................................... 128

### Chapter 13 - Working With Loops .................................. 129  
Getting Loops Into Waveform .................................... 129  
Setting the Edit Tempo .......................................... 129  
Dragging Loops to a Track ....................................... 130  
Dragging in Multiple Clips from the Browser ................. 130  
Looping the Loop .................................................. 130  
Duplicating Clips .................................................. 131  
Loop Properties .................................................... 132  
Moving On ......................................................... 134

### Chapter 14 - Keyboard Shortcuts ................................. 135  
Keyboard Shortcuts Page .......................................... 135  
Setting a Keyboard Shortcut ..................................... 135  
Changing a Keyboard Shortcut ................................... 136  
Saving Keyboard Shortcuts to a File ......................... 137  
Loading Keyboard Shortcuts from a File ...................... 137  
Printing a List of Keyboard Shortcuts ......................... 138  
Moving On ......................................................... 138

### Chapter 15 - Recording Audio .................................... 139  
Configure the Input .............................................. 139  
The Input Object .................................................. 139  
Customizing Input Names Globally ............................. 141  
Customizing Input Names for an Edit ......................... 141  
About MIDI Inputs ................................................ 141  
Setting Up Inputs for Multi-track Recording ................. 142  
Number of Inputs .................................................. 142  
Enable a Track for Recording .................................... 143  
Hit Record .......................................................... 144  
Enable Recording for All Inputs at Once ..................... 144
# Contents

Input Meters ................................................. 144  
Dragging the Input Object Track to Track .................. 145  
Renaming a Track ........................................... 145  
Recording Steps in Review .................................. 145  
Working with the Click ...................................... 146  
Enabling the Click Track .................................... 146  
Listening on Headphones While Recording ................. 149  
Live Input Monitoring ....................................... 149  
If at First You Don’t Succeed ............................... 150  
Abort Record and Delete the Take ......................... 151  
Recording a Stereo Signal .................................. 151  
Retrospective Record ....................................... 152  
Safe-Record Mode ........................................... 153  
Moving On ....................................................... 153  

## Chapter 16 - Recording Overdubs .......................... 154  
Set up the Drum Loop ....................................... 154  
Get Ready to Record ........................................ 155  
Record the Rhythm Guitar Part .............................. 155  
Doubling the Rhythm Guitar ................................ 156  
Overdub a Bassline .......................................... 157  
Rename Tracks ............................................... 158  
Adding Additional Tracks .................................. 159  
Rearranging Tracks ......................................... 160  
Adjust the Mix ............................................... 160  
Moving on ....................................................... 160  

## Chapter 17 - Clean-up Editing ............................... 161  
Trimming ....................................................... 161  
Correcting Small Timing Problems ......................... 162  
Correcting Timing by Slip Editing ......................... 164  
Fade-outs ...................................................... 166  
Stretch an Ending Note ..................................... 166  
Fixing Clicks at the Edit Points ............................ 167  
Rendering to a Single Audio Clip ......................... 168  
Moving On ....................................................... 169  

## Chapter 18 - Warp Time .................................... 170  
Warp Time Mode ............................................. 170  
The Warp Time Editor ....................................... 171  
Working with Warp Points ................................ 172  
Warp Points and Snapping .................................. 173  
Limitations of Warp Time editing ......................... 173
## Contents

**Time Stretch Algorithm** .......................................................... 173  
**Moving On** ................................................................................. 174

**Chapter 19 - Loop Recording** .................................................. 175  
Getting into Loop Recording Mode ............................................... 175  
Loop Recording Step-by-Step ....................................................... 175  
Selecting the Best Take ............................................................... 176  
Unpacking Takes to Tracks ........................................................... 177  
Moving on ...................................................................................... 177

**Chapter 20 - Comp ing** ............................................................. 178  
Copy Your Edit ............................................................................. 178  
Comp ing Takes ........................................................................... 179  
Flatten Comp ............................................................................... 181  
Setting up a Comp Group ............................................................ 182  
Comp ing Tracks Using a Comp Group ......................................... 184  
Comp Group Editor ...................................................................... 185  
Moving On .................................................................................... 186

**Chapter 21 - Using an Amp Simulator Plugin** ............................ 187  
Setting Up the Track ................................................................... 187  
Recording with the Amp Sim ......................................................... 191  
Managing Latency ....................................................................... 192  
Speed of Sound Through Air ....................................................... 193  
Dialing in the Guitar Tone ............................................................ 194  
Using a Tuner Plugin ................................................................... 194  
Moving On .................................................................................... 195

**Chapter 22 - MIDI Setup** .......................................................... 196  
MIDI Drivers ................................................................................ 196  
Set Up the MIDI Inputs ................................................................ 196  
Naming MIDI Inputs/Outputs ....................................................... 197  
Disabling Unused MIDI Inputs ..................................................... 197  
Configuring the Track .................................................................. 197  
Insert a Synth Plugin ................................................................... 198  
Using a Virtual Keyboard ............................................................ 199  
Moving On .................................................................................... 201

**Chapter 23 - MIDI Recording** .................................................... 202  
Setting up a Track ....................................................................... 202  
Recording a MIDI Performance ................................................... 202  
Playing Back a MIDI Performance .............................................. 203  
In-line Piano Roll View ............................................................... 204
CONTENTS

MIDI Record Modes - The Action Property .................................................. 204
MIDI Input Quantize ................................................................. 205
Moving On ........................................................................ 206

Chapter 24 - MIDI Loop Recording ......................................................... 207
  Loop Recording in Merge Mode ......................................................... 207
  Recording to Prepare for MIDI Comping ............................................. 208
  Comping MIDI Takes .................................................................... 209
  Flattening the Composite to a Single Clip .......................................... 210
  Moving On ........................................................................ 211

Chapter 25 - MIDI Editing .................................................................... 212
  Working with MIDI Clips ................................................................. 212
  Trimming MIDI Clips .................................................................. 212
  Moving MIDI Clips .................................................................... 212
  Moving a MIDI Clip Track-to-Track .................................................... 213
  Slip Editing MIDI Clips ................................................................. 213
  Reframing a MIDI Clip ................................................................ 213
  Splitting a MIDI Clip .................................................................. 214
  Determining MIDI Clip Key ............................................................ 214
  MIDI Note Editors ...................................................................... 216
  Setting the Number of Octaves & Note Height .................................... 217
  Mouse Wheel Options for MIDI Editing ............................................. 218
  Basic MIDI Editing - Pitch ............................................................... 218
  Per Note Automation .................................................................... 219
  Nudging Notes ........................................................................... 220
  Note Length ............................................................................... 220
  Snapping During Note Editing .......................................................... 221
  Copying and Duplicating Notes ........................................................ 221
  Adjusting Pitch and Velocity in Properties ........................................ 221
  Note Start, Length, & End ............................................................... 222
  The Pencil Tool .......................................................................... 222
  The Eraser Tool ........................................................................... 222
  The Line Tool ............................................................................ 223
  Note Colors ................................................................................. 224
  Selecting Multiple Notes ................................................................ 225
  Splitting Notes ............................................................................ 226
  Quantising Notes ....................................................................... 226
  Applying Groove ....................................................................... 228
  Legato Notes ............................................................................... 228
  Editing the Note Velocity ............................................................... 230
  Step Entry Mode ........................................................................... 231
  Hearing Notes While Editing ............................................................ 231
## CONTENTS

The Velocity Editor ........................................... 232
Editing other Controller Data ............................... 232
Shaping Controller Data ..................................... 233
Randomising Velocity Data ................................. 234
MIDI Editor View ............................................. 236
Working with Clips Across Multiple Tracks in the MIDI Editor .................. 240
Enter Chords ................................................... 242
Moving On ..................................................... 244

### Chapter 26 - Quantizing MIDI Notes .................. 245

How to Quantize ............................................. 245
Quantizing Note Lengths .................................... 246
Quantizing with Groove ..................................... 247
Defining Groove Templates ................................ 250
Complex Groove Templates ................................. 251
Managing Groove Templates ............................... 252
Moving On ..................................................... 253

### Chapter 27 - Step Clips ................................. 254

Step Clips Overview ......................................... 254
Inserting a Step Clip Into the Edit ...................... 256
Programming a Drum Beat with a Step Clip ............ 258
Step Clip Properties ........................................ 259
The Step Clip Footer ........................................ 261
Pattern Options .............................................. 263
Step Clip Pattern Actions ................................. 264
Step Clip Section Actions ................................... 265
Step Clip Channel Properties ............................. 266
Step Clip Channel Actions .................................. 268
Deleting a Channel .......................................... 269
Velocity Gate Editor ......................................... 269
Looping Step Clips .......................................... 271
Render a Step Clip to MIDI ................................. 272
Step Clip Presets ............................................ 272
Moving On ..................................................... 273

### Chapter 28 - Scanning Plugins ...................... 275

Scanning Plugins ........................................... 275
64-Bit Versus 32-Bit Plugins ............................... 276
Sorting the Plugins List .................................... 276
Setting the Style of the Plugin Object ................. 277
Building a Custom Plugin Selector ...................... 278
Opening Plugin Windows .................................... 279
Locking (Pinning) Plugin Windows .................................................. 279
Setting Tags ..................................................................................... 280
Moving On ....................................................................................... 280

Chapter 29 - Using Plugins .............................................................. 281
The In-line Mixer ............................................................................. 281
Adjusting the Size of the In-line Mixer Section ............................... 282
Working with Plugins ...................................................................... 283
Assigning a Quick Control Parameter ............................................ 285
Third-Party Plugins ........................................................................ 286
Searching for Plugins ...................................................................... 287
Using Master Plugins ...................................................................... 288
Using the Visual Plugin Selector ..................................................... 289
Determining Plugin Technology ...................................................... 291
Customizing the Thumbnail Image .................................................... 292
Scanning to Capture Thumbnails ...................................................... 292
Opening Visual Plugin Selector with a Shortcut ......................... 293
Plugin Sidechains .......................................................................... 294
Moving On ....................................................................................... 294

Chapter 30 - Built-in Effects Plugins ................................................. 295
Waveform Effects .......................................................................... 295
Volume & Pan Plugin ....................................................................... 297
Level Meter .................................................................................... 298
The 4-Band Equalizer ...................................................................... 300
Reverb ......................................................................................... 301
Delay ............................................................................................ 301
Chorus .......................................................................................... 302
The Phaser .................................................................................... 303
The Compressor/Limiter ................................................................. 303
Pitch Shifter .................................................................................. 304
The Low/High-Pass Filter .............................................................. 306
Text Plugin .................................................................................... 306
Saving Presets ............................................................................... 307
Moving On ..................................................................................... 307

Chapter 31 - Effects Bus Tracks ......................................................... 308
Create the Bus Track ...................................................................... 308
Adding the Effect Plugin ................................................................ 308
Aux Return Plugin .......................................................................... 309
Adding Aux Sends to the Channels ............................................... 310
Adjusting the Send Level ............................................................... 311
Assigning the Aux Bus ................................................................. 311
About This Book

Tracktion Waveform User Guide

Welcome to this user guide for Tracktion’s latest digital audio workstation - Waveform. While this is the first release of the Tracktion DAW under the Waveform name, we are starting with version 8. This important release ushers in a new era for the Tracktion software platform. Waveform has new editors, music creation tools, and finally, a traditional mixer view! Waveform builds on the Tracktion technology base and is the worthy successor to Tracktion T7. The look and feel has been refined and along with that comes the new name - Waveform.

If you are using earlier versions such as T5, T6, or T7 some of this content will be relevant. However, you will be be better served by previous guides available at tracktion.com\(^1\) or from Leanpub\(^2\). Better yet, consider upgrading to Waveform to access the full range of features.

\(\text{Note: This user guide is subject to revision during the entire release cycle.}\)

This manual is significantly improved and expanded. We are working toward complete coverage of Waveform’s rich feature set but there are still few gaps. These are some of the key things that aren’t fully covered:

- Control Surface Mapping
- Waveform Sampler
- Video integration
- Melodyne Integration
- Project Templates
- Waveform Archive format
- Freeze Points
- CPU Usage Meter

\(^1\)http://www.tracktion.com
\(^2\)www.leanpub.com
A Note About Illustrations & Media

This Waveform User Guide is generously illustrated with screen shots, diagrams, and video links. Some of these were created using earlier versions of the software.

Since the user interface has been updated in Waveform some of the illustrations vary in style and color from this version. Where the layout or features have changed significantly we have made an effort to update them. If you find something that is really off, please send a message to support@tracktion.com.

Don’t Print Suggestion

Some of you love to have a printed reference and we understand that. Don’t be too upset if the day after you print out 400 plus pages that an update is released. Updates will potentially be released along with or following new revisions of the software. That’s just the way it is with software!

About the Author

This user guide was written by Bill Edstrom and has been revised and expanded from the prior independently released books “Guide to Tracktion T6” and “Guide to Tracktion T7.” Mr. Edstrom has extensive knowledge of Tracktion software and has create numerous video tutorials published by Groove3.com as well as books on other DAWs published by Hal Leonard Books.
Chapter 1 - Introduction

Welcome to the *Waveform User Guide*. The goal of this book is to help you learn the Waveform digital audio workstation software. If you are coming to Waveform from another DAW, or learning computer recording from the ground up, you will find this guide useful. This book will be particularly interesting to those who already have experience with Traktion. Waveform has dozens of innovative features, and this latest version streamlines the workflow while adding key features such as a detachable “traditional” mixer view and flexible, creative new MIDI editing tools, all while making the software more powerful than ever.

Waveform runs on both macOS and Windows as well as Linux. All versions are maintained in parallel; as a result the latest revisions are nearly identical across all three platforms.

Waveform, like its predecessors, has a unique design where you can do editing and mixing in the same tabbed window. The arrangement has tracks followed by an in-line mixer channel integrated to the right of each track.

By popular demand Waveform adds a traditional style Mixer view that docks below the arrangement, or can be split off to a separate tab or second monitor. If you loved the way Traktion’s in-line mixing worked you can keep the Mixer view closed and forget it. However, if you come from music production from hardware mixing desks or other DAWs that have a console view, you now have a familiar and friendly way to interact with Waveform.

And don’t forget Waveform has a very flexible plugin architecture that includes native plugins, plugin racks, and support for VST, VST3 and AudioUnits plugins.

What’s New in Waveform 8?

Waveform 8 has many new and exciting features that enhance the workflow and open up new creative potential. Please refer to Appendix C - New Features for the complete list of changes.

What’s in this User Guide?

In this user guide you will learn:

- How to install and set up Waveform
- How to record audio to tracks
- How to record MIDI and use virtual instruments
- How to record with guitar amp simulators
• How to edit audio
• How to edit MIDI
• How to mix with the inline mixer section
• How to insert and use plugin effects
• How to mix down to Wave or MP3 files
• Using musicality tools like the pattern generator, chord player, and step clips
• Using the detachable mixer view
• Using powerful clip layer effects
• And much more!

Waveform User Guide presents the information in a combination of step by step workflows, diagrams, screenshots, video links, and point by point references. We made every effort to present the topics in a logical order however we expect you will use it as a reference. If you want master Waveform, it is a great idea to read this entire guide and watch the linked videos while working on real projects.

**Tip:** Please make sure to go to the Waveform website[^3] and make sure that your installation of Waveform is fully up-to-date.

### Video Resources

Several training videos are available that cover many useful areas. Please refer to the training section at [Tracktion.com[^4]] for more details.

Many topics are demonstrated in videos at [Groove3[^5]] and on [YouTube[^6]].

Some topics include video links to Youtube that show the software in action. The links are clickable if you are reading an electronic version. Links also appear as footnotes at the bottom of any page that has links. We have collected most of those links into Appendix A - Video Links for quick reference.

### Setting Waveform Keyboard Shortcuts

This book uses the default Waveform key mappings for shortcuts. You will need to use that setup to follow the examples. If you changed your shortcut settings, do the follow steps to set them back to the default:

1. Navigate to the Settings tab, Keyboard Shortcuts page

[^3]: www.tracktion.com
[^4]: www.tracktion.com
[^5]: www.groove3.com
[^6]: http://goo.gl/YnaOMd
2. Click *Reset to Defaults* at the bottom of the page
3. Select *Restore Waveform default key mappings*
Settings Tab: Set the Keyboard Shortcuts to Match this Book
These keyboard shortcuts have been carefully designed for efficient workflow and in a way that keeps the commands consistent between macOS and Windows.

**Modifier Keys Conventions**

The book uses the following abbreviations for modifier keys:

- Command: Cmd
- Control: Ctrl
- Option: Opt
- Alt: Alt

In most cases ‘Cmd’ on macOS will translate to ‘Ctrl’ on Windows. In this user’s manual, we present both using the convention MacOS / Windows. For example - Cmd + C / Ctrl + C.

**Here is an example in context:**

Click to select the clip, then copy it using Cmd + C / Ctrl + C.

Next, position the cursor in the Arrangement where you want to place the copy and paste, using Cmd + V / Ctrl + V.

**Note:** Most Linux users will use the ‘Meta’ key in place of Alt. On a typical PC keyboard, Meta is usually the Windows key.

**Assigning the Duplicate Command to the Keyboard**

The Duplicate action is not mapped to the keyboard by default. To match the book examples, assign the ‘D’ key to duplicate. Here is how to do that:

1. Navigate to Settings tab, Keyboard shortcuts page
2. Locate the *Duplicate* command. It’s in the *Editing Functions* section
3. To the right of *Duplicate*, press the plus (+) icon
4. The *New key-mapping* dialog box appears
5. Press D key, then click OK
Moving On

With those things set, your Waveform installation will match the examples in this book. Get ready to learn all about Waveform!
Chapter 2 - Installing Waveform

Most likely, you already installed Waveform. If you haven’t yet, or have any questions about installation, keep reading.

Your Tracktion Account

Go to www.tracktion.com. Navigate to Account > My Account. If you haven’t yet purchased Waveform, you can choose to download the demo, or purchase a license. If you received an earlier version of Waveform or Tracktion when you purchased a mixer or audio interface, then you can upgrade to the current Waveform version at a nice discount. Regardless, create an account on the Tracktion website if you haven’t already done so.

Customer Login at Tracktion.com

After you log in, you will see your licenses listed. Click on My Downloadable Products and choose the Waveform version you want to install.

---

7https://marketplace.tracktion.com
Should I Install 32-bit or 64-bit?

On the Tracktion site, navigate to Account > Downloads. That opens a set of tabs where you can choose which version to download: 32-bit or 64-bit.

The sound quality is the same between the 32-bit and 64-bit versions of Waveform. The decision is about compatibility with your computer and plugins.

Tip: We highly recommend you use the 64-bit version for your installation and commit to using an appropriately equipped computer, operating system, and plugins.

Waveform 32-bit:

- Runs on either 32-bit or 64-bit operating systems
- Runs only 32-bit plugins
- Can access up to 4 GB of RAM

Waveform 64-bit:

- Runs on ONLY 64-bit operating systems
- Runs only 64-bit plugins
- Can access more than 4 GB of RAM
The key point to keep in mind is: If you want to run older 32-bit plugins, use the 32-bit installation of Waveform. If your computer has more than 4GB of RAM, then running the 64-bit version allows you to load more instances of large virtual instruments.

**Warning:** If you use the 64-bit version, Waveform will not recognize your 32-bit plugins. If you rely on 32-bit plugins for your recordings then you must use the 32-bit version of Waveform.

Click on the link to download the installer.

## Installation

The installation varies slightly between macOS and Windows. Separate sections follow for the two operations systems.

### macOS Installation

The installation file for macOS has a `.dmg` file extension, typical of most macOS installers. Double-click the file to open the disk image. You will see the Waveform application icon.

Drag the Waveform application icon to the applications folder, which is conveniently aliased right next to it. That’s it, Waveform is now installed. You will still need to authorize it, a process that will be described below.

### Windows Installation

The installation file on Windows has a `.exe` file extension, typical of most Windows installers. Double-click the file to begin the installation wizard.

Step through the wizard to tell Waveform where you want it to be installed. In most cases, the defaults will work best.

### Linux Installation

There is a separate Linux section on the Accounts > Download page on the Waveform website. There you will find the latest 64-bit build in the form of a Debian package (.deb). If you are running Ubuntu, simply download the file, then double click and install the package.

For more about running Waveform on Linux, please refer to the [Linux FAQ](http://goo.gl/XUNiwA) on the KVR website.

---

8[http://goo.gl/XUNiwA]
Running Waveform for the First Time

To launch Waveform on macOS, locate Waveform in the applications folder, then double click the icon.

In Windows, locate Waveform in the Start Menu, then launch it and Waveform will start up. The Waveform window initially has two tabs: Projects and Settings. Later on, your songs, called ‘Edits’ in Waveform, will load into additional tabs.

Waveform initially runs in demo mode. If you have a license, it is a quick and easy process to unlock it:

1. Select the Help > About menu item at the lower left of the Projects tab. This loads the About box. You will see all kinds of information about Waveform.
2. Locate and click the Unlock button.
3. Enter the address and password you used when registering at the Tracktion website, then click Register.

Waveform is now unlocked and ready to use on this computer.

Pop-up Help

As you start exploring Waveform, you will soon notice pop-up help. Pop-up help balloons appear as you move the mouse pointer over objects on the window. While somewhat helpful, you may or may not wish to use them at all times.

To turn pop-up help off, click Help > Turn off pop-up help. The help button is located in the lower left corner of the Projects tab. You can easily reverse the process if you want pop-up help back.

Tip: If you ever want to see pop-up help while it is disabled, point to the object you’re interested in and hit F1.
First Run Setup Progress

When you run Waveform for the first time, you will see the *First Run Setup Progress* panel over on the left. As you click each item, it takes you directly to the page and feature on the Setup tab needed to complete the task. The tasks are designed to streamline setup and get new users configured and running quickly.
First Run Setup Progress Panel

If you close the panel and wonder how to get it back. Navigate to Help > Show First Run Setup.
Installing Melodyne Essential

Melodyne Essential is a terrific bonus for Waveform users. It adds powerful pitch and time manipulation to Waveform at no addition cost. Melodyne Essential is a separate installation and is provided under license from Celemony\textsuperscript{9}. Here are the basic steps to install and active it.

- Exit Waveform if it is running
- Go to the Tracktion website and log in (Account > My Account)
- On your Account Page copy or make note of the Celemony - Melodyne Essential license code listed there (Account > MyAccount)
- Go to the Celemony\textsuperscript{10} website then click login. Log in or create a new account.
- Follow the website instruction to register Melodyne Essential, download it, and install it.

Tip: Make sure to install Melodyne using its installer defaults. Waveform is integrated with the ARA technology of Melodyne, and should detected it on the next restart.

Note: Waveform also works with the full Melodyne Editor. If you already have that on your system, just check to make sure it is the latest version.

Note: Melodyne is not available for Linux or the Linux version of Waveform.

For more information on getting Melodyne Essential up and running check out TSC’s Melodyne Configuration Tips & Tricks\textsuperscript{11} page.

\textsuperscript{9}http://www.celemony.com
\textsuperscript{10}http://goo.gl/1dntgM
\textsuperscript{11}http://goo.gl/gUYiX
Moving On

At some point you will want to scan your existing plugins. You can learn how to do that in Chapter 28 - Scanning Plugins if you want to work ahead. That step is not necessary quite yet. Let’s move on to installing some demo projects!
Chapter 3 - Installing the Demo Projects

This chapter walks you through the process of installing some Waveform demo songs. The demos are very useful because they give you something to experiment with as you learn the basics of the application.

Establish a Waveform Projects Folder

It's a good idea decide where you want to keep your Waveform projects on your system. One method would be to create a Waveform folder, under the Documents folder on your system. So, decide on a location and create your Waveform folder using the Finder (macOS) or File Explorer (Windows).

Project Tab: Get Demo Songs

The Menu at the lower left of the Project tab includes a button - Get Demo Songs. Click that for a quick way to download the demos.
Get Demo Songs Dialog Box

Select the songs to download from the list, choose the destination folder then click Download. We suggest using your newly created Waveform project folder as the destination. You also have the option to show only new songs, meaning those you haven’t yet downloaded.

Downloading is handled in the background. Click the Progress Meter in the upper right corner to see how the downloads are progressing.

Checking the Progress of Demo Downloads

When the downloads are finished, the demo songs will appear at the bottom of your Active Projects list.

**Tip:** We suggest organizing the demo songs into a folder to keep them separate from your own projects.
Moving On

With Waveform installed and a few demo files ready to play with, it’s time to move on to configuring your audio interface.
Chapter 4 - Audio Device Setup

To use Waveform, it is essential to configure it to work with your audio interface. While Waveform does work with a computer’s internal audio, most users will use an external audio interface. Waveform supports Core Audio on macOS and ASIO and Windows Sound (WASAPI) on Windows.

Audio Device Page

**Warning:** To configure Waveform for recording, you must use the Auto-Detect feature along with a hardware loopback. If you don’t, then your overdubbed tracks will not be in alignment with existing tracks. While this is not difficult, it is essential to do this manual step anytime you change the Audio Device page. The procedure to do this is covered later in this chapter.

This chapter covers the essential steps to get your audio interface configured as an audio device in Waveform.

**Audio Device Setup Setup on macOS**

1. Click on the Settings tab then select the Audio Devices page.
2. Select an output device. Assuming you have the necessary drivers installed and the device hooked up, it should appear as an option for the *Output:* property.
macOS - Audio Device Output and Input Properties

Note: With macOS, USB audio interfaces that follow USB Audio Class 1 (1998) or USB Audio Class 2 (2009) will function without installing any additional driver. In the product specs for such devices they are often listed as “class compliant.”

1. Select an Input device

Tip: We strongly suggest that you select the same device for the output and the input. In this example, we are using a “USB iTwo” which is a simple 2 in / 2 out interface.

Note: On macOS and Windows you can select the input device and output device separately. In most cases you will set them to the Output and Input the same.

Test Button

There is a convenient Test button next to the audio device parameter. Click it to send a short test tone to the audio device’s output. If you hear the tone, you know your device has been configured correctly.
Audio Device Setup in Windows

If you haven’t already, navigate to Settings tab > Audio Devices page.

Audio Device Type
Waveform gives Windows users four choices for audio device type.

- Windows Audio
- Windows Audio (Exclusive)
- DirectSound
- ASIO

Any of the above four options might work with your computer, but there are definite differences, and best options.

⚠️ Note: Waveform is not supported on XP or Vista. We recommend Windows 10 as the best option.

ASIO
This is the best choice if you are using an external audio interface. You will need to install the manufacturer’s driver. Using ASIO will usually give you the best low latency performance for recording and playback. Many modern audio interfaces include a mixer app to control low latency mixing within the unit. When using ASIO, you simply choose the device both inputs and outputs.

Windows Audio
Use this if you are running Windows Vista/7/8/10 on your computer, and are using the internal sound on your machine. This solution is best when you don’t have an ASIO audio interface such as when using a laptop’s internal sound. This device type uses WASAPI (Windows Audio Session API) which offers nicely optimized access from applications software to audio I/O. Windows Audio will also function with USB Audio Class 1 interfaces.

⚠️ Tip: Windows Audio used to be the preferred option for those using Windows Vista or Windows 7 however we don’t support Waveform on either of those legacy windows Windows versions.
Windows Audio (Exclusive Mode)

This is the same as Windows Audio, but Waveform will not allow any other application to use the audio interface while running. For the lowest latency and most critical applications, choose this option when using your internal sound.

Note: Before the 2017 Windows 10 “Creators Update” no version of Windows supported USB Audio Class 2 devices natively. But now if you have a fully up-to-date installation of Windows 10, you can likely use your USB device using Windows Audio. This applies to most modern USB2 or USB3 interfaces. If you have an earlier version of Windows, Class 2 interfaces might seem to function because they default back to USB Audio Class 1. However, for best performance and access to all features we still suggest you install the manufacturer’s drivers, and use ASIO.

DirectSound

This used to be the preferred option back when Tracktion was running on Windows XP with internal sound. This is not a good choice for Windows 8 or Windows 10. For Windows 8 and 10, it is deprecated and might not work at all. Since XP is not support, we suggest you stay away from this option.

Tip: If you aren’t on Windows XP don’t use the DirectSound device type. Also, don’t attempt to run Waveform on Windows XP, it’s not support by TSC or Microsoft.

Choosing the Audio Interface

With the audio device type set, you can choose any audio interface connected to your computer or the internal sound. Select your device if it’s not already shown for the Device property.
Control Panel

On some but not all audio interfaces, clicking the Control Panel button will open the manufacturer’s driver control panel to set the buffer size. Many audio interfaces don’t allow you to set the buffer size or the sample rate through host software. If that is the case, locate the control panel software on your system, and open it. Set the Sample Rate and Audio buffer size there. In some cases, you will need to restart Waveform for the change to take effect.

Setting the Sample Rate

The default for the sample rate is 44100 Hz, which matches the sample rate for CDs. We suggest choosing this sample rate unless you have a specific reason to choose a different sample rate.
Testing for Audio Playback

It is a good idea to test playback to make sure you get sound as well as a complete stereo image. Here is one way to do that:

1. Go back to the Projects tab and select one of the demo tunes - Subways is a good choice.
2. Locate the Edit on the right (SubWays T4) and double-click to open it.
3. Click *Play* (spacebar) and you should hear music!
Successful Play Back

**About Latency**

The process of mixing your tracks together, calculating digital effects, and triggering instrument samples takes time in any DAW. It is impossible for digital mixing to happen instantly. The amount of time your computer needs to compute, process, mix and playback from input to output is called ‘latency.’ Latency is the amount of time you allow the computer think and is normally measured in milliseconds, from just a few to several hundred milliseconds.

During playback, you experience latency as a delay between hitting play and hearing playback. This results in a barely detectible lag in the transport functions, and doesn’t cause much trouble.

Latency during overdubbing is more of an issue. If you are hearing playback of existing tracks a bit late, then what you are recording is not going to line up correctly because your timing reference is shifted, either late or early. Even a few milliseconds will effect feel. At 30 or 60 milliseconds, the timing will seem off. This can have an impact on the feel of the recording or even make the timing seem completely off.

For these reasons, all DAWs include a “latency compensation” feature. Following recording, the audio tracks are essentially shifted to compensate for latency in the A/D process, mixing, and plugin DSP processing.
Managing Latency

Audio buffer size by default is 512 samples (11.6 ms) on macOS and 256 samples (5.8 ms) on Windows. On modern macOS computers, you can usually run with the buffer size set to 256 as well.

- **Note:** The choice of available buffer size options varies. It depends on what audio interface, connection type, and driver technology you have available.

Let’s consider a latency of 11 ms. In reality, 11 ms is a very short period of time. In the real world if you are playing a MIDI controller into a virtual instrument, there will be an 11 ms lag between when you play a note and when you hear the note. It’s the same thing if you’re working with a virtual guitar amp or amp simulator. When you play a note the guitar you hear the sound 11 ms later. Sound travels through air at the rate of approximately one foot (0.34 meters) per millisecond. So this latency is like playing with your guitar amp or keyboard monitor 11 feet (3.4 meters) away. There is a delay but you might get by. At 6 ms delay, usually the delay is barely noticeable.

With computer recording, we always aim to strike a balance between noticeable latency and getting clean playback. Why not just lower it all the way down? Because, the computer needs time to ‘think’ and produce the sounds and process effects. If we get too aggressive with lowering the buffer, the computer starts to complain in the form of pops, clicks, dropouts, and the like. So during recording you might keep the buffer smaller; during editing and mixing you can increase it.

- **Tip:** Try 256 samples when you get started. While your songs are simple, this should work fine on most modern systems. If you feel there is too much delay when playing virtual instruments, try a lower buffer value. If the audio starts to break up, try higher settings.

- **Note:** When using Melodyne Essential for editing audio, you will need to increase the buffer size to at least 1024 samples, in order to prevent getting a warning message and to have clean playback.

Calibrating Input Latency Compensation

If you use Waveform for any overdubbing, this is possibly the most important lesson in this book. **Waveform requires you to run Auto-Detect** using a loopback connection on your audio interface.

- **Warning:** This test sets up a deliberate feedback loop. Switch your speakers off during this test. You will be connecting an output to an input using a patch cord, so be careful.

Here are the steps:
1. Turn off your monitor speakers!
2. Make sure any input monitoring knobs, buttons, or mixers are off or turned down.
3. Connect one output back to one of the inputs. To make it simple, connect the left output to input one.
4. Turn the gain up about half way on the input.
5. In Waveform go to Settings > Audio Devices.
6. In the Channels list click on one of the Inputs

![Select an Input]

6. In the Properties section click Auto-Detect.

![Auto-Detect & Time Adjust Parameters]

7. Click Run Test. Waveform will send a short test signal from the output to the input. It will calculate the delay between output and input.
8. Click *Apply* and Waveform will copy the delay value to the Time Adjust property.

For recordings to be aligned during overdubs, you must repeat this every time you make a change to the *Sample rate* or *Audio buffer size*. If you don’t, your recordings will be several milliseconds out of alignment with existing tracks.

**Tip:** You can keep a note of the *Time Adjust* values at different settings and enter it manually for the settings you commonly use.

**Warning:** To configure Waveform for recording, you must use the Auto-Detect feature along with a hardware loopback. If you don’t then your overdubbed tracks will not be in alignment with existing tracks. While this is not difficult, it is essential to do this manual step anytime you change the Audio Device Setup.
Other Audio Device Settings

We have just covered the essential tasks to get going. There are more settings here that you might be curious about. To be complete, here is an explanation of each:

### CPU Cores to Use
This can be set from one to the number available. Usually you leave this at the maximum cores available. The maximum is typically the number of hardware cores in your CPU times two. For example, if you run a four-core processor, the maximum cores will be reported as eight. If you are running some other software alongside Waveform that needs more CPU power, then you can reduce this number to make Waveform leave some cores open for other tasks CPU. Cases where this is necessary are rare except when debugging specific problems.

### Use 64-bit Maths When mixing Tracks
Normally this setting is left on, especially if you have a nice fast computer. It gives you a little bit more headroom in the mix engine, but you probably won’t notice much difference if it’s on or off. If you have a very old computer with limited CPU, leave it off. By default it’s off; we usually leave 64-bit maths turned on.

### Only Show Enabled Devices
The Channels list on the Audio Devices page includes a check mark next to each input and output. Click that check mark and it turns to a red ‘X.’ This disables that hardware; after that Waveform will no longer present it as an option in other menus. Well, this setting Only Show Enabled Devices will hide disabled inputs or outputs when turned on. I usually leave it off.

### Max Monitoring Latency
This is the maximum allowed latency, when in low latency monitoring mode. If latency exceeds this, Waveform will shut off some plugins. We suggest you leave this at the default 5 ms, as it has no effect unless you engage low latency mode.

### Low Latency Buffer Size
This is the alternative buffer size to use when in low latency mode. Leave this at the default and don’t worry about. It also has no effect unless you engage low latency mode.

---

**Tip:** If you are curious about low latency mode, click the ‘i’ next to the Max Monitoring Latency or Low Latency Buffer Size parameter. You enable low latency mode from the CPU usage window which is opened by clicking on the icon in the upper right corner of the Waveform window header.
Internal Buffer Multiplier
Another setting related to low latency mode. Usually just leave this set at 1X and forget it.

**Resetting to the Defaults**

If you are playing around with the values on this page and you just don’t know how they should be set, click *Reset Audio Settings*.

Leave the page at the defaults and press *OK*. This resets the page to the factory settings.
If you tick *Reset input devices* option, all the settings for input devices will get reset. Those include *Input gain, Trigger level, Time adjust*, and recording options.
If you tick *Reset output devices* then the output options are reset. Output options include *Treat as stereo pair, Dithering Enabled, Left/Right Reversed* and *Alias* parameters.

**Moving On**

Audio device setup is straightforward, apart from running the Auto-Detect loopback test. Even so, you don’t need to fully understand everything on the Audio Devices page. Follow the guidelines in
this chapter and you will be ready to move on.
Chapter 5 - Getting Around in Waveform

This chapter is an overview of how to operate Waveform. You will also learn how to set up Waveform for an efficient workflow, as well as how to change the tempo of your song.

Tabs and Menus

With Waveform open, you see the Projects tab and the Settings tab. Click on the tab name or icon to switch to that tab. Switch back and forth between those two tabs by clicking the tab you want or by pressing F4.

Projects Tab & Settings Tab

Notice that there are no menus along top, as with other macOS and Windows programs. Menus are located at the left side of the Controls panel, in the Menu section. The Menus are different depending on if you are on the Projects tab or an Edit tab.

Menu Section in the Projects Tab
The only useful item you will find in the normal menu location is the command to quit Waveform.

The Menu section is part of the Controls panel that includes the Properties section, Master section, and Transport controls.

You can shrink the Controls panel down to a compact Toolbar by clicking the close icon.
From the Toolbar you can open back to the full Controls panel by clicking the corresponding open icon.

**Pop-up Help**

Pop-up help is helpful at first. It might quickly become annoying as you get more familiar with the Waveform.

Disable pop-up help from the Menu section using Help > Turn off pop-up help. Even with pop-up help disabled, you can see available pop-up help by pointing at an item on screen and pressing F1.

**Roll-over Help**

In addition to pop-up help, Waveform offers roll-over help. Rollover help messages appear in the upper right for controls and objects. The messages appear automatically as you hover the pointer over items on the screen.
Creating a Project

The very first step to produce a song in Waveform is to create a project. To do so:

1. Go to the Projects tab
2. Click New Project and the New Project dialog box appears
3. Fill in the Name
4. Select the Location
5. Click Create Project

**Note:** We are always working to improve the accuracy of pop-up help and rollover help messages. If you find any help messages to be wrong, unclear, or missing please email a screenshot and short description to support@tracktion.com.
The New Project Dialog Box

After clicking Create Project you will see the contents of the project in a list to the right with the title All items in project: projectname.

For now, the most important entry in the “All Items” list follows the word “edit”; that file is called an Edit. In our example, the Edit name is “SummerSong100 Edit 1.”

Note: Creating a project creates a folder, that in turn contains sub-folders that contain the project media, a Project file (.Waveform) and an Edit file (songname.traccionedit). The folder, Project, and Edit all use the name you provided in the New Project dialog box.
Tip: Another way to create a Project is to click the plus to the right of the tabs. Select New Project and the rest of the steps are the same.

Opening the Edit

An Edit is the workspace in Waveform where you record, edit, and mix your songs. Double-click the Edit in the All Items list; and it opens to a new tab. This type of tab carries the name of the Edit and is called an ‘Edit tab.’

Edits and Revision Control: In Waveform you can have as many Edits per Project as you want. This gives you a great system for revision control. At key milestones in your workflow, go back to the Project tab click Create a Copy. This copies the Edit to a new file. Rename the copy appropriately and resume work using the new Edit. You can return to the previous state of the Project at any point by opening an earlier Edit.
The Edit Tab

The Edit tab is where most of the action occurs while working in Waveform. What other DAWs call a “project” or “song”, Waveform calls an Edit. In a way, this is similar to the terminology used in many video editing programs. You have a collection of media that you organize into an Edit. In concept, you can organize the same media into other Edits. In music production, having multiple Edits gives you revision control and flexibility to have multiple mixes of a song all contained within the Project.

Basic Navigation

What you need to know to navigate an Edit:

Start and Stop Playback

The obvious way to play and stop is to use the Play/Stop button located on the transport in the Master Section. Alternatively, press the spacebar to toggle between start and stop.

Tip: By default, the cursor will jump back to the start position when you stop playback. If you would like the cursor to remain at the stop position, there is a setting for that in the menu Options > Return cursor to start position when play stops. Turn that off, and the cursor will pause at the point you hit stop.

Zooming In and Out

Here are some basic ways to control zooming:

- Use the Up and Down keys to zoom in and out
- Use the zoom controls in the lower right corner
- On the timeline just above the cursor, grab and drag up or down
Quick Zoom Tool

In Waveform you can also use the quick zoom tool:

- Hold Shift + Opt / Shift + Alt and drag to select an area. The pointer changes to a magnifying glass. When you release, the view zooms in to your selection.

![Dragging a Selection with the Zoom Tool](image)

- To step back from that zoom level, once again hold Shift + Opt / Shift + Alt and click in the arrangement.
- Waveform remembers the zoom levels, so you can zoom in repeatedly. Then, press Shift + Opt / Shift + Alt click to zoom back out.

Tip: Quick zoom can really speed things up. Give it a try! The zoom tool is multilevel. Zoom in several times then again hold Shift-Opt / Shift-Alt and click to zoom back out. Each click steps you back one zoom level.

Tip: There are keyboard macro actions that you can assign to the keyboard to undo and redo the action of the zoom tool. The actions are found at Basic Actions > Zooming > undo mouse select+zoom and Basic Actions > Zooming > redo mouse select+zoom from the Script Editor. See Chapter 37 - Keyboard Macros to learn how to use scripts.
Positioning the Cursor

The cursor position is used as the playback start time, and is also used to reference many of Waveform’s editing functions. In other DAWs it is called a playhead, now time, or playback cursor. In Waveform we call it the ‘cursor.’

There are numerous ways to position the cursor, including:

- On the timeline just above the cursor, grab and drag it left or right
- Opt-click / Alt-click the timeline and the cursor will jump to that spot
- Click in the background of the arrangement
- Use the left and right arrow keys to move the cursor backward and forward
Tip: You can change the way clicking on the Timeline works by selecting Options > Timeline drag action > Drag to position transport. With this set, when you click in the timeline, the cursor jumps to that position. If you drag in the timeline, the cursor follows as well.

Note: In this mode, to drag zoom, you need to hold down Opt / Alt. Since you can still zoom in and out with the mouse wheel or the up and down arrow keys, this mode is a great way to get around in Waveform.

# Scroll Behaviour

Scroll behavior can be tailored to your preference. By ‘scroll’ we mean how the cursor moves and how the tracks move past your screen during playback and recording.

The choices are available from the menu - Options > Scroll Behaviour.

![Options > Scroll Behaviour](image)

The default is Scroll with playback. Here is a rundown of what each option does:

**Scroll with playback (default)**

During playback the cursor stays on screen. As the cursor goes past the right edge, the tracks page over keeping the cursor in view.

**Scroll smoothly**

During playback, when the cursor arrives at a fixed position near the center of the screen, the tracks scroll under the cursor. This is a matter of personal preference.

**Keep cursor on screen**

During playback the cursor will stay on the screen. Even while editing or manually panning, the cursor always stays on screen. As you pan over right the cursor stays at the left edge of the screen.

**No options selected**

During playback the cursor will move past the right edge of the screen and then move out of site.

Tip: For most users we suggest leaving Scroll with playback enabled and the other two options off.
Changing the Tempo

Tempo in Waveform is managed using the Tempo track at the top of the screen. You can hide or show the Tempo track using the Tempo button at the upper right.

Show or Hide the Tempo Track with the Tempo Button

The Tempo is represented as a line in the Tempo track. This line is called the “Tempo Curve.” For a fixed tempo tune it will appear as a line set to a beats-per-minute (BPM) value.

Fixed BPM Tempo Curve

For tunes with tempo changes it might appear with step ups or step downs in tempo, or even gradual tempo changes represented as curves (thus the name Tempo Curve). In other software this is often called a “tempo map.”

Varying BPM Tempo Curve

To change the tempo of your Edit:

1. Click the tempo BPM readout in the Master section. The Properties section will show the Tempo properties.
2. Adjust the BPM parameter to the desired tempo. Either click and type it in, or drag the slider.
3. Alternatively, open the tempo track and drag the tempo curve line up and down.

**Note**: Setting the tempo this way changes the tempo only for the segment of the tempo curve that is under the current cursor position.

**Video Clip**: To learn how to use the tempo track to map tempo changes to an existing recording, Check out the video on Creating a Tempo Map

## Changing Tempo at a Specific Bar

To change the tempo at a specific bar, use the action *Insert tempo change at cursor* (Opt + T / Alt + T). Here are the steps:

12. https://w-edstrom.wistia.com/medias/687engp5ar
Right-click Timeline: *Insert tempo change at cursor*

1. Position the cursor where you want the tempo change to occur
2. Right-click on the timeline, and select *Insert tempo change at cursor*
3. In the Properties section, adjust the BPM parameter to the new tempo.
4. To see the results of the tempo change, open the tempo track to see the step up or down on the Tempo Curve

**Note:** The Tempo Curve can also be adjusted with more detail in the Tempo track in much the same way as automation. Click to add points (nodes) to the curve and drag them to shape your tempo changes along with an adjustable Curvature.

**Removing Tempo Changes**

Click on any tempo point, to select it. In Properties, click *Delete > Delete this tempo setting.*

**Removing all Tempo Changes**

Click on the Tempo curve line. In Properties, click *Delete points from curve > Delete all points from the curve.*

**Offsetting and Scaling the Tempo Curve**

Displace Curve and Scale Curve Controls
Displace Tempo Curve
  Click anywhere on the Tempo Curve. In Properties, drag left or right over Displace Curve to move the entire tempo curve up or down.

Scale Curve
  Select the Tempo Curve, then drag left or right over Scale Curve to reduce or emphasize the amount of tempo variation across the entire Edit.

Moving On

This chapter was a basic introduction to the operation of Waveform. You can now operate the transport; you can open the demo files; you can create a new blank project; and you can adjust the playback volume and tempo.

That is enough to start exploring Waveform. Stay tuned, there is a lot more to come!
Chapter 5b - The Projects Tab

This chapter is a collection of topics related to the Waveform projects tab. The Projects tab the starting point for creating new Edits and organizing all of your file.

Project Tab - Three Column View

The Projects tab shows a three column view of the files associate with your projects. These columns represent the Edit list, assets pool, and exported files. You can choose which columns to have on-screen using the View Options selector at the top right.

If you prefer the long single list from earlier version of Tracktion, choose View as single list from the View Options selector.
The Project tab Edit list includes an audio thumbnail preview of each Edit. Waveform renders this preview in the background during idle time, when an Edit is open, and updates it periodically. It’s all automatic and you don’t need to do anything to maintain it. Click the thumbnail to play the preview and drag the play cursor around to hear different parts of the song.

The Share button to the right of the preview thumbnail gives you two ways to share the Edit.

Share as archive of this edit takes you directly to the Create Archive dialog box. From here you can export the Edit as a project bundled with with all necessary assets to load back in to Waveform on another computer.

The other option on the Share button is Share a preview of this edit. This simply locates the preview audio file on your file system. From here you can do what you want with it. It’s in the Ogg Vorbis
format.

Note: Don’t drag, move, or erase the preview file. You need to leave it in this location for the preview to work on the Project tab. If you want to use it somewhere else, copy it first.

Project Tab - Get Demo Songs

The Menu at the lower left of the Project tab includes a button Get Demo Songs. Click that for a quick way to download the Waveform demo Projects. For a full description of this feature refer to Chapter 3 - Installing the Demo Projects.

Moving On

This chapter was a basic introduction to some of the features of the Project tab.
Chapter 6 - The Settings Tab

The Settings tab is organized into pages for configuring global preferences. Click one of the page headings along the left to select a page. The settings for that page appear on the right and a short description of the page appears in the lower left. In this chapter, you will learn what each page is about.

Tip: Useful keyboard shortcuts: Press F2 to jump directly to the Setting tab. Press F3 to flip between Settings and your Edit.
Audio Devices Page

Use this page to select your audio device, configure inputs and outputs, and manage latency. Learn all about the Audio Devices page in Chapter 4.

Note: The Auto-Detect feature for inputs is also accessed from this page. This is essential to getting your overdubs to properly sync to existing tracks. Pay particular attention to that discussion in Chapter 4.

MIDI Devices Page

Use the MIDI Devices page to configure external MIDI keyboards, MIDI ports, or MIDI instruments to communicate with Waveform. You can also configure your computer keyboard to act as a virtual MIDI keyboard from this page. The MIDI Devices page is covered in Chapter 22.

Plugins Page

While Waveform includes basic effects and virtual instruments, it also hosts third-party VST plugins in Windows, plus VST and AU (AudioUnit) plugins on Mac. To use third-party plugins, you need first to tell Waveform to scan for them.

To do that, click Scanning and Sorting then select from one of the plugin formats to scan. You need to repeat the scan for each of the plugin formats that you want to use. Read more about plugin scanning in Chapter 28.

General Behaviour Page

There are lots of settings and actions available on the General Behaviour page. These give you many ways to customize Waveform to match your preferences and the types of projects you work on.
Here is a rundown of the essential settings on the General Behavior page:

### Username: William Edstrom

- **Language:** English
- **Check For Language Updates:** Never
- **Font:** Default
- **Colour-scheme:** Default
- **Use Low Detail Interface**

#### When Starting Waveform:
- Go to the project page

#### Saving Edits:
- When an edit is about to be closed, always ask the user whether to save it

#### Auto-Save Edits:
- Auto-save every 5 minutes
- Generate Edit Previews

#### Temporary Directory:
- /Users/Bill/Library/Caches/com.tracktion.Traktion4/Temporary

#### LAME Location:
- /Users/Bill/Library/Preferences/com.tracktion.Traktion4/lame

#### Undo Levels:
- 120

- Audio Clip Import: Always copy file

#### Link clip colour to track colour

- Automatically assign colours to new tracks

#### Default MIDI Editor Position:
- Panel

#### Enable mastering with CloudBounce

#### Track Resizing:
- Double-clicking a track toggles between small and medium height

#### Side Panel Position:
- Right

#### Automatically hide and show panels

- Renaming a Clip in an Edit Also Renames its Source Item
- Rename Mode: Only rename source file if it is in the project folder

- Meter Response: Level meters decay quickly

- Peak Hold: Level meter peaks drop after 2 seconds

- Solo Behaviour: Cumulative solo

- Default Pan Law: Linear

- Default Marker Type: Bars & Beats

- Default Freeze Point: Pre-fader

- Freeze Point Creation: Freeze track when a freeze point is created or copied

- Default Drag X-Fade: Off by default

- Comping X-Fade Time: 20 ms
Username
Customize Waveform with your name, band name, or studio. This gets saved with Projects and Edits.

Import/Export User Settings
Use Export User Settings to save most of the preferences on the Settings tab to a file. You can name this and save it anywhere on your system. The user settings file will always have a .trkssettings file extension. You can restore settings by clicking Import User Settings and loading the file.

Tip: Many Waveform settings can be saved to text files, making it easy to restore them to another computer or just save them in case you need to reinstall the software. To keep exported settings organized and easy to back up, we recommend creating a set of folders under the main Waveform folder to hold them.

Waveform Settings Folders

Audio Clip Import
We suggest you set Audio Clip Import to Always copy file. When you import audio files in to a Project, Waveform can either reference the original file, or copy the file to the Project folder. We suggest you set Waveform to always copy imported files, as it makes it far less likely the the audio will get separated from the project. It also makes it easier to back up your projects, since all the media will be contained within the Project folder structure. The only reason to choose the other option is if you have very limited drive space.

Link Clip to Track Colour
With Link clip color to track colour enabled, clips will match the color selection for the track. If you change the track color clips will change color to match. This tends to give better color definition to different tracks.

Automatically Assign Colours to new tracks
With this off tracks will not have a specific color and will just match the theme of the rest of
the program. This will translate to Mixer channels as well. With this option enabled, tracks will have a color however it will be very faint. It’s mostly to work in connection with the option above where you link clips to the track color. The clip colors are much more vibrant and so are the mixer channels. Most users leave both of these options enabled.

**Track Resizing**
When you double-click a track header (the track name) in Waveform, the vertical track height toggles to a larger size. You have three choices for how the resizing works. You pick the best choice using the property Track Resizing. Try each mode and choose the one that works best for you.

**Rename Mode**
We suggest you set Rename Mode to Only rename a source file if it is in the project folder. This option avoids renaming a file accidentally. Note that this setting won’t matter if you set Audio Clip Import as suggested above.

**Automatically Hide and Show Panels**
With the Browser, in-line Mixer, Toolbar, or Controls panel hidden, move the mouse pointer to the appropriate edge of the window, and the panel will slide open. When you move your pointer off the panel, it will be hidden away again. Notice the animation as a panel slides in and out.

To turn off the auto hide/show panels action, deselect Automatically hide and show panels in the Settings tab, General Behaviour page.

**Other Settings**
There are several other settings like Meter Response, Peak Hold, and Solo Behavior, which will be covered in context, in later chapters.

**Keyboard Shortcuts Page**
The Keyboard Shortcuts page is used to configure keyboard shortcuts for dozens of actions. You can click the View as HTML button at the bottom to generate an HTML version of the keyboard shortcuts.
list. You can search it or print the resulting HTML file as a reference. You can also learn a lot about what is possible with Waveform by looking through shortcuts list and trying them out. Keyboard Shortcuts are covered in detail in Chapter 14.

The Keyboard Shortcuts page also includes the Script Editor for creating macros. Macros and the Script Editor are covered in Chapter 37.

**Loop Database Page**

This page is used if you want Waveform to index your existing loop file folders. To do so, enter the path to your loop libraries and select one of the scan options. Following the scan, the loops will appear in the search results on the Browser Search tab. Once indexed, you can assign tags to loops to organize them further.

> **Note:** Having Waveform index your loops is entirely optional. If you already have loops organized into folders, you can simply bookmark your loop folders in the Browser Files tab. The downside of indexing your loops is that you get a longer list of results when using the Browser Search tab. This can make it a bit harder to see relevant results when searching for plugins.

**Control Surfaces Page**

Use this page to setup external control surfaces. These are typically hardware units that control the transport or provide knobs and faders that you can assign to on-screen controls.

**Moving On**

Now you should have a better understanding of the General Behaviours page of the Settings tab.
Chapter 7 - Getting Help

This chapter is a summary of the various ways to get help when working with Waveform.

Pop-up Help

The first source of help is pop-up help. While useful at times, you can also turn off pop-up help with Options > Help > Turn off pop-up help. Press F1 to view pop-up help for the item under the pointer. Refer to Chapter 5 for an illustrated guide to pop-up help.

Roll-over Help

Roll-over messages appear in the upper right for items under the pointer. These messages give you a description of the object under the mouse pointer.

Quick Start Guide

Waveform includes a Quick Start PDF file. Access this brief printable guide from the Help menu.

Keyboard Shortcut List

There is a complete reference for the standard default keyboard shortcuts in Appendix B. Studying the keyboard shortcut is a great way to get more familiar with Waveform.

Navigate to the Settings tab, Keyboard Shortcuts page. Here you will see all the assignable actions grouped by category.
For a searchable list click View as HTML to load the current list in your web browser. From here you can search it with Cmd + F / Ctrl + F or print it out.

**Tracktion Shortcut Keys**

<table>
<thead>
<tr>
<th>Shortcuts</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flip between edit/project screens</td>
<td>F3</td>
</tr>
<tr>
<td>Go to project screen</td>
<td></td>
</tr>
<tr>
<td>Go to edit screen</td>
<td></td>
</tr>
<tr>
<td>Go to settings screen</td>
<td>F2</td>
</tr>
<tr>
<td>Show colour-scheme editor window</td>
<td></td>
</tr>
<tr>
<td>Save the current edit</td>
<td>command + S</td>
</tr>
<tr>
<td>Save the current edit as</td>
<td>shift + command + S</td>
</tr>
<tr>
<td>Quit the application</td>
<td>command + Q</td>
</tr>
</tbody>
</table>

**Help Functions**

<table>
<thead>
<tr>
<th>Functions</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Tracktion’s help documentation</td>
<td></td>
</tr>
<tr>
<td>Enable/Disable the popup help</td>
<td></td>
</tr>
<tr>
<td>Show popup help for whatever the mouse is currently over</td>
<td>F1</td>
</tr>
</tbody>
</table>

**Transport Controls**

<table>
<thead>
<tr>
<th>Functions</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start/stop playing</td>
<td>spacebar</td>
</tr>
<tr>
<td>Start playing</td>
<td></td>
</tr>
</tbody>
</table>

HTML View of Keyboard Shortcuts Assignments

### Videos Tutorials

The Waveform videos page\(^{13}\) has a nice selection of training videos. The series “Tracktion T7 Update Explained” is available from Groove 3, Inc\(^{14}\) along with other Tracktion related videos. Groove 3 is a deep resource for all things music production.

Also checkout this YouTube channel\(^{15}\) for various free videos demonstrating Tracktion and Waveform features.

This user guide includes links to videos many of which are only available here. Check out Appendix A\(^{16}\) for a complete list of videos linked from within this user guide.

\(^{13}\)http://www.tracktion.com/support/videos

\(^{14}\)http://goo.gl/GKbdIM

\(^{15}\)http://goo.gl/hywdxh

\(^{16}\)appendix-a
Tracktion and Waveform Forums

There is a growing Tracktion - Waveform Users Group on FaceBook. If you use FaceBook join the group. Many new and veteran Waveform users are active there. The TSC team are also members and occasionally drop into the conversations.

The long term forum for Tracktion and Waveform Software is hosted at KVR. This the oldest Tracktion related forum on the Internet. Here you can interact with other users, TSC staff, and developers.

Also check out the Tracktion Software official Facebook page for updates, news about Waveform, promo offers, and artist profiles.

TSC Support

In large part, your success with getting issues resolved, requesting features, and reporting bugs, depends on following the recommended guidelines, when filling out the support request form.

Support Request Form

17https://www.facebook.com/groups/Tracktion/
18http://goo.gl/YaygV6
19kvraudio.com
20http://goo.gl/Hv3Xjr
Support Request Form Checklist:

- Use “FR:” in the title for feature request
- Use “BR:” Bug Report in the title for bug reports
- Include the Waveform version number (from the Waveform About box)
- Include your operating system and version
- Note your system specs like processor type and the amount of RAM
- List the steps to recreate the bug
- Attach the log file (Help > Show the Tracktion log file)
- Attach or link to screenshot or screen video
- Report one issue at a time
Follow these same guidelines when posting bugs and feature requests to the KVR Tracktion Software forum\(^{22}\).

Don’t hesitate to provide feedback positive, negative or even your creative ideas for the future. User input really shapes future direction of Waveform.

**Moving On**

Those are the key ways to get help when learning and using Waveform. Next, let’s get into more detail on using Waveform!

\(^{22}\)http://goo.gl/YaygV6
Chapter 8 - The Edit Tab

In this chapter you will learn the layout of the Edit tab. The Edit tab is where most of the action occurs during recording, editing, and producing your song. This chapter is important, as you will learn the terminology for the Waveform interface and objects used throughout the rest of this user guide.

The Parts of a Waveform Edit

The Edit tab is made up of four main parts: The Browser, the Arrangement, the Mixer, and the Controls panel.

Parts of the Edit Tab: A, Browser. B, Arrangement. C, Controls panel
The Browser

The Waveform Browser resides along the left side of the Edit. You can open or close it by clicking its icon or by pressing B. The Browser includes a collection of tabs, giving you quick access to media, plugins, and markers.

Tip: You can move the Browser to the top or right side of the Edit, by dragging its icon to the appropriate edge of the screen.

Browser Open/Close Icon, A. Browser Tabs, B.

Here is a short description of each Browser tab:

**Files**  The Files tab gives you quick access to the audio files used in the project, as well as the project folder structure. It also gives you quick access to common locations and drives on your system. Most important however, is the ability to bookmark folders for quick access. Using bookmarks is the easiest way to access a loops library. Audio files and loops can be easily auditioned from the Files tab as well.

**Tracks**  Use the Tracks tab to filter tracks in the arrangement by tag. First, you need to tag them by selecting one or more tracks and setting tags in Properties.

**Search**  The unified Search tab, allows you to search for loops, presets, or plugins in a single interface. The tag field dynamically updates to show the relevant tags for filtering.

**Markers**  Use the Markers tab to add bars & beats or timecode markers to the Marker track. Navigate to any marker by simply clicking on the marker name. You can also quickly delete the selected marker, change its name or marker type in Properties.
Clipboard

Use the Clipboard tab to see what is currently in the clipboard. Put selected items from an edit or project on the clipboard by pressing 
Cmd + C / Ctrl + C. Then, drag clipboard contents to the arrangement from the Browser Clipboard tab. The clipboard can contain clips, plugins, or racks. It is particularly useful when copying items from other projects on the Projects tab.

For much more about the Browser check out Chapter 9 - The Browser.

Tip: Resize the Browser by dragging the edge left or right. This is particularly helpful when working with the Search tab, which has numerous search columns that might be hidden.

The Arrangement

The Arrangement is made up of the Timeline, Track Headers & Inputs, Tracks, and the Inline Mixer.

Timeline

The Timeline acts as a ruler, measuring the time of the edit. While it is commonly set to show the bars and beats of your song, it can also show seconds and milliseconds or seconds and frames with a simple right-click selection.

The Timeline is related to several other onscreen features:

In-marker & Out-marker

The range between the In-marker and the Out-marker defines what is called the “marked region” in Waveform. In other DAWs this is called often called the “loop” or “cycle.” The marked region defines looped playback, loop recording, and many of Waveform’s editing options. The keyboard shortcuts are I to position the In-marker, and O to position the Out-marker.

Tempo Track

The Tempo track appears below the timeline, when open. Here you define the tempo and tempo changes. Open and close the Tempo track using F9.

Note: The Tempo track is sometimes referred to as the ‘Global track’ within Waveform. This is because it contains global song key and time signature changes in addition to the tempo map. In this user guide we typically call it the Tempo track because that’s how the track is labeled in the application.
Marker Track
There are actually two marker tracks that can be opened below the Timeline. One is for bars & beats markers, such as song sections. The other is for absolute time in terms of hours:minutes:seconds and milliseconds. Cycle through the options with F10.

The Clip Object
Above the right side of the Timeline you find the Clip object. Some Waveform users call the Clip object a “clip dragger” or “clip maker.” All of the terms are descriptive of how it works. Drag it to a track to create an empty clip of any of the four types - MIDI clip, Audio clip, Edit clip, or Step clip.

The Plugin Object
Drag the Plugin object to the inline mixer section of any track to insert an audio effect plugin or virtual instrument. When you drop the Plugin object, you get a menu of all available plugins and instruments. You can control the organization of the menu from the Settings tab Plugins page. Refer to Chapter 29 - Using Plugins for much more about inserting and using plugins.
Right-click the Plugin object to launch the visual plugin selector. This is fully explained in [Chapter 29 - Using Plugins](#chapter-29).

**Show/Hide Buttons**

Several areas of the Edit tab can be opened for use or closed to declutter the screen. Here are the buttons to control those along with the corresponding keyboard shortcuts.

- Show/Hide Tempo Track (F9)
- Show/Hide Marker Track (F10)
- Show/Hide Inputs Section (Shift + F12)
- Show/Hide Inline Mixer Section (M)
- Show/Hide Controls Panel (F11)

**The Track Section**

Tracks appears as parallel lanes that contain and organize clips of audio and MIDI. Signal flow follows from left to right from Inputs, to Clips for recording, to the inline Mixer and any plugins it uses, then on to the Master section. There is really only one kind of track in Waveform. Tracks can hold any kind of clip: Audio clips, MIDI clips, Step clips, or Edit clips. To create a new Track simply press T.

**Track Headers**

The leftmost column of the Arrangement forms a list of track headers. Select a track by clicking directly on the track name within the header. Additional track properties including the Name
became available in Properties. To rename a track, simple edit the *name* property. Tracks can be reordered by grabbing any track by the header and dragging it to a new location.

![Track Headers](image)

**Inputs**

Inputs appear as right facing rectangular arrows. Click on an input for a menu of options that includes a selection of available inputs. Use the menu to set up a track for recording. Additional input options are available in Properties. You can even drag an input to another track to continue recording.

![Track Input](image)

**Tip:** Resize tracks using the zoom tools in the lower right corner of the arrangement.
Clips

You can drag in audio files and loops to build your Edit, or record them directly. The same goes for MIDI clips. Step clips are a unique inline step sequencer. Step clips are variation on MIDI Clips. Edit clips allow you embed an entirely different Edit into your song as single clip. Select any of the kinds of clips to access more properties and actions in Properties.

Audio Clips

Audio clips are created during recording or can be dragged in from the Browser or desktop. Audio clips are one of the key elements of a Waveform arrangement. Waveform gives you a rich set of tools to work with Audio clips to split them, combine them, reverse them, or change the pitch, timing, or speed. You can also edit Audio clips with Melodyne to adjust the intonation of recorded notes. Clip Layer Effects give you even more options to manipulate Audio clips. See Chapter 41 - Clip Layer Effects to learn more.

MIDI Clips

MIDI clips are the Waveform container for MIDI performance data. The clips have many of the same editing features as Audio clips. Expand MIDI clips vertically to see the full inline piano roll MIDI editor. The MIDI editor comes with a full set of tools for editing, entering, and modifying MIDI notes. Double click to open in the MIDI editor.

Step Clips

Step clips are a unique type of inline step sequencer that gives you amazing flexibility to enter MIDI notes on a grid. Step clips are ideal for programming drum beats and rhythms, they can also be used for baselines, synth leads or just about anything else. Some Waveform users program complete compositions entirely with Step clips!
Edit Clips

Edit clips are another unique Waveform concept. You can embed an entire Edit into a clip. You can also use Edit clips to separate out all your drum programming to another Edit as an aid when doing complex drum programming. Use Edit Clips to compose songs in blocks - develop the verse, chorus, and bridge in separate Edits and bring them together in another Edit. Teachers use it when recording several students singing over the same underlying track. It is a very unique feature and uses for it are still being discovered!

Edit clips behave in the arrangement just like Audio clips. How can you tell the difference? They have an additional tab in Properties to manage the link to the underlying Edit.

The Inline Mixer

Waveform’s default inline Mixer is one of it’s unique, defining features. For each track, signal flows from left to right - Input to Track, Track to Mixer, Mixer to Master. The Mixer is where you arrange plugins to create whatever channel strip you need for the track. If you have MIDI clips on the track then insert virtual instrument as a sound source. If you need to EQ a vocal, drop in an EQ.

Note: Waveform also has a full Mixer view that represents channels and plugins as they would be on a mixing console. To use the Mixer view, click on the show/hide mixer panel button in the upper right corner of the Waveform interface. See Chapter 38 - Mixer View to learn all it.
The Volume & Pan and Level Meter plugins are installed on new tracks by default, however you can remove, reorder, or even add more instances of them. You will find the following things on every track by default:

**Mixer Default Setup:** Volume & Pan Plugin, Level Meter Plugin, Solo Button, Mute Button

**Volume & Pan Plugin**
This acts as like the channel fader and pan controls on a conventional mixer. When you click either element, a larger version pops up allowing you to easily adjust level or panning. When selected, the full set of properties appear in Properties.

**Level Meter Plugin**
The level meter shows the level of audio on the track. You can add additional instances or put the meter anywhere in the track using drag and drop. You can change the meter response between Peak, RMS, and Sum & difference from the right-click menu or from Properties.

**Mute**
The *Mute* button mutes and un-mutes the track.

**Solo**
The *Solo* button silences all other tracks so you can hear one track at a time. *Settings > General Behavior > Solo Behavior* allows you to customize exactly how *Solo* works. Choose from *Cumulative* or *Exclusive* modes. From the right-click menu you can choose *Solo Isolate* which allows the track to continue to play if another track is soloed. This is particularly useful if a track is configured as an effects bus.

**Tip:** Right-click on either *Mute* or *Solo* to access a menu. From here you can reset all the solo and mute states for all tracks.
The Controls Panel

Making up roughly the lower third of the Edit tab, the Controls panel is made up of three main parts: The Menu section, the Properties section, and the Master section.

The Menu Section

A full set of menus related to the Edit are available in the Menu Section. Of particular importance are the Export, Click Track, Snapping, and Options menus. In this user guide, we make numerous references to the Menu section using a path syntax separated by “greater-than” symbols. For example, “to set a one bar count-in choose Click Track > Pre-record count-in length > Use a 1 bar count-in.”
Properties Section

What is shown in Properties depends on what object you have selected. Each track, input, clip, plugin, rack, and automation point has its own set of properties. Click to select any object and Properties will automatically switch to show the values and actions that are relevant to whatever you have selected. This is a key concept when using Waveform, and is central to its design.

Master Section

The Master section contains cursor position information, the Transport, Master plugins, Master volume control, and a set of global control buttons.
Cursor Position Info

At the top of the Master section, you will notice three key pieces of information about the current cursor position: The tempo, the time signature, and the location counter.

- Click the tempo display to see tempo properties.
- Click the time signature for time signature properties.
- Click and edit any part of the location counter to move the cursor to that location.

You can also drag any of the components of the location up and down to move the cursor. The location counter format will change to match what you have set for the Timeline.

The Transport

The Transport is made up of a set of eight buttons that include all the usual suspects: Play/Stop, Record, RTZ, Rewind, and Fast Forward. In addition, there are buttons for Automation Read, Automation Write, and Panic. The Panic button restarts Waveform’s audio engine. All of these can be assigned to keyboard shortcuts for fast access.

Master Plugins Area

The Master section also contains a plugin area to insert final processing like compression and limiting. With no plugins installed, it will display (Drop Master Plugins Here). Drag plugins from the Browser or the Plugin object here or right-click to add them.
Master Section Buttons
The Master section includes eight buttons to access commonly used global on/off functions. More on these buttons in a moment.

Master Level
The Master level provides the final volume adjustment for the entire mix. The corresponding pan control provides control of the balance between the left and right signals. For most applications the master pan control will remain centered.

Master Meter
The Master meter shows the final output level. Right-click the meter to set the meter mode or reset any overload indicators.

Master Section Buttons
The Master section buttons include some of the most used functions in Waveform. This is a description of what these buttons are for along with the shortcut used to toggle the button.

Loop
Loop (L) turns looping between the In-marker and Out-marker on and off. This is for both playback and loop recording.

Click
Click (C) turns the metronome click on and off.

Auto Lock
Auto Lock is short for “Automation Lock.” As the name implies, this button locks automation to clips. When on, as you move clips around the automation curves follows along.

Punch
With Punch (P) tuned on, Waveform will only record when the cursor is between the In-marker and the Out-marker.

Snap
Snap (Q) button turns snap-to-grid on and off.
Scroll

With Scroll (S) turned on, Waveform pans the screen to keep the cursor on screen during playback and recording.

MIDI Learn

Click MIDI Learn to enter MIDI Learn mode. In this mode you can easily assign external controller knobs and faders to on-screen controls.

MTC

With MTC enabled, Waveform will chase sync to incoming MIDI Time Code. Unless you are still syncing to tape or hardware sequencers, leave MTC off.

Compact Toolbar

To save space while recording Waveform offers an alternative to the traditional Controls Panel. The compact Toolbar does most everything the standard Controls Panel does while taking up a fraction of the screen space. Not only that, you can switch back and forth between the Toolbar and Controls Panel easily.

The New Compact Toolbar

To open the full Controls Panel from the Toolbar, click the open icon at the far left.

Click the Open Icon

To shrink the Controls Panel down to the Toolbar, click the close icon at the top right of the Menu Section.

Click the Close Icon

The left side of the Toolbar includes icons to open and close the Menu and Properties sections along with dedicated Undo and Redo buttons. Also, all of the buttons from the Master section appear as icons on the Toolbar.
Tip: Hover your mouse pointer over any icon on the Toolbar and look at the rollover help in the upper right corner of the Waveform window to see what it does.

Working with Properties in Compact Mode

In Waveform you constantly need access to Properties. With the compact Toolbar, the pop-out Properties panel closes every time you select a different object: clip, track, automation curve, or plugin.
To keep Properties open you can pin it using the push-pin icon at the upper right. With it pinned, Properties will only close when you click its icon on the Toolbar. You can always leave it pinned all the time, and open and close Properties manually.

Tip: There is a macro action to enable the Properties push-pin under Basic Actions > Editing > Lock properties panel. See Chapter 37 - Keyboard Macros to learn how to use scripts like this.

```javascript
1 // Pin Properties Panel Open
2 Tracktion.lockPropertiesPanel();
```

**Keyboard Shortcut to Toggle the Toolbar**

If you want to easily switch back and forth between the Toolbar and the standard Controls Panel, there is a macro action to do so. Here is how to set it up:

1. Go to the Settings tab, Keyboard Shortcuts page.
2. Open the Script Editor at the bottom of the page.
3. Click Add a new macro.
4. Fill in a name such as “Toggle Controls Panel Size.”
5. Right-click the editor and navigate to Basic Actions > Zooming > Toggle between full and minimal controls panel.

Selecting the Toolbar Toggle Action

1. That’s all there is to the macro. Now, assign it to a keyboard shortcut, such as F11.
Note: In the default key-mapping used in this user guide, \textit{F11} is assigned to \textit{Show/Hide Controls Panel}. You may find that toggling between the Toolbar and the Controls Panel is a much better use of \textit{F11}.

Moving On

That was a broad overview of sections, controls, and buttons on the Edit tab. Next, we start to break all this down so you can have fun making music with Waveform.
Chapter 9 - The Browser

The Waveform Browser provides quick access to files, loops, plugins, and presets. It allows previewing loops, filtering of your Tracks by tags, and bookmarks to your favorite folders. When you have located media files and plugins in the Browser, you add them to the Edit using drag and drop. The Browser also has tabs for notifications and the clipboard. In this chapter, you will learn about each of the tabs.

Open and close the Browser (B) with the Browser icon. Drag the Browser icon to the top, right, or left edge of the Window to reposition it. You can also resize the Browser tab by dragging the right edge right or left.
Another way to set the Browser position is available on the Settings tab, General Behaviour page. Locate the setting *Side Panel Position* and set it to Left, Right, or Top.

**Browser Files Tab**

The Browser Files tab allows you to find audio files on your system to include in your project. You can also preview audio files and set bookmarks. After you export mix downs of your song, you can easily find them in the Files tab as well.

**Browser Files Tab Controls**

Here are controls at the top of the files tab.
Browser Files Tab Controls

Browser Files Tab Menu

In use, the Files tab shows a list of files. Click the Files menu button to choose what to list. The menu is divided into sections. These aren’t labeled in the software, but the graphic here shows what each section does.

Creating Bookmarks

To create a bookmark to a favorite file location, navigate in the Files tab to any drive and
folder on your system. When you locate a frequently used folder, open the Files tab menu and select *Bookmark current folder*.

**Tip:** Using bookmarks is a great way to access your loop library if you already have it organized by folders. This is often a more direct way to get to certain loopsets than searching in the Search tab.

**Removing Bookmarks**
To remove a bookmark, navigate to that folder, click the Files menu icon, and select *Delete bookmark for current folder*. Notice that the delete option will only be available when the current folder has been bookmarked.

**Tip:** A quick way to located exported mixes of your song is to use the Browser Files tab. From the Files menu, select *Project folder > Exported*. By default all your exported files go into this subfolder of the parent project folder. To get to the resulting file directly on your system, right click any file and select *Open the folder containing this file...*

**Tip.** Quickly Locate Exported Mixes in *Project folder > Exported*

**Browser Files Info**
Information about the selected file shows in the Files tab footer. This includes the sample rate, bit depth, stereo or mono, length, number of beats, BPM, and time signature. The info varies depending on what meta data is included with the file.
Auditioning Files

Click any audio file in the files list and use the Play/Stop button along with the Audition level to preview it. By default, audio files start to play immediately when you select them. You can turn that off by deselecting Auto-Play. With Loop enabled, files play continuously until you press stop or select a different one. You can also see a thumbnail of the waveform along with a moving playhead line during the audition.

Tracks Tab

The Tracks tab works in conjunction with track tagging. Once tracks are tagged, you can filter which tracks to view from the Tracks tab by enabling Show Only Tagged Tracks and then clicking on the tags for the tracks to view. All tracks that do not include the tags are hidden.

The most common scenario is to tag tracks of a similar kind like “drums”, “guitars”, or “vocals.” Then you can filter by those types.

Tagging Tracks

To add tags, select one or more tracks in the arrangement, and type the tags into the Tag field in Properties. You can enter as many tags as you like separated by commas.
Filtering by Tags
To filter the visible tracks in the arrangement by tags, enable Show Only Tagged Tracks at the bottom of the Tracks tab. Click a tag to show only tracks that include that tag. You can click several tags to show additional tracks. If no tags are selected, then all tracks are shown. If you turn off Show Only Tagged Tracks, then all tracks are shown.

Removing Tags
To remove a tag from a single track, edit the Tag property in Properties for that track. Remove a tag from all tracks by right-clicking the tag in the tag field of the Tracks tab and selecting Remove Tag. A dialog box will appear to confirm the deletion. Click OK and the tag will be removed from all tracks.

Search Tab
The Search tab allows searching by keyword and filtering by tags for loops, presets, and plugins. This unified search also gives you all the same preview functions offered in the Presets tab for auditioning loops.

Searching
To search for a file, simply start typing into the Search box. The results will immediately
appear in the results list. Searching and the results list include the Name, Tags, Category, and Manufacturer organized into columns. You can sort by any column by clicking on its header. You can rearrange the columns by dragging them. Search terms are not case sensitive.

<table>
<thead>
<tr>
<th>Name</th>
<th>Tags</th>
<th>Category</th>
<th>Manufacturer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume Pan</td>
<td>Mixing</td>
<td>Effect</td>
<td>Tracktion Software</td>
</tr>
<tr>
<td>Level Meter</td>
<td>Mixing</td>
<td>Effect</td>
<td>Tracktion Software</td>
</tr>
<tr>
<td>Patch Bay</td>
<td>Mixing</td>
<td>Effect</td>
<td>Tracktion Software</td>
</tr>
<tr>
<td>Aux Send</td>
<td>Mixing</td>
<td>Effect</td>
<td>Tracktion Software</td>
</tr>
<tr>
<td>Aux Return</td>
<td>Mixing</td>
<td>Effect</td>
<td>Tracktion Software</td>
</tr>
<tr>
<td>Text</td>
<td>Mixing</td>
<td>Effect</td>
<td>Tracktion Software</td>
</tr>
<tr>
<td>Freeze Point</td>
<td>Mixing</td>
<td>Effect</td>
<td>Tracktion Software</td>
</tr>
</tbody>
</table>

Search Results List

Tip: If you can’t see all the search list columns, expand the width of the Browser by dragging the right edge.

What to Search For?
You can further refine searches by selecting which type of things to include. Click the search loop icon and select from Loops, Presets, and Plugins. Notice that the tag field will adjust to include only the appropriate tags for the types of items enabled.

Tag Field
To filter by tags, click any combination of tags. The logic for the selection is “and.” What I mean is this. If you select both “Drums” and “Mallets” tags, the results list will only show items tagged with both Drums and Mallets.
Setting Tags

You can set or change the tags for one or more items in the results list with a right-click. The exact process is a bit different between loops, presets, and plugins. For Plugins and Presets, you right-click and select Set Tags. A single line field opens for editing where you and type in or edit the tags. Separate the tags with commas.

For loops, the same right-click and Set Tags opens the larger Tag dialog box. From there you can see available tags, type in new ones, or edit the existing ones.

Edit Preset Name

Right-click to open the Preset Details dialog box which presents Name, Description, and Tags fields that you can edit and save.

Audition

Select a loop in your search results and press the Play/Stop button along with the Audition level to preview it. By default, loops play immediately when you select them. You can turn that off by deselecting Auto-Play. With Loop enabled, files play continuously until you press stop or select a different one. The preview also features a nice waveform thumbnail to give you a visual reference to the loop content.
Using Search Results

Anything you find and want to use, drag from the search results to the arrangement. Track loops to tracks, drag plugins to the mixer or Audio clips. Drag instrument presets to the mixer. Drag track presets to tracks.

Indexing Your Loop Library

If you want Waveform to be able to search for loops, you need to index your loop library. Do that from Settings > Loop Database > Scan for Loops. You will see options on that page to enter paths to your loops.

Note: If you don’t want to use Waveform to search your loop library, then you don’t need to have it scan and index your files. You can simply create bookmarks to your loop library folders on the Files tab.

Markers Tab

Use the Markers tab to add Bars & Beats or Timecode markers to the Marker track. You can also use it navigate to any marker by double-clicking on the marker name. You can also quickly delete the selected marker or change its name in Properties.

We have complete coverage of Markers and the Markers tab in Chapter 10 - Using Markers.
Clipboard Tab

The Clipboard tab shows the most recent item copied or cut. Copies are typically done using Cmd + C / Ctrl + C while cuts are done using Cmd + X / Ctrl + X. There are also onscreen buttons for copy and cut depending on the object and context.

To use the last item copied or cut you typically use Cmd + V / Ctrl + V. Alternatively you can go to the clipboard tab and drag items onto the arrangement. It is particularly useful when you want to copy elements from other projects on the Projects tab, then drag or paste them into a different Edit. You can also copy and paste between Edits.

Here are few things to know about the clipboard:

**Adding Items to the Clipboard**

The best way is to use the keyboard shortcut to copy a selection of clips (Cmd + C / Ctrl + C). The shortcut for “cut” will also work (Cmd + X / Ctrl + X). These commands are also usually available from right-click menus.

**Dragging Clipboard Items to the Arrangement**

When you drag items from the clipboard you get all or nothing. However before dragging, you can remove the items you don’t want by right-clicking and selecting *Remove item from clipboard).*
Clearing the Clipboard
To remove all items from the clipboard. Right-click any item and select *Clear clipboard*.

**Multiple Browser Panes**

With Waveform you can easily set multiple views into the Browser at the same time. To add a Browser pane, click the tiny + icon at the top right.

When you have multiple panes, each pane has a drop-down menu at the top to choose the Browser view: Files, Tracks, Search, Notification, Markers, or Clipboard.

You can open as many Browser panes as you want. You may want to have one pane showing your Files and another set to Search by plugins.
Browser Setup With Two Panes

The above image above shows the Browser at the top.
To close a Browser pane, click the small X in the upper right.

Synchronized Previews

If you have multiple Browser views open and focused on loop files, you can audition the loops against your song synced to the Edit tempo.

Since Waveform allows multiple Browser panes, you can start previews for several loops at the same time. The Browser preview options have been updated with this in mind. Click the preview options button to open the selections.
Browser Preview Options

**Play All**
This is a new option to start the preview of all selected loops across all open Browser panes.

**Stop All**
This stops all preview playback in all Browser panes.

**Re-trigger on play**
Whenever you start playing back a new loop, all Browser panes that have loops playing will re-start from the beginning. You will want to enable *Re-trigger on play* for each open Browser pane for synced auditioning.

**Auto-play**
With *Auto-Play* enabled, each time you click a loop or select a new loop in a Browser, preview playback will start.

**Loop**
With *Loop* on, preview playback will keep repeating until you stop it. With *Loop* disable, the preview plays a single time then stops.

**Tip:** Enabling *Re-trigger on play* is essential to have multiple Browser panes preview in-sync.

When you find a set of loops that work well together using multiple Browser panes, you probably want to drag them to your Edit. You can do this in a single operation by dragging one loop while holding Shift. The Shift modifier causes all the loops to be included in the drag. Next, drop the all the loops and you are presented with a list of options. Select how you would like the clips to be added to the Edit.
Video Clip: This video tutorial\textsuperscript{23} demonstrates this feature but was created before the Options menu was implemented.

Moving On

Reading about all the features of the Browser should give you more insight into the capabilities of Waveform. It will make even more sense after you get familiar with the core workflows of recording, editing, and mixing.

\textsuperscript{23}\url{https://youtu.be/KEVG8gm9U28}
Chapter 10 - Using Markers

In this chapter, you will learn about using markers in Waveform. There are four different kinds of markers:

**In-marker and Out-marker**
Together these define the “marked region”, that is the region for looped playback and loop recording. Many editing functions rely on the position of the In-marker and Out-marker.

**Bars & Beats markers (B&B Markers)**
Bars & Beats markers can be used to identify song sections, give you a visual guide to the song, and provide quick navigation to different parts of your song. They are arranged as clips on the Marker track. Bars & Beats markers appear with a musical note icon on the Marker track. They also appear as narrow pointers on the Timeline when the Marker track is closed.

**Timecode Markers (TC Markers)**
Timecode markers mark a specific time offset into the Edit, and are not dependent on tempo changes. They can aid with navigation, especially when working with video. TC markers appear as clips with a clock icon on the Marker track. They appear as rounded pointers on the Timeline if the Marker track is closed.
Note: In Waveform, the term ‘marked region’ means the range of an edit that occurs between the In-marker and the Out-marker.

Wave File Markers
You can add yellow arrows directly to Wave files that then appear on Audio clips. These are the least useful type of markers. More about them near the end of this chapter.

In-marker & Out-marker
Position the In-marker and Out-marker by dragging the I and O flags along the Timeline. The In-marker and Out-marker together define the range over which playback will loop when the Loop button in engaged in the Master section. They also define what is called the “marked region” used for numerous editing actions.

• Pressing I places the In-marker at the cursor position
• Pressing O places the Out-marker at the cursor position

Tip: To set the marked region over a selection of clips press A. This also works for Marker clips making it a great way to set the In-marker and Out-marker over a song section.
Drag to Set In-Marker & Out-marker

A really useful trick is to drag across right to left across the body of any track, even blank tracks while holding the keyboard modifiers Cmd + Opt / Ctrl + Alt. The drag action sets both the In-marker and Out-marker.

Timeline Drag to Set In-marker & Out-marker

With Waveform, the loop range is defined by the In-marker and Out-marker. Users of other DAWs are used to dragging along the timeline to draw in the loop range. You can do this in Waveform if you know the trick.

1. Double-click to set In-marker

2. Drag right to set Out-marker

Double-click Drag to Set In/Out Markers

Double-click on the Timeline and start dragging right. The double-click positions the In-marker at the starting point. As you drag right, the Out-marker drags along and is set when you lift the mouse button.

Video Clip: Here is a video tutorial\(^{24}\) demonstrating how to drag to set the In-marker and Out-marker.

Navigate Using the In-marker & Out-marker

You can quickly navigate to the In-marker or Out-marker using the square bracket keys. Press [ to locate the cursor to the In-marker; Press ] to locate the cursor to the Out-marker.

\(^{24}\)https://youtu.be/zaPg04lype4
Zooming to the In-marker/Out-marker

When you have a marked region set between the In-marker and Out-marker you can quickly zoom in to that region. To do that, right-click the Timeline and select *Zoom to show the marked region* or simply to press F7.

- Zoom to show the entire length of the edit on-screen [F5]
- Zoom to show a few seconds around the cursor [F8]
- **Zoom to show the marked region** [F7]
- Zoom to show the currently selected clips [SHIFT + N]

Right-click the Timeline, Zoom to In-marker/Out-marker

Looping Playback Over the Marked Region

To continuously repeat playback over a section of your tune, set the In-marker and Out-marker to define the loop range. Turn on looped playback by engaging the *Loop* button (L). Playback will repeat that section over and over until you stop playback.

- Loop
- Click
- Auto lock
- Punch
- Snap
- Scroll
- MIDI Learn
- MTC

Enabling Loop Playback

- **Note:** When Loop is enabled, playback will only play within the marked region. If the cursor is located earlier than the In-marker or after the Out-marker when you press Play, it will jump to the In-marker and play from there.

Auto Punch and the Marked Region

To use Auto Punch, first set the In-marker and Out-marker over the range where you want to punch in. Enable the *Punch* button (P) in the Master section. Make sure Loop is turned off. Now enable a track for recording, position the cursor before the In-marker and press Record on the Transport. Even though the track is armed for recording, no recording will happen until the cursor gets to the In-marker.
Tip: Auto punch recording means that recording is only allowed between the In-marker and Out-marker. Also, punch recording only works when Loop is off.

The Marker Track

Let’s take a closer look at the Marker track. You can open and close the Marker track with the Marker track show/hide button.

The Marker track can contain either Bars & Beats markers or Timecode markers. If you don’t like to see the types mixed together on the same track, there is an additional split mode that shows each type on separate lanes.

To access that mode, select the Marker track by clicking the header. Then in Properties, de-select Use a single track for all types of marker. In this mode, the Marker track has two lanes. The top lane shows Timecode Markers and the bottom lane shows Bars & Beats Markers.
Note: F10 is assigned to action *Toggle the marker view mode*. Pressing F10 cycles through the three marker track states - hidden, normal, and split mode.

Tip: You can click on any blank space in the Marker track to instantly position the cursor.

## Adding Markers

Here are the various ways to add markers to the Marker track:

### Drag the Clip Object

Drag the Clip object to the Marker track and choose which type of Marker to create. This creates a Marker clip you can drag and resize. It has left and right trim handles to adjust the length. You can also drag a marker by its header and move it around. If the Marker track is in split mode, the type of Marker (B&B or TC) is determined by which lane you drop the Clip object on.

![Adding a Marker by Dragging the Clip Object](image)

### Press Return

The Return key (Enter on PCs) has several functions related to Marker navigation during playback. At the most basic level, pressing Return adds a new Marker at the cursor position. The type of Marker clip matches the most recently added Marker. If a Marker clip is selected, it adds one of that type. Markers added with Return, use the next available sequential Marker number.

### Right-click the Marker Track Header

Right-click the Marker track header and choose which type of marker to add at the cursor position.

![Add a Marker from the Marker Track Right-click Menu](image)
Marker Track Properties Buttons

Click the Marker track header to select it, then look in Properties. There you will find the buttons **New Bars & Beats Marker** and **New Absolute TC Marker**.

![Marker Track Properties Buttons](image)

Add a Marker from Marker Track Properties

Browser Markers Tab *Add* Button

You can add either kind of Marker Clip using the selections on the Browser, Markers tab.

![Add markers from Browser, Markers Tab](image)

Add a Marker from the Browser, Markers Tab

**Marker Clip Properties**

Marker clips behave like other clips in several ways. You can adjust the length using the trim handles, you can split them, drag them, duplicate them, or nudge them. They also contain several properties, described below:

**Number**

Marker numbers are issued sequentially as you add Marker clips. You can edit the *Number* property if you want. If you change *Number* to one that is already in use, then the other clip using that number will be assigned the next available number. Marker numbers can be used for quick navigation during playback.
Tip: If you feel compelled to renumber all your Markers to get them into a nice sequential order, you might want to skip some numbers, in order to make it easier to insert new Markers. For example, if you have a lot of markers in the song, you could re-number them by 5s.

Type

Type allows you choose which type of Marker clip you want: Bars & Beats or Absolute. Bars & Beats markers adjust to the tempo changes in the song. Timecode markers are fixed to a specific time offset into the Edit and are not affected by tempo changes.

Note: Timecode markers are also called “absolute markers”, “TC markers”, or “absolute timecode markers” within Waveform. All those terms refer to the same thing. For this book, I usually call them Timecode markers.

Name

The Name property sets the name shown on the Marker clip. By default it will be “New Marker.” Most users rename it based on song section. For example: Intro, Verse, Chorus, Bridge, or Outro.

Start

The Start property shows the bar, beat and tick start time for B&B markers. For Timecode markers it shows Hours/Minutes/Seconds/Milliseconds. For either type, you can edit Start directly to move the marker to a different location.

Length

Similarly, Length shows B&B marker length in Bars/Beats/Ticks format. For Timecode markers, it shows length as Hours/Minutes/Seconds/Milliseconds. Edit the Length property and the Marker clip length will change to match.

End

End values are in the same format as the Start property. Edit it to change the ending time. When you change the End value, Length gets adjusted to match. Start always remains the same. If you edit End to fall before Start, it will be set to match the Start time. In that case, Length gets set to zero.

Colour

Choose from one of the nice colors. This sets all selected Marker clips to the color you choose.

Tip: You can change a Marker clip from Bars & Beats to Timecode using nudge. Press F10 until the Marker track split mode is showing. Select the marker clip to convert and press Shift-up or Shift-down to nudge the clip to the other lane.
Navigating by Markers

Once you have Markers set up, you can quickly navigate using the Marker number and the Return key. Just type in a Marker number like ‘5’ or ‘11’ and hit Return (‘Enter’ on PCs). As you type the number you will see it appear in green in the upper right of the Waveform window. When you see the number, you have about two seconds hit Return before the number disappears.

![Marker Number As It Appears Momentarily](image)

If you enter a number that doesn’t have a matching Marker, then Waveform will insert a marker with that number at the cursor. Also, if you just press Return, a Marker clip is inserted at the cursor position.

Undo (Cmd + Z / Ctrl + Z) removes a marker if you didn’t intend to insert it.

Tip: The Number + Return approach to navigation works during playback but also works when Waveform is idle. If it doesn’t seem to be working when playback is idle, click the header of the Marker track or select any Marker and try again.

The Browser Markers Tab

Use the Browser Markers tab to add Bars & Beats or Timecode markers to the Marker track. You can also use it navigate to any marker by double-clicking on the marker name in the list. You can also quickly delete the selected marker or change its name in Properties.
Select Marker Clips
   Single-click a marker in the list to select it.

Navigate to a Marker clip
   Double-click on a marker in the list to jump to that position. This works during playback too.

Rename a Marker
   Click a marker to select it. Then, edit the Name property in Properties.

Add a Marker
   Click Add at the bottom of the Markers tab. Select from the two types: Absolute timecode marker and Bars & Beats Marker.

Delete a Marker
   Select a marker in the list and click Delete or just press Delete on your keyboard. Undo (Cmd + Z / Ctrl + Z) restores a deleted marker.

Change a Marker from One Type to the Other
   Select the marker and edit the Type property in Properties. Or drag it from the TC Marker track to the B & B Marker track or vice-versa.
Renumbering Markers

It is sometimes too easy to get your marker numbers out of order, but there is an easy trick to renumber them: Open the Markers tab in the Browser. Select all of the markers and edit the Number property. For example if it shows “1” with all the markers selected change it to “2.” The markers instantly renumber starting from “2.” If you really want them numbered starting from one, simply do it again, changing the Number property back to one.

Adjust Markers (Wave File Markers)

There is another type of marker in Waveform, also called “markers.” They appear to mark spots in a clip, but actually are stored in the underlying Wave files. You work with these markers from the Adjust Markers actions in Audio clip properties. You also add and remove them by dragging the marker object in Audio clip properties View Source Info.

<Tip> Don’t bother using this kind of marker. This a hold over from legacy versions of Tracktion that required much more interaction with the undying files.
Moving On

Markers can be extremely useful in the context of recording and editing. Not only do they keep your project organized, they also provide easy navigation into important locations within the Edit. Now you are familiar with all of the various types of markers in Waveform.
Chapter 11 - Selecting and Snapping

In this chapter, we start working with clips. The examples focus on Audio Clips and MIDI Clips. Keep in mind that most of these techniques also apply to Step clips, Edit clips, and Marker clips.

First, you’ll learn how to select clips and groups of clips. Then, you will learn about the snap-to-grid functions. Snap-to-grid makes it easy to align clips to the bars and beats of your song. Let’s get started with selecting clips.

Selecting a Clip

To select a clip, simply click on the clip. The clip is highlighted and its properties appear in Properties.

Auditioning a Clip

To audition a clip, double-click and you will hear it play back, starting at the spot where you have double-clicked. Click within the clip to jump to a new spot as playback continues. Click anywhere outside the clip and the auditioning will stop. Moving pointers above and below the clip indicate the playback position.

Auditioning essentially solos the clip; everything else within the Edit is muted in this mode.
Selecting Multiple Clips

To select more than one clip, hold down Cmd / Ctrl then click on each clip that you want to add to the selection.

Once you have multiple clips selected, you can perform operations on them as a group, such as moving them by dragging, duplicating, or deleting them. We’ll cover more about clip editing operations in Chapter 12 - Basic Audio Editing. To clear a multiple selection, simply press the Esc key.

Another way to make a multiple selection is to use the lasso tool. Here’s how that works:

1. Hold down Opt / Alt until you see a plus cursor.
2. Now as you drag, the cursor draws a yellow box.
3. Anything the yellow box touches gets selected.

Tip: You can further customize a multiple selection by holding down Cmd / Ctrl then click any clip you want to de-select.
Shift Selecting Clips

Waveform also supports Shift-select. This is a quick way to select a contiguous range of clips. Here’s how:

1. Select the first clip.
2. Hold down Shift and select the last clip. This will select the first clip, the last clip, and all the clips in between.

Shift-select works for clips on a single track, and even across multiple tracks.

> Tip: Shift-select also works for many other kinds of Waveform objects including Browser lists and tracks.

Deselecting Clips

You can always press Esc to deselect everything.

> Tip: Pressing Esc also works to clear selections of other objects in Waveform like plugins and tracks.

Using Snap-to-Grid

Snap-to-grid makes aligning clips and notes to musical time accurate and efficient. Working with this powerful feature is crucial to using Waveform for editing audio and MIDI.

Enable/Disable Snap-to-Grid

To toggle snap-to-grid on or off, click on the *Snap* button (Q) in the Master section. When snap-to-grid is enabled the *Snap* button appears highlighted.
Pressing Q also toggles Snap on and off. You can also control the snapping state from the menu section - Snapping > Enable snapping.

Tip: Remember the keyboard shortcut Q is short for quantize. Snap-to-grid is a form of quantizing. If you don’t like that shortcut, you can always remap it to another key.

About Snap Resolution

The snap resolution is dependent on the zoom level. If you’re zoomed way out, the snap resolution might be one bar. The more you zoom in, the snap resolution gets finer and finer.

Tip: You can always see what your current snap resolution is by hovering the mouse pointer over the Timeline. A tooltip appears showing Snap resolution: Bar, Snap resolution: Beat, or Snap resolution: Half beat for example.

Snapping Clips to the Grid

As you drag a clip, it snaps to the grid increments. If you want to see exactly where it’s snapping, look at the Start parameter in Properties. Snap-to-grid makes it easy to align a clip to a bar or beat of the music.
Note: Snap-to-grid is an alignment of the beginning of a clip to a grid line. Notice that snapping also applies to editing functions like trimming.

Snapping the Cursor to the Grid

Snapping may affect how the cursor is positioned depending on another setting. Turn on Snapping > Snap cursor movement and the cursor position will snap to the grid. Remember that the snap resolution is determined by the zoom level.

Tip: To get clear indication of exactly where the cursor is, look at the time display in the Master section.

Snapping Clips to Other Clips

Another snap behavior is to Snap clips to neighbors. With Snap clips to neighbors off, clips snap to the grid normally. However, with Snapping > Snap clips to neighbors turned on, clips snap to other clips. It seems as if they are magnetically attracted to each other. This is useful for any editing where you want to arrange clips end-to-end, for example when editing voiceover tracks.
Tip: A problem with Snap clips to neighbors is that you need to have snapping enabled for it to work. To snap clips to other clips with snap-to-grid disabled, just hold down Opt / Alt as you drag. This is really the best way to arrange clips end to end!

Overriding Snap-to-Grid

Temporarily override snap-to-grid by holding down Cmd / Ctrl. Using this modifier, you can freely position clips without first turning off Snap.

Nudging Clips

To move clips using the keyboard, select a clip then press Shift + Right Arrow or Shift + Left Arrow. The nudge action moves the clip by one grid increment. You can also move clips track to track using nudge. To nudge clips track to track, use Shift + Up Arrow and Shift + Down Arrow.

You can use nudging when moving large selections of clips over, to add a song section or make room for an intro.

Note: Nudging works the same whether snapping is on or off. The nudge move is by one grid increment.

Nudging Notes

Snapping is useful when working with Audio clips, but equally so when working with MIDI notes. We cover MIDI editing in Chapter 25. However, here is a preview while we are on the topic of nudging.
Double-click on the header of a MIDI clip. It goes into the large view so you can see the in-line MIDI editor. MIDI notes work much like clips, in that they respect the snap resolution. You can drag a note to snap by the current grid increment: bar, for example. You can nudge notes forward or backward in time by the grid increment as well. To do so, hold Shift while pressing the Left Arrow or Right Arrow.

Tip: Remember the keyboard shortcut Q to toggle Snap on and off.

Moving On

Now that you’ve learned how to get around in Waveform, it’s time to start having fun manipulating audio. We’ll jump into that in the next chapter.
Chapter 12 - Audio Clips and Editing Audio

In this chapter, you are going to learn how to work with Audio clips. and how to work with the integrated editing handles that are part of each Audio clip.

Parts of an Audio Clip

Notice that an Audio clip has several parts. It has a header that includes trim and slip handles. It has a body that contains the waveform thumbnail and fade handles.

Header
Move Audio clips by dragging from the header. The header includes the trim handles (hollow), slip handles (solid), and other tools.
Body

The Audio clip body features the waveform thumbnail, fade handles, and the clip name.

Plugins

Audio clips can host plugins directly, so you might see one or more plugins right on the clip body. Learn more about that in Chapter 32 - Clip Effects.
Properties

Like most other objects in Waveform, Audio clips have lots of additional properties and controls in Properties.

Audio Clip Properties

Note: If you accidentally move or edit an Audio clip, you can always press Undo (Cmd + Z / Ctrl + Z) at the top of the Menu section to get right back where it was.

Moving Clips

As you move the mouse pointer over the Audio clip header, it changes to a grabbing hand. Use that to drag the clip forward or backward in time. If Snap is on, the beginning of the clip will snap by grid increments.

Move Audio Clips by Dragging from the Header

Note: As we discussed previously, the grid resolution depends on the zoom level.

You can also drag Audio clips from track to track. With snap enabled, track-to-track drags will usually stay in sync. However, with snap turned off, it is easy move the clip slightly off time. To prevent that, hold down Shift as you drag track to track. The Shift key, constrains the timing of track to track drag moves.
Tip: Another way to move a clip track-to-track without changing the timing is to use nudge. Select the clip the hold down Shift and press Up Arrow or Down Arrow to nudge it to an adjacent track.

Deleting Clips

The easiest way to delete a clip is to selected it and press Delete or Backspace. The cut (Cmd + X / Ctrl + X) keyboard action does the same thing. If you need yet another way to delete, locate and click the convenient **Delete** button in Properties.

Tip: As you work with clips sometimes you just want clear the selection. The fastest way is to just hit Esc.

Audio Clip Handles

Each Audio clip header includes six handles that you use for trimming, slipping, stretching. These are represented as four arrows and two boxes.

Trimming

Hollow left and right arrows on both of the upper corners of the clip are trim handles. Grab a trim handle and drag left or right to trim the start or end of the the clip. Notice that trimming this way directly changes the **Start** and **End** values in Properties. With **Snap** turned on, trimming snaps to the grid. To trim freely, hold down Cmd / Ctrl as you drag or turn **Snap** off.
Slip Editing

Slip editing means moving the waveform within the clip without altering its Start, Length, or End values. Drag the solid box shaped handle left or right to slip edit. You can override snap-to-grid during slip editing by holding down Cmd / Ctrl.

Reframing

The hollow box shaped handle allows reframing the clip. Drag it left or right and the clip moves but the waveform doesn’t. It essentially allows you to reframe the audio without affecting its timing.

Slip Trimming

The solid left and right arrow handles are for slip trimming. Try dragging the left solid arrow. Notice that it moves the clip Start while keeping the End planted. Now try the right solid arrow. Moving that one, moves the End while keeping the the Start planted. Although this operation seems similar to trimming, the difference is that the underlying waveform slips relative to the end that is not moving.

Tip: With Snap on, hold down Cmd / Ctrl as you drag to temporarily override snapping for most editing operations.
Splitting a Clip

Splitting Audio clips, is essential for audio editing. Here is the quickest way:

1. Select the clip
2. Position the cursor where you want to make the split
3. Press slash (/)

Tip: If you want to make numerous splits, you can keep holding down the left mouse button as you drag the cursor and press slash (/) - never lifting the mouse button.

Audio clip Properties also has Split Clips actions. Look to the far right of Properties and find the Split Clips button. You will find options to split at the cursor along with options to split at the In-marker or Out-marker. Keep in mind that these actions will only affect selected clips.

Duplicating Clips

To duplicate one or more clips, select the clip and press D. That will copy the clip and paste it right after the original clip. Duplicate works like copy and paste, all in one action.

---

Video Clip: Basic Audio Editing

https://w-edstrom.wistia.com/medias/qr0fax85zn
Tip: If you want to use a different key for the duplicate action, you can change it in Settings tab > Keyboard Shortcuts > Editing Functions: Duplicate.

Fade-in/Fade-out

In the upper corners of the Audio clip body, notice the fade handles. Each is shaped like a tiny box with a diagonally line through it. Grab a fade handle and pull it inward. This action draws a fade-in or fade-out.

Audio Clip Fades

Video Clip: Fade-in/Fade-out Demo\(^2^6\)

By default, you will get a linear fade, but there are other fade types available in Properties for the clip. For more control, directly edit the **Fade In** and **Fade Out** numerical values in Properties.

Audio Clip, Fade Properties

---

26http://vimeo.com/user356034/fades
Pitch Fade

Right click on the fade handle, and you can select between a volume fade and pitch fade. Pitch fade gives you a very cool tape stop effect or tape run-up effect. The fade graphic is shaded darker than for volume fades.

Here is a video tutorial demonstrating pitch fade:

Pitch Fade Video Tutorial\(^{27}\)

Crossfades

A crossfade is fading out one Audio clip while fading in another. Some controls in Waveform are labeled “X-Fade” when referring to crossfade. Here are the steps to create a crossfade:

1. Drag a clip so that it it overlaps another one somewhat.
2. Press X on the keyboard.

That’s it: a crossfade. It’s a fade-out that overlaps the fade-in of the next clip. You can adjust the fade shapes using the buttons in Properties, just like any other fade.

Note: Keep in mind that the fade shape buttons only operate on the selected clip. You will need to select the clip on the appropriate side of the crossfade for the fade shape buttons to work.

\(^{27}\)https://w-edstrom.wistia.com/medias/o2ff37pknl
Drag Crossfade

The Settings tab, General Behaviour page has a setting labeled Default Drag X-Fade. It has two possible settings: On by default or Off by default. When set to On by Default, the simple act of dragging a clip so that it overlaps another clip will create a crossfade. Other DAWs call this “auto-crossfade.”

![Settings Tab, General page, Drag Crossfade Default](image)

**Note:** In Waveform, Drag-X Fade is actually a property of each Audio clip. When you change Default Drag X-Fade it will only take effect for new clips you create or add to the Edit.

Edge Fades

When editing, sometimes you need to apply short fades to both edges of an Audio Clip to avoid popping. This is especially true if you split a clip in the middle of a note. The solution is add as short fade-in and fade-out to the clip. Waveform calls those “edge fades.”

![Apply Edge Fade](image)

The good news is that you can instantly add edge fades by clicking Apply Edge Fade in Properties. This applies 7 ms fades to the start and end of all selected clips.

Copy and Paste

Typical cut, copy, and paste commands also work with with Audio clips:

- Cut (Cmd + X / Ctrl + X)
- Copy (Cmd + C / Ctrl + C)
- Paste (Cmd + V / Ctrl + V)
Clip Gain, Mute, & Pan

Adjusting the gain of an Audio clip is a great tool for mixing. Simply split out one phrase, or even one note and tweak the gain level. Waveform has not only clip gain but also clip mute and pan - all available in Properties. When working with stereo Audio clips, Pan works as a balance control.

Gain
Drag the slider left or right to adjust the Gain value. Alternatively, click the slider and type in a value directly. The gain change is reflected right away in the height of the waveform thumbnail on the clip.

Mute
Click the Mute icon to silence the clip. The waveform thumbnail will dim to gray.

Pan (Mono Clips)
Drag the Pan slider left or right to adjust the stereo placement of the clip. You can also click and type in values directly. Full left is -1.00, centered is 0, and full right is 1.00.

Pan (Stereo Clips)
With stereo Audio clips, Pan acts as a balance control. What that means is that as you slide it more right the left side gets quieter. Slide it left and the right side gets quieter. At the extreme left and right positions the opposite side is silent. The really cool thing about this is that the waveform thumbnail updates dynamically show to show the effect.

Active Channels (Stereo Clips)
For stereo clips you can turn off either the left or right channels using the Active Channels buttons in Properties. When you click Left, for example, it toggles the left side off. But it’s not just muting the left side, it switches the clip to a mono version of the right side material. The great thing is that the waveform thumbnail updates to show this instantly.
Reversing Audio Clips

Another cool thing you can do is reverse a clip so the audio plays backwards. Simply click the *Reverse* button in Properties. The waveform thumbnail reverses and the sound will be backwards on playback.

![](image1.png)

Reversing an Audio Clip

Deselect *Reverse* to return the clip to normal playback.

**Merging Clips to One Clip**

Following editing, you may want to combine several clips back into a single clip. To do so, select all the clips using shift select or a lasso selection - that means dragging while holding Opt / Alt. Then choose *Render Clips > Merge the selected clips* in Properties.

![](image2.png)

*Render Clips > Merge the selected clips*

In a few moments, Waveform combines the clips into a single contiguous clip. There are many other ways to merge, render, and export that we will explain later.
Here is video demo of merging clips:

Merge Selected Clips Video Demo

**Group Clips**

With Group clips, you can combine clips on a track into a single grouped clip without rendering. The advantage of this is that you can ungroup at anytime for access to the individual clips.

To create a Group clip, select the clips you want to group on a track. It doesn’t have to be a contiguous selection, but the clips do need to reside on the same track.

Next, click *Create Group Clip* in Properties.

---

28[https://w-edstrom.wistia.com/medias/5h6bn8h3vg](https://w-edstrom.wistia.com/medias/5h6bn8h3vg)
Click Create *Group Clip* in Properties

Notice that the resulting clip has a “Group” label and icon on the lower left which indicates the number of clips it contains. It also has a simplified header.

A Group Clip

To ungroup the clip back to the original state, select it and click *Ungroup* in Properties.

Click Ungroup in Properties

If you like, you can create a macro and assign *Group Clips* and *Ungroup* to keyboard shortcuts. In the Script Editor, locate the actions under *Basic Actions > Editing > Group selected clips* and *Basic Actions > Editing > Ungroup selected clips*.

Here is the code:

```java
1  // Group Clips Macro
2  Tracktion.groupSelectedClips();
```

```java
1  // Ungroup Clips Macro
2  Tracktion.ungroupSelectedClips();
```

Group Clips can be useful when working with beats created from sliced up audio. You can treat the Group Clip as a single single clip making move and duplicate operations straightforward. At any point you can ungroup it to modify the various parts.
Linked Clips

You can also easily create linked copies of clips that reference the same underlying audio file or MIDI data. Changes to the original clip then are reflected to any of the linked copies. This works for Audio clips, MIDI clips and Step clips.

To create a linked clip, drag the Linked Clip handle from the clip header. As you drag, you are dragging a copy referenced back to the source clip.

In the following image, we have dragged over a linked copy of an Audio clip. Notice that the lower left of each clip shows a “link” icon indicating that this is a linked clip.

To test the link, we have reversed the audio on the first clip. Since this changes the underlying file, the second clip is also reversed.

Non-destructive edits like splits and fades don’t affect the linked copy. However, anything that affects the underlying file will. For other examples of this type of edit, select an Audio clip then in Properties
open View Source Info > Edit Audio File > Basic Editing Operations.

From this dialog you can perform several kinds of edits to the underlying file. These operations will affect all linked copies as well as the original.

Linked clips might be even more useful for MIDI clips. Any changes made to one of the linked clips are reflected to all the copies. This can be useful when creating a beat that is used many places in a song. If you update one linked copy, they all get revised.

While you could do something similar with looped clips, looped clips are a series of continuous repeats on a single track. Linked clips appear as separate clips and can even be placed on separate tracks.
Step clips can also be copied using the *Linked Clips* handle.

**Tip:** It’s a bit more difficult to identify linked Step Clips because they don’t have clip names along with the link icon. You can identify linked Step Clips because the *Linked Clip* handle in the header turns green whenever there are linked copies present. This holds true for linked Audio clips and MIDI clips as well.

### Deleting a Section of Audio Removing Space

You can easily delete a section of audio from one or more clips and remove the space between clips. While it’s not entirely obvious how to do this, it is easy if you follow these steps:

1. Set the in-marker and out-marker over the section you want to delete.
2. Select all the clips on all tracks (Cmd + A / Ctrl + A)
3. In Properties, choose *Delete > Delete marked region of selected clips, and move up any selected clips* (Cmd + J / Ctrl + J).
Edit with Melodyne

Waveform integrates the incredible Celemony Melodyne ARA technology, for pitch and time manipulation. A Melodyne Essential license is included and you will have received information on how to install it, along with your Waveform order.

Here is how to invoke Melodyne on an Audio clip:

1. Select an Audio clip.

   ![Change Stretch Property to Melodyne](image)

1. In Properties change the *Stretch* property to *Melodyne*. The word Melodyne appears at the center of the clip.
1. Click the word “Melodyne” at the center of the clip to open the Melodyne UI.

Tip: To learn all about Melodyne click Help > Manual within the Melodyne UI. Skip the section on Loading, Transferring and Saving, as those operations are handled automatically by ARA.

Here is how to remove Melodyne from a clip:
1. Select an Audio clip that is using Melodyne.
2. In Properties change the \textit{Stretch} property to \textit{No Time-Stretching} or \textit{Elastic Pro}. Melodyne is removed from the clip.

\begin{itemize}
  \item \textbf{Video Clip:} Here is a video clip that explains how to invoke Melodyne in Waveform\textsuperscript{29}.
\end{itemize}

\section*{Moving On}

Those are the simple but powerful tools in for editing Audio clips in Waveform. But, these are the fundamentals. Let’s move on to looping Audio clips in the next chapter.

\textsuperscript{29}https://youtu.be/N3T8G-qF4zQ
Chapter 13 - Working With Loops

In this chapter we introduce the looping capabilities of Waveform. You can drag in files from your loop library as Audio clips, repeat them with the Duplicate (D) action, or switch any Audio clip into looping mode and roll out repetitions over as many bars as you want. This makes it easy, for example, to extend a short loop into a beat to play over the full length of a song. Loops have a special tab in Properties. which we will explore in this chapter as well.

Getting Loops Into Waveform

There are four ways to copy loops into an Edit.

1. Use the Browser Files tab and navigate to wherever you have audio files and loops on your system. Drag loops you find there to tracks in the Edit. As you drag in loops they appear as an outline until you drop them.
2. Use the Browser Search tab and search for loops and then drag them into your Edit. The Browser also gives you the ability to preview loops to help you select the right one for the song.
3. Simply drag them from your computer desktop drop them onto tracks.
4. From the menu section, select Import > Import an audio or MIDI file. Navigate to a file on your system and click open. The Select a file to import dialog box even includes a basic file audition function with Auto-play.

Setting the Edit Tempo

If you know the tempo of the loop, you might want to set the tempo of your Edit to that tempo before dragging the loop in. That will give you the most natural results.

Changing the Tempo

Here is how to change the tempo:
1. Click on the BPM setting in the Master section. Properties will show the BPM value.
2. Click on the BPM value and type in the new tempo.

**Dragging Loops to a Track**

As you drag a file to a track, you’ll see an outline of the Audio clip before you drop it. Position the beginning of the clip right where you want it on the track, then just drop it. If it’s not in the right place, grab the Audio clip from the header and drag it into place.

After dropping a loop, notice that the cursor jumps to the end of the loop. This is to position the cursor to drop in the next one, as you build up a track.

Tip: If you don’t like having the cursor jump to the end when dropping in loops, hold down Opt / Alt as you drag. This prevents the cursor from jumping to the end.

If Snap is on, loops you drag in will snap to the grid.

**Dragging in Multiple Clips from the Browser**

To drag in several clips at once, make a multiple selection in the Browser and drag the selected loops to a track. They will be arranged on the track end-to-end.

Tip: To drop a selection of clips to parallel tracks, hold down Cmd / Ctrl as you drag and Waveform asks if you want to put them on one track or separate tracks. This is great when working with multitrack drum loops. It even creates additional tracks if there aren’t enough available.

![Add multiple files dialog](image)

Dragging Loops to Separate Tracks

**Looping the Loop**

Audio clips have an L icon on the header. Click the L to toggle looping mode for that clip. Once the clip is in looping mode it will immediately appear to be twice as long. Enabling looping gives you one repeat right away.
Audio Clip Loop Mode

To repeat the clip, drag the right trim handle and roll out as many repeats as you want. You will see a white repeat divider at the start of each repetition. The underlying audio wave file is not duplicated, it is just being replayed over and over. All other editing operations work the same as any other loop.

To stop looping, click the L icon again to toggle looping off. That returns the clip to a single cycle.

There is another way to activate clip looping. Select the clip then click **Loop this Clip** in Properties. From there you can select the number of times to loop. This is an alternative to dragging the right trim handle to roll out repetitions.

The nice thing about looping is it doesn’t take up any additional space in the project. You can loop just about any clip. You could take a four bar drum loop and separate out one or two bars of the main groove then loop it. That can give you the starting point for a song. Roll it out across the entire song, and you’ve got something more inspiring than a simple click track to play against.

**Duplicating Clips**

Another way to repeat a clip is to duplicate it. To do so, select a clip and press D. Duplicate is the equivalent of copy followed by paste. The duplicate clip is placed immediately after the selected clip.
Duplicating a Clip

This is the best approach if you plan to edit the audio in a unique way for that section of the song.

**Loop Properties**

Notice that Properties has a second tab labeled *Loop Properties*. This tab appears whenever you select an Audio clip. These properties are related to the underlying wave file. Tweaks to these properties affect how the Audio clip will respond to tempo, pitch, and time stretching. Here is a description of the most essential properties on the Loop Properties tab:

### Auto-Pitch

With *Auto-Pitch* enabled, Waveform will change the pitch of the clip appropriately to match key change events in the Tempo track. This only works if you have a *Root Note* set for the file; more on that in a moment.

### Auto-Tempo

With *Auto-Tempo* ticked, the Audio clip will be automatically stretched to match the song tempo and tempo changes in the Tempo track. For *Auto-Tempo* to work, you need to make sure you have the *Root Tempo* set for the file and *Stretch* set to an appropriate algorithm.

### Warp Time

With *Warp Time* enabled the waveform view to the right becomes a Warp Time editor. You can add warp points and do fine timing adjustments. This powerful feature is covered in detail in Chapter 18 - Warp Time.
**Time Signature**
Edit *Time Signature* values to set the time signature of the file.

**Root Tempo**
*Root Tempo* is the original tempo of the loop file. Waveform uses this when stretching the file to sync it to the Edit tempo. If *Root Tempo* is not recorded along with the loop file, you can set it here. Files created within Waveform will automatically have the *Root Tempo* set to match the Edit tempo.

**Beats**
The *Beats* parameter is the number of beats in the file. Using *Beats* and *Root Tempo* Waveform calculates the length of the loop file in musical terms.

**Pitch Offset**
If you just want to pitch the file up or down, enter an offset value for *Pitch Offset*.

**Stretch**
*Stretch* sets time stretching algorithm used for this loop file. Usually you will want to use Elastique (Monophonic) for lead vocals and solo instruments. Use Elastique Pro for everything else. Melodyne is typically selected and used for pitch correction using it’s own window.

**Waveform View**
The waveform view allow you to play the file. You can also adjust the in and out loop points by dragging the purple lines inward. There is a convenient level control here as well. This view is replaced by the zoomable Warp Time editor when *Warp Time* is enabled.

**Loop Start/End**
This button contains a few quick tools to set the start and end loop points of the underlying wave files to match the current Audio clip start and end points.

**Beat Points**
*Beat Points* are a type of marker that shows where the transients are to assist with time stretching. This concept is very similar to how acidized files work. With the latest Elastique Pro stretching algorithms manually manipulating the beat points is not necessary.

**Add to Library**
If you create an Audio clip loop and might want to reuse it in other projects, click *Add to Library* then give it a name and tags.

**Note:** When you use *Add to Library*, the loop file will be saved to the *User Loops Path* folder as designated on the Loop Database page of the Settings tab.

**Tip:** If you want more control when adding loops to your library, try *Export > Render to a File*. If you choose, *Only Render Selected Clips* you get much more control over its properties and where to put the resulting file.
Moving On

There’s a lot more you can do with clip looping, loop files, and loop libraries in Waveform, but those are the fundamentals.
Chapter 14 - Keyboard Shortcuts

In this chapter you will learn how to customize the keyboard shortcuts in Waveform. In Chapter 1 we covered how to change to the default keyboard mapping for shortcuts. Use the default mapping to match the shortcuts presented in this manual.

Keyboard Shortcuts Page

The Keyboard Shortcuts page on the Settings tab shows all of the key-mappings. You can easily change those to your liking or match them to a DAW you are already comfortable with.

Setting a Keyboard Shortcut

Waveform allows you to have more than one shortcut tied to a single action. This is really helpful if you want to have a way to do something on your laptop, but then take advantage of the extended keypad when you’re working on a desktop computer.
Let’s take a look at an example. To start recording you click the *Record* button in the transport or press keyboard shortcut R. When working on a computer that has a full size keyboard, you may prefer to start recording by hitting the asterisk (*) key on the keypad. To do so:

1. Click the plus icon to the far right of each action. To create or add a keyboard shortcut to an action, click the corresponding plus icon. The *New Key-mapping* dialogue box opens up.
2. Type the key or key combination that you want to trigger this action. The key or key combination will be identified in the dialogue box and it will also show you if there’s a conflict with an existing mapping. For our example, press asterisk and then click OK.

Now, both R and the keypad asterisk are assigned to the Record action. Back in the Edit test this by turning *Record* on and off using either R or asterisk.

**Note:** Keyboard mappings are global. Any changes you make will be active for all your Edits.

### Changing a Keyboard Shortcut

To change an existing shortcut, click directly on the key-mapping at the far right of the action. Choose between *Change this key-mapping* and *Remove this key-mapping*. If you choose the *Remove* option, the key-mapping disappears. If you choose the *Change* option the *New key-mapping* dialog appears and you can enter a new assignment.
Saving Keyboard Shortcuts to a File

Once you have your keyboard shortcuts set up the way you want, you can save the entire key-mapping to a file, a very good idea. If you run Waveform on a different computer, you can simply import the file, and will then have all your familiar assignments ready to go.

To save your shortcuts setup, click **Save Key-Mappings** and Waveform presents a dialogue box requesting a file name and path. You can store the key-mapping file anywhere you like. Waveform key-mapping files have the `.Tracktionkeys` extension.

Tip: You could create a ‘settings’ folder under your main Waveform folder to hold such files, naming the key-mapping files with a version number at the end. This gives you the ability to easily roll back to a previous version if you ever change your mind about a new keyboard layout.

Loading Keyboard Shortcuts from a File

If you’re working on a new installation or move to a new computer you can load your custom key-mapping file. Go to the Keyboard Shortcuts page on the Settings tab and click **Load Key-Mappings**.
Find your exported key-mapping file then click *Open*. All your key-mappings are restored.

Load Key-Mappings Button

**Printing a List of Keyboard Shortcuts**

If you want to print a list of all your current keyboard shortcuts, click *View as HTML* at the bottom of the Keyboard Shortcuts page. This loads a nicely formatted, searchable view of all the current key-mappings into your browser. From there you can search it or print it using normal web browser features.

View as HTML Button

HTML View of the Keyboard Shortcuts List

**Moving On**

At this point you should have a good handle on how to customize the keyboard shortcuts in Waveform. Since T6, Waveform offers powerful macro scripting you can use to further customize keyboard shortcuts. For more about that, see Chapter 37 - Macros.
Chapter 15 - Recording Audio

Now it’s time to learn how to record your own instrument or vocal tracks into Waveform. First, you will learn how to configure track inputs for recording. Next, you will learn how to use Waveform’s built-in metronome to provide a reference click, in order to keep your recordings in time. Then we walk through recording a take and exploring the record modes.

Configure the Input

We covered audio device setup back in Chapter 4 - Audio Device Setup. Refer back that chapter if you have any questions about setting up your audio interface.

As a reminder, before recording with Waveform you need to use the Auto-Detect feature to establish proper recording sync between playback tracks and newly recorded tracks. This essential step, calibrates the timing offset so that system latency doesn’t throw off the timing of your overdubs. Re-run Auto-Detect test anytime you change your interface hardware or buffer setting. The Auto-Detect procedure is explained in detail in Chapter 4.

⚠️ Warning: To configure Waveform for recording you must use the Auto-Detect feature along with a hardware loopback. If you don’t then your overdubbed tracks will not be in sync with existing tracks. While this is not difficult, it is essential to do this manual step anytime you change the Audio Device Setup.

The Input Object

At the far left of every track, you will find the input section. Each track has an input object that looks like a rectangular arrow pointing right.

Tip: If you don’t see the input objects, click the Show/Hide Inputs (Shift + F12) button at the top right corner of the Edit tab.
Click on an input object to see a menu of options. From the menu, select which hardware input to use for recording to this track. You can set it to *No input* or select any input from your audio interface. In this case it’s set to *Input 1*.

When you select an input, the input object shows the input name, a real-time input meter, and the record arm “R” button. Also, a full set of input properties appears in Properties.
Customizing Input Names Globally

If you are happy with the default input names that’s great, however, you can customize them with friendlier names using the Alias property.

To change your hardware input alias names globally, go the Settings tab, Audio Devices page. Select an input in the Channels list and edit the Alias name in Properties.

Customizing Input Names for an Edit

There is another way to rename inputs, but only for the current Edit. In the Edit, select an input and notice the Alias name in the Properties section. Change this to customize the input name for that particular song. As an example, you could use this to indicate the microphone used in the session.
About MIDI Inputs

Notice that on the input menu, you can choose MIDI interface inputs. There’s really no difference between an audio and a MIDI track. A track can contain Audio clips or MIDI clips. You just need to set the input appropriately and insert the correct kind of plugins.

MIDI Devices on the Inputs Menu

In essence a track behaves like an audio track if you set an audio input; it works like a MIDI track if you set a MIDI input and insert a virtual instrument plugin.

Setting Up Inputs for Multi-track Recording

It’s very convenient to assign all inputs to consecutive tracks using Assign all inputs to consecutive tracks from the inputs menu. It does exactly what the name says, allowing you to quickly set up for multi-track recording. This is great if you’re setting up to record a live performance through a digital mixer with a lot of inputs.

Number of Inputs

This feature is something uniquely Waveform. You can set up more than one input on a single track, up to four inputs assigned to a track.
Assign up to Four Inputs to One Track!

Now, if you record with more than one input armed, you will get a separate clip for each. This results in stack of audio clips.

A good use of this feature is to have several recording chains configured and ready to go, when auditioning microphones and preamps. Simply arm the input you want to try and away you go. It makes it super efficient to switch to a different mic/preamp combination by simply arming the desired input.

Enable a Track for Recording

To enable (arm) a track for recording, click the \( R \) symbol on the input object. The \( R \) illuminates to indicate that the track has been armed for recording.

Test the input signal. If you’re using a microphone or a guitar, play a note or have the singer sing something. You should see the meter moving on the input while testing. If not, check your input level on the hardware and make sure phantom power is on if necessary for the mic.

**Tip:** Once recording has started you can still click \( R \) to enable and disable recording on the fly. This allows you to do manual punch-in and punch-out style recording. Here is a video that explains **Punch In/Out on the Fly.**\(^{30}\)

\(^{30}\)https://w-edstrom.wistia.com/medias/wgjyszl1i6
Hit Record

With the input setup done, recording is a matter of clicking Record (R) on the Transport. While recording, Waveform draws the waveform on the track. To stop recording press Spacebar.

Recording always starts at the cursor position. There are several ways and options to stop recording which will be explained in a bit.

Enable Recording for All Inputs at Once

If you are doing multitrack recording with many inputs you can arm all the tracks at once from the input menu using the option Enable/Disable all devices for recording (Cmd + R / Ctrl + R). You can even use this on the fly during recording to start and stop recording without stopping the transport.

Input Meters

Click on an input to select it. Notice the large meter along the bottom edge of the Properties section. This gives you a good reference for setting up the input level.

Tip: As a rule of thumb, you want to set input level to hover around the middle of the range shown on this meter. The input level is adjusted using the gain controls on your audio interface or preamp.

If you’re doing multi-track recording and you want to see large meters for all the tracks at once, press F12. Waveform will go into “big meters” mode. This superimposes a very large meter onto each track.

Note: The big meters obscure your view of clips on the tracks, so you will want to toggle it off (F12) when not recording.
Drag the Input Object Track to Track

Here’s a unique aspect of the input objects. You can drag the input object from track to track. For example, say you recorded something on track one, and now you want to record something else using the same microphone onto track two. Simply, grab the input object and drag it from track one to track two. The set up is done instantly.

Note: Dragging the input track to track is a really useful function in Waveform. Once you start using this feature you will miss it when you record with any other DAW!

Renaming a Track

To rename a track, click directly on the track name, then edit the Name property in the Properties section. A really quick way to do this is to click Name, press Tab, and start typing. As soon as you tab off the Name property or click elsewhere in Waveform, the new track name will be set.

Recording Steps in Review

Here is a review of all the steps needed to test your recording setup:

1. Arm the track or tracks for recording by clicking ‘R’ on the track input.
2. Make sure Loop is turned off in the Master section.

Note: Waveform supports loop recording but we’ll get into that in a later chapter.

1. Make sure the cursor is rewound to the beginning by clicking Return-to-zero (Home) in the Master section.
2. Verify that *Click* (C) is turned off (for now) in the Master section.
3. Click *Record* (R) in the Master section. Play something into the input using your instrument or your voice depending on the kind of input selected.

   ![Image of Click Track](image)

   **Note:** As you record, you’ll see the meters and you’ll also see the waveform start to draw on the Audio clip.

1. Press Spacebar to stop recording.
2. To hear what you recorded, click rewind then press Spacebar to play. You should be able to hear what you just recorded.

   ![Image of Transport Controls](image)

   **Tip:** If your recorded take just isn’t really going well, you can press *Abort* or *Abort & Restart* on the transport. These options only appear during recording.

### Working with the Click

While recording, it’s usually very helpful to have an audible timing reference. Waveform has a built-in metronome that offers a steady click for just this purpose.

### Enabling the Click Track

To enable the metronome click, turn on *Click* (C) in the Master section. That turns it on but the setup is in the *Click Track* Menu. Here are explanations for the options:
Enable Click

Another way to enable or disable click is to open the Click Track menu and select Turn on click track or Turn off click track. That does the very same thing as pressing C or clicking the Click button in the Master section.

Click Volume

Adjust the volume of the click using the Click Track > Volume slider. There are also Low volume (-14dB), Medium volume (-4.4dB), and Full volume (0dB) presets available.

Note: Curiously, Full volume is not actually full. The Volume slider goes to +3 db. That’s three more than Full volume if you are keeping score.

Count-in

While recording, you can have the click start a bit before the cursor position. This gives you time to get into the groove before performing. Enable the count-in from Click Track > Pre-record count-in length. Select from none, one bar, two bar, or two beats for the count-in length.

With count-in enabled, you will hear the click during recording. If the cursor is at the beginning of the Edit, you will hear the count-in then the cursor will start moving. If the cursor is not at the start, it will actually jump back by the count-in length and play from there.
**Click During Playback**

If you want to hear the click during playback, make sure to leave *Click Track > Only click during recording* disabled.

**Emphasize Bars**

To clearly hear the downbeat of each bar, enable *Click Track > Use loud clicks to emphasize bars*. With that enabled, Waveform uses a different sound for the first beat of each bar.

**Click Sound**

To change what sounds are used for the click, select *Click Track > Change Click Settings*. This opens the *Click Track Settings* dialog box. From here, you can change the samples used to make the click sound. Just select the audio files for the normal and emphasized beats. If you leave the *File* properties blank, you will get the default sounds.

![Click Track Settings](image)

**Configuring the Click Sound**

Not too many people still do this, but it's possible to use an external MIDI sound module for your click sound. If you are inclined to do that, you can set the MIDI note numbers in the *Click Track Settings* dialog box.

**Click Output Device**

If you want to redirect your click so it's not coming through your main speakers, look at the click output device options (*Click Track > Output device for click*). Normally and by default this is set to *Default audio output*. You can pick any audio output on your system or even any MIDI output. If you select a MIDI output, it should be a sound module of some sort. When using MIDI for the click, you can set the click sound note numbers as explained in the previous section.

Using a click is an essential reference tool for studio recording, so it is great to have a synchronized click built-in and ready to go.
Listening on Headphones While Recording

Ideally, you will monitor what you’re recording through headphones, and set up the level and mix on your audio interface outside of Waveform. Most audio interfaces give you the ability to mix your live input with the playback from previous tracks. You use the mixer on the audio interface to balance the live input sound with the sound being played back by Waveform.

Simple audio interfaces have a mix knob that allows you to mix between the inputs (your mic) and playback (previously recorded tracks). For example, when recording a vocal leave the mix knob just about in the middle. Half of what you hear is the live input off your mic, the other half is what’s being played back from Waveform.

Some audio interfaces do not have a specific knob on the front panel to control the mixer level, and instead have an application that you run alongside Waveform that features a virtual mixer. These applications allow you to set up the monitor mix in your headphones separately from what’s happening in the recording software.

Live Input Monitoring

There are situations where you need to use live input monitoring through Waveform, rather than through your interface. The two main use cases for that that are when playing through virtual
instruments, or virtual guitar amps while recording. We will cover the details later in the book, but here are a few points for those curious about such things.

**Step 1. Disable Hardware Monitoring**
To try live monitoring through Waveform, first set up a track and arm it for recording. Now, play something into the input using a mic, guitar, or other instrument. At this point you shouldn’t really hear anything through Waveform to your headphones or speakers.

**Step 2. Enable Live Input Monitor**
Now make sure the input is selected and look for the *Live Input Monitoring* option in Properties. Click to enable it. You should hear the input going through Waveform and back out to your speakers (or headphones).

The downside is latency. You might possibly notice a delay between when you play a note and when you hear it. It’s a time lag between you sing and when you hear it in your headphones. At high buffer settings it will sound like an annoying delay slap or echo. At lower buffer settings it might sound like a hollowness if you are singing with headphones on. When playing an instrument, you might not hear any problem at all.

To really hear the effect of latency, try turning the buffer size up to 1024 or even more. Then as you play you’ll hear a noticeable delay between when you sing, speak or play a note and when you hear it.

**Note:** Latency delay is more of a problem for singers than it is for somebody playing guitar or another instrument. The sound of your voice is coupled through your skull right into your ear with zero latency. When combined with your voice slightly delayed by the latency, the result might sound hollow or “phasey” in your headphones. This won’t be recorded, but might throw you off during recording.

Why then would you ever use live input monitoring? You need it for guitar amp simulators and for virtual instruments. For normal vocal and instrument recording, it is preferable to use your audio interface to provide zero latency monitoring.

**If at First You Don’t Succeed**

With a track armed, hit *Record* (R) and record away. Press *Record* a second time (or Spacebar) to stop recording. If you don’t like what you’ve recorded select the Audio clip and press Delete or Backspace. Rewind and try again! You can alternatively press *Undo* (Cmd + Z / Ctrl + Z) to undo the last recording take.
Abort Record and Delete the Take

If you are impatient to delete a failed recording take, then you will love this feature: Abort recording and delete the take. With a single keystroke you cancel the take, throw it out, rewind to the beginning, and get set to try again. The Abort button on the transport does the same thing.

Abort Buttons on the Transport During Recording

There is a variation on this feature: Abort recording, delete take, and restart. That does the same thing, but then drops right back into recording. This action appears on the transport during recording.

Recording a Stereo Signal

If you are recording a pair of microphones or a stereo source like a keyboard, you can treat two adjacent inputs as a stereo pair. This is done in the Settings tab, Audio Devices page. Click on an input then enable Treat as Stereo Pair in Properties.

Now instead of two inputs, you have one stereo input. This will appear over in the Edit when you select inputs for a track. The pairs are always created with the odd numbered input on the left and the even numbered input on the right.

When you record from a stereo input, you’ll wind up with a stereo clip showing both the left and the right waveforms.
Retrospective Record

You know how there are times where you wish you were recording because a practice take was so amazing? Or maybe a singer sings a pickup just before the downbeat. Waveform’s “Retrospective Record” feature actually keeps a recording buffer running for any track that has an input set up.

To enable this feature, from the Menu choose Option > Retrospective record and select the buffer size. We find that the 30-second buffer is usually enough to safe-guard against chopped off picks or endings. For live shows or recording speeches, set it to 10 minutes.

To recover lost audio, simply click the retrospective record icon in the upper right corner of the Waveform window. The buffered audio will be added as Audio clips to the appropriate tracks. If you click the icon while the transport is still running, the audio will be synched to the timeline. If you click the icon with the transport stopped, the audio will be placed at the cursor. In that case you will need to manually align the clip to the track.

Retrospective record doesn’t consume much CPU and is a great safeguard against losing important audio or a killer take.
Safe-Record Mode

When recording shows, doing long recordings, or if you ever need to leave your computer unattended while it’s recording, consider enabling Safe-Record (Options > Safe-Record mode).

In safe-record mode, you starting recording in the normal way. However, as soon as recording starts, Waveform shows the Safe Record modal dialog box. You can’t do anything in Waveform including stop the recording without entering the four key shortcut.

Here is how to get out of safe-record mode:

OS X: Shift + Opt + Cmd + R
Windows: Shift + Alt + Ctrl + R

Those are the defaults, but you can change those to any other crazy key combination you want.

Moving On

That was a lot of information about recording audio in Waveform. In the next chapter we will continue on with overdub recording.
Chapter 16 - Recording Overdubs

In this chapter we walk through an example of recording a simple song. In the previous chapter, we explained how to use the Click feature to hear a metronome tempo reference while recording. In this chapter we will use a drum loop instead. Later you will learn the steps to overdub guitars and bass, in order to create a simple tune.

Tip: For overdub recording, you typically do all the recording wearing headphones with your main speakers off. This prevents bleed from one track to the next for cleaner mixing later on.

Here are the tracks we will have by the end of the chapter:

- Track 1: Drum Loop
- Track 2: Acoustic Guitar
- Track 3: Acoustic Guitar - Double
- Track 4: Bass

Set up the Drum Loop

1. First, set the desired tempo. Click on the tempo (e.g. 77 bpm) in the Master section. Then click on the BPM value in Properties and type in the tempo.

   ![Click BPM to Edit Tempo](image)

   Click BPM to Edit Tempo

1. Drag in a loop from the Browser, for example a two bar loop. This will create an Audio clip. The example shown uses Track 1 for the loop, which has been renamed to “DrumLoop.”

   ![Start With a 2-Bar Drum Loop](image)

   Start With a 2-Bar Drum Loop
Tip: If the loop doesn’t align to the bars correctly, hold Opt / Alt and drag the right trim arrow and stretch the loop until it snaps to the bar line. Make sure Snap is enabled for perfect loop.

1. Click the L icon on the Audio clip to convert it to looping mode. Now drag the right trim handle to roll out as many repetitions of the loop as you need.

Roll Out Repeats of the Drum Loop

Get Ready to Record

1. Set up the input. In this example, the drum loop is on the first track, and the second track is used for recording the acoustic guitar rhythm part. We have selected Input 1 where the mic is connected.

Configure the Input

1. We won’t use loop recording, so make sure the Loop button is turned off in the Transport section.
2. Turn off Click because we are using the drum loop track for the timing reference.
3. Let’s use a two bar count-in. To set that up, select Click Track > Prerecord count-in length > Use 2-bar count-in.

Record the Rhythm Guitar Part

1. Use your audio interface mix knob or app to balance the level of the guitar mic with the level of the drum loop track. On the guitar mic input, make sure Live Input Monitoring is turned off.
2. Next, arm the track for recording by clicking the R icon on the input. When you try this you will see the metering on the input moving if you play a chord.
3. Test the input level by playing at the loudest level you plan to use for the track. Adjust the level using the gain control on the audio interface.
4. Verify that the cursor is at the beginning of the edit. If not, press Home.
5. Press Record (R) on the Transport to start recording. Now record a take of your song. At the end hit Spacebar to stop recording.

Tip: If recording doesn’t go as planned, delete the Audio clip and try again. We went over several ways to do this in Chapter 15.

Note: If you hear some kind of weird phasing as you play your instrument, then it probably means you have Live Input Monitoring enabled while also monitoring through your audio interface. Disable Live Input Monitoring.

Doubling the Rhythm Guitar

1. Following recording the initial rhythm guitar part, rewind and play it back. Use the Volume & Pan plugins in the mixer section to balance the signal with the drum loop.
2. To double the rhythm guitar, drag the Input object to the the next track. Now track 3 is immediately ready to go for recording an overdub.

Tip: You might want to lower the original track by 3 to 6 dB using the Volume & Pan plugin to better balance the recorded track with your live mic.

1. Rewind then click Record in the Transport.
1. After recording, play back and balance the new recording with the original guitar track. To get a wide stereo effect from the doubled part, pan the tracks to opposite sides using the Pan slider from the Volume & Pan plugin.

### Overdub a Bassline

You can record the bass by connecting it directly to the audio interface; no amp, no mic.

**High Impedance Inputs.** Identify which input on your interface supports a direct 1/4” high impedance input. This is often indicated by the guitar, gtr, or hi-z. Sometimes you need to engage a switch or button for the high impedance mode. Your bass or electric guitar will sound better if you have the hi-z mode enabled.

1. Connect your bass to the interface using a normal 1/4” to 1/4” guitar cord.
Engage High Impedance Mode on Your Audio Interface

1. From this point, recording works exactly the same as with a mic. Select the correct input and adjust the input level. Make sure the bass has a good level but is not activating the clip LED on the interface using the gain knob on the audio interface.
2. Arm the input for recording if it’s not already. Adjust the levels of the existing tracks so that you can hear the tracks. At the same time, you want to hear what you are playing on the bass.
3. Rewind and hit Record. If the take doesn’t go well, stop, press Undo and try again.

Overdubbed Bass Line

Tip: If you get a good take but think you can do better, don’t delete the clip. You can drag the input to another track and try again. Just mute the original track or clip so that you don’t hear it while recording the next take. The first take might wind up being the best take!

Rename Tracks

As you record overdubs, it’s good idea to stay organized. One key is to name the tracks appropriately. Click directly on the track name in the track header then edit Name in Properties.
Renaming a Track

Tip: It can get annoying when renaming several tracks. You keep mousing between the track and the Properties section. To avoid all the extra mouse mileage, click the track name then press Tab. Tab puts the focus directly on the Name property ready for typing. Follow this link to watch a video that demonstrates using this technique to rename tracks: Tab to Rename Tracks

Adding Additional Tracks

If you get to this point and you do not have enough tracks in your project, you can easily add tracks. There are several ways to do that.

1. Press T. Select any existing track and press T. That creates a new track directly below the selected one.
2. Right-click. Right-click in any blank space or on any track and select Create new track.
3. Track Menu. Another way is to select Tracks > Create a new track. using the Tracks menu. Or, select Tracks > Create several new tracks to add up to sixteen new tracks in one go.

Create Tracks from the Tracks Menu

Tip: Like most things in Waveform, you can undo creating tracks using the Undo button (Cmd + Z / Ctrl + Z). To remove a track from your project, select it and hit Delete or Backspace.

31https://youtu.be/lcSaAU2izms
Rearranging Tracks

To rearrange the tracks, drag the track from the track name area and drop it in the new position. As you drag the track, a glowing bar will appear between tracks showing you the target for your drop. When that bar is in the right spot, let go of the drag and the track will be repositioned.

Adjust the Mix

At this point you can adjust the levels of all the recorded track or continue to record and overdub vocals, keyboards, or other instruments. As you add more tracks, you will need to reduce the level of each to avoid overloading the master level.

Tip: If you temporarily overload the master meter, you can reset the overload indicators using the backslash key (\).

Moving on

That was a walk-through of overdubbing. At this point, you should be getting familiar with basic recording in Waveform and have a handle on how to work with tracks in Waveform.
Chapter 17 - Clean-up Editing

After you have some basic tracks recorded, you can use the Waveform editing tools to clean up the clips and fix small problems with the takes. We covered Audio clip editing in Chapter 12. In this chapter we will show you a few practical examples of how to use them.

Note: Sometimes it is easier to make timing edits if you move the track you’re working on near the drum part. That way you can see the timing of your notes compared to the timing of the essential rhythmic elements of the song.

Trimming

The trim handles are a great way to clean up the beginning and ending of recording takes. Trim the beginning to keep the track silent until the part actually comes in. Then trim the end to silence any extra noise that happens after the song is done.

To use the trim handle just grab and drag. If you leave Snap on, trimming will snap to the grid. With Snap turned off, you can trim freely.

Tip: You can temporarily override snapping by holding Cmd / Ctrl while trimming.

You can also trim multiple Audio clips at the same time. Just select several clips using Opt-drag / Alt-drag and then adjust the lengths using the trim handles on any of the select clips.
Correcting Small Timing Problems

Bass Note Timing is Early

Look at this example baseline compared to the drum loop. One of the bass notes is early. Ideally, you would re-record this part. If that’s not an option you can easily correct small issues like this. The strategy is to separate the out-of-time note to its own Audio clip, then move it slightly.

1. Turn off Snap. 2. Select the Audio clip you want to fix. 3. Position the cursor just at the beginning of the note that needs fixing and press slash (/) to split the clip.

4. Position the cursor just after the note and press slash (/) again. The bad note is now separated to its own Audio clip.
5. Click to select the single note. Trim the clip to shorten it a bit.

6. Zoom in enough so you can see the alignment between the note and the drums. Grab the note and slide it to line up with the correct drum hit.

7. Complete the edit by trimming and crossfading into the other notes.
Splitting & Selecting. Right after you split a clip, you’ll notice that the two resulting clips are both selected. If you trim, slip or move a clip the action will apply to all selected clips. That might not be what you want. To select a single clip, just click one of the clips. At any time, you may hit Escape to de-select everything.

Correcting Timing by Slip Editing

Another way to correct timing is with slip editing. With this approach you “slip” the waveform within the Audio clip rather than moving the clip. The key to this approach is to put the initial split exactly where you want to the note to start.

1. Turn Snap off 2. Zoom in enough to see where the note should start and select the clip to fix. 3. Position the cursor at the exact spot you wish the note had started and press slash ( / ) to split the clip.

4. If the note was early, trim back the previous clip to get rid of the extra bit.
5. Position the cursor at the end of the note and press slash to split it again. The bad note will have a separate Audio clip.

6. Select only the note you want to adjust. Grab and drag the slip handle (solid box). The waveform will slip within the window of the Audio clip. Align the waveform so it starts just after the leading edge of the clip.

7. Clean up the edges with trimming and crossfading.
Note: If you have automatic crossfade turned on then as you move one clip to overlap another, a crossfade will be created automatically. See Chapter 12 for more about crossfades.

Fade-outs

You can also adjust the fade-outs at the end of takes simply by using the fade handle and dragging it to the left for each track appropriately.

Remember, you can adjust the shape of the fade-out by selecting one of the four preset shapes in the Properties section.

Stretch an Ending Note

If a note at the ending isn’t held out long enough, you can apply a time stretch quite easily. Re-recording the take would be preferable, but if that’s not an option, here’s how you can do a quick
time stretch to lengthen an ending note.

1. First, separate out the note that you want to stretch using split as in the other examples.
2. Hold Opt / Alt and drag the right trim handle to extend the note to the desired length.

3. Audition the playback to make sure that it sounds clean. The more you stretch it the more chance you have to degrade the audio quality, but you will be surprised at how well this really works.

**Note:** Besides just simply cleaning up the takes, you can do detailed editing on Audio clips to completely change the timing or even the arrangement. While writing songs, you can use these tools to compose bass lines that tightly lock in with the drums. You can do this by adjusting the timing, removing notes, or shortening notes; it all depends on the nature of your music production. When writing a song, you can use these tools to try many different ideas.

**Fixing Clicks at the Edit Points**

When you do this type of editing, you might occasionally hear a click at the beginning or ending of a clip. This occurs when you split across a waveform that’s actually got some energy at the split point. You can easily correct those by putting a very tiny fade at the beginning of the clip.
You could zoom way in and add tiny fades to the beginning and ending of each clip. The easier way is to select the clip and click *Apply Edge Fade* in Properties. This instantly puts 7 ms fades at the beginning and ending of all selected clips.

![Apply Edge Fade in Properties](image)

### Rendering to a Single Audio Clip

If clean-up editing leaves your track looking like a shredded mess, you can quickly render all the clips back to a single clip. To do so:

1. Select all the clips you want to combine to one clip. One way to do that is to click the first clip, hold down Shift, then click on the last one.

![Selected Clips before Rendering](image)

2. In Properties select *Render Clips > Merge the selected clips*. Merging is a single command, which is a great enhancement to the workflow.

![Render Clips > Merge the selected clips](image)
Those are the essential editing techniques you can use to clean up your recorded tracks. Use these techniques to trim clips, apply fade-outs, make minor timing adjustments, and then render all the changes to a single clip.
Chapter 18 - Warp Time

Warp Time is an audio editing option that was introduced in T6. Rather than needing to split out notes to move them, as discussed in the previous chapter, you can drag Warp points to bend and stretch audio into time. Apart from simply correcting timing problems, you can apply it creatively to compositions and loops to alter the feel of recorded audio.

The implementation is actually very simple. You can get up and running with Warp Time very quickly.

Tip: Warp time is also available as one of the Clip Layer effects, as described in Chapter 41. Clip layers allow you to use Warp time directly on Audio clips in the arrangement.

Warp Time Mode

Here is how to switch into the Warp Time mode:

1. Select an audio clip
2. In Properties, go to the Loop Properties tab
3. Enable the Warp Time option

![Enable Warp Time Mode](image)

The waveform view on the Loop Properties tab switches to the zoomable Warp Time editor.
The Warp Time Editor

Warp Time Editor on the Loop Properties Tab

The Warp Time Editor is working on the underlying audio in the clip so there might be much more audio shown than you see on the Audio clip. This will usually be the case if you have trimmed the Audio clip beforehand.

Tip: If you want the Warp Time editor view to exactly match the waveform on the selected Audio clip, render the clip using Render Clip > Flatten the selected clip. This will create a new underlying file. After that, what you see and hear in the Warp Time editor will match what you see and hear in the Audio clip.

Zooming In & Out

To zoom the waveform, use the mouse scroll wheel. On many laptops you can use a two finger up/down gesture in place of a scroll wheel. On Mac laptops you can also use a two finger left or right trackpad gesture to slide the waveform left and right.

Warp Points

Click on the timeline to add a Warp point. When you drag a Warp point left or right, time is stretched or compressed between that point and surrounding Warp points.

Tip: You can add a Warp point and drag in a single action. Just click on the timeline, hold and start dragging. The waveform will stretch until you stop dragging.
Removing Warp Points
Shift-click any existing Warp point to remove it. Right-click any existing Warp point for options to rename it or remove all Warp points.

![Warp Point Right Click Menu]

Working with Warp Points
By default, the Warp Time editor will always have starting and ending Warp points. If you add a Warp point and move it, the audio will be stretched between the beginning and ending of the wave.

![Before Warping]

![Dragging a Warp Point to the Left]
To correct audio timing over a constrained area, you can think about a three point technique. You typically want to add Warp points just before the beginning of notes or percussive hits. That would be just before a transient. If you do that then stretching occurs over the note not in the middle of it.

With the three point technique, you insert Warp points before and after the note you want to alter to lock down the timing. Then add a Warp point right at the transient you want to change and drag it into to time.

**Warp Points and Snapping**

As you drag Warp points, you will notice they snap to the grid. The snap grid for Warp points is based on the zoom level of the Warp Time editor, not the zoom level of the Edit.

To override snapping when adjusting Warp points, hold down Cmd / Ctrl as you drag the points.

**Limitations of Warp Time editing**

Warp Time editing works best for single track parts. If you use it on multitrack drum parts, you will find it seriously affects the phase alignment of multi-miked drum kits. This is the same for other instruments that are recorded with multiple mics.

You can use Warp Time on stereo tracks. If you have two mono tracks, first render them to a stereo track before using Warp Time.

**Time Stretch Algorithm**

By default Warp Time uses Elastique Pro but you can switch it use any of the other modes as well. There is little benefit in selecting other modes, since Waveform does the actual stretching offline.
Most of the time, Elastique Pro will give you the best results. If you have specialized needs, you can experiment with the other Elastique options under the spanner icon.

Note: If the Stretch property is set to “Melodyne” or “No Time-Stretching,” Waveform still uses the Elastique Pro algorithm for Warp Time.

Moving On

Here is a video demo of Warp Time that you might find interesting:

Warp Time Video Demo

Warp Time, the standard editing tools, and Melodyne give you amazing potential to manipulate the timing of your Audio clips.

32https://w-edstrom.wistia.com/medias/8klw4ees4u
Chapter 19 - Loop Recording

Loop recording is a really cool way to quickly record multiple takes of a part onto a single track. Following loop recording, you can easily pick the best take and make it active, so that it is the one you hear during playback.

Loop recording also sets you up to use the track comping tools that are built into Waveform. Comping allows you to go phrase by phrase through the different takes and choose the best phrases and create a composite best take. We cover comping in detail in Chapter 20.

Getting into Loop Recording Mode

Getting into loop recording in Waveform is simple - enable Loop (L) in the Transport. Now when you click Record, recording will only occur between the In-marker and Out-marker. The transport will “loop” between the In-marker and Out-marker allowing you to automatically record take after take, until you hit Stop.

Loop Recording Step-by-Step

1. Set the In-marker and the Out-marker over the range that you would like to do the loop recording. To set the In-marker, position the cursor and press I. To set the Out-marker, position the cursor at the end of the loop and press O.

Note: The Click count-in works for loop recording. If you want a running start for each take, set Click Track > Pre-record count-in length to one or two bars.
1. Configure the input and check your levels just like we did for standard recording.

![Configure the Input for Recording](image)

1. Click *Record* (R) on the transport to start recording.

While recording when the cursor hits the Out-marker, Waveform will automatically loop back for the next take. When you have enough takes, press Spacebar or R to stop recording.

**Selecting the Best Take**

After loop recording, you will have a number of takes stacked within the Audio clip. The very last take you recorded is what you will hear during playback. This is called the “active take.” To select a different take for the active take, click the plus (+) sign in the lower right corner of the clip. You will see a list of all takes there. Pick the one you want to promote to the active take. You can audition all the takes and make your favorite one the active take.

![Choosing the Active Take](image)

*Tip:* With your takes recorded this way, it is perfectly set up for comping, which we will cover in the next chapter.
Unpacking Takes to Tracks

If you want to work with your loop recorded takes as separate audio tracks, it is easy to unpack the takes to tracks. To do so, click the plus (+) sign and then select *Unpack to new tracks*.

That instantly converts an Audio clip full of takes to a series of tracks containing separate Audio clips. Now you can use normal audio editing to move them around, chop them up, or arrange them into a song.

Moving on

The secret to loop recording is to set the In-marker and Out-marker over the section you want to record, make sure *Loop* is turned on, and then record like you normally would. Loop recording also sets you up for comping, which is covered in the next chapter.
Chapter 20 - Comping

In this chapter, we're going to go over the cool comping features in Waveform. Comping is an editing technique where you select the best phrases from numerous takes to build a composite or “comp.” The idea is to create the best possible take. Engineers have been doing this for years, but Waveform makes it much easier than the traditional methods.

Comping typically starts with takes recorded in Loop mode, covered in Chapter 19 - Loop Recording. Loop recording is not a prerequisite for doing comping. Waveform also allows you to build composites from any collection of tracks, using the Comp Groups feature. More on that later in the chapter.

Copy Your Edit

Before you start comping, it is a good to create a copy of the Edit. This is so you can return to the raw takes, in the event you later wish to do the composite a different way.

Note: We are assuming that you have already recorded using the technique in the previous chapter. If not, go back to Chapter 19 and get some takes recorded!

1. When you finish loop recording, make sure to save the Edit with Save > Save edit (Cmd + S / ctrl + S).
2. Go to the Projects tab and select the correct Edit. In the Controls panel, click Create a Copy.
3. It is recommended to keep your Edits organized by adding a revision number. Do so by clicking on each Edit, then editing the Name property.
4. On the original Edit, add a comment that says, “This version is before comping” or similar.
5. Close the tab for the original Edit and open the new copied version.

Strategically creating copies of your Edits and naming them in a logical way, works like a revision control system. You can always roll back if something goes wrong, or if you just change your mind.
**Comping Takes**

Now that everything is setup, it’s time to get to the creative part of the process.

1. Select the Audio clip that contains the takes you want to comp.

   ![Show the Takes Following Loop Recording](image1)

2. Click on the plus (+) icon in the lower right corner of the clip and select *Show takes*. That expands the clip to show all of the individual takes. If you play back over this section of the Edit, you will hear the very last take you did during loop recording.

   ![Takes in the Expanded View](image2)
3. To build a composite take, click and drag a range over a phrase from any take. That phrase is instantly promoted to the active take. This drag-to-select action is called “swiping.”

![Swipe a Phrase to Add it to the Active Take](image)

**Tip:** While comping, sometimes it’s helpful to have the cursor return where you started playback whenever you stop playback. Do so by enabling Options > Return cursor to start position when play stops. This makes it easier to audition phrase by phrase without needing to constantly reposition the cursor.

4. Continue swiping and auditioning to build up the composite. If you want to switch a selected phrase to a different take, just click another take. The selection instantly moves to that take.

![Building the Composite Take](image)

5. If the swipe selection doesn’t fully enclose a phrase, adjust either edge of the selection by simply dragging the edge to trim it.
Trim the Edges of a Selection

Note: While comping sometimes you’ll use a little bit from every take. Other times you’ll predominantly use one take and just fix a couple of bad phrases.

Once you have finished, click the plus (+) icon and select Hide takes. At that point, you’re finished comping!

Tip: After comping, it is a great time to create another copy of the Edit and add a note that this was saved after comping. This gives you the option to roll back if you ever want to make some changes.

Flatten Comp

If you feel compelled to remove the underlying takes from the Edit, click the plus (+) icon on the clip and select Flatten current comp. This gives you the option to delete the source files. Keep in mind
that this operation is permanent.

Tip: Don’t flatten the comp without first saving a copy of the Edit. Also, we do not recommend selecting the option to delete the source files as this will remove them for your other saved Edits.

Setting up a Comp Group

To introduced Comp Groups, a feature that allows you to use swipe comping with any group of tracks. This works similarly to the techniques described above for comping takes. The difference is that you first add the tracks involved to a Comp Group.

Select Tracks to Comp
Select all the tracks you want use to build the composite. These are typically recorded as various takes of a lead vocal or solo instrument. However you can use any collection of tracks you want.
Create a Comp Group

In Properties, open the Comp Group menu and select Add group. This opens the Comp Group Name dialog box. The name will default to Comp Group 1 which is fine. You can change it to something more descriptive if you want. Click OK.

Add a Track to a Comp Group

Any tracks pre-selected at the time you created Comp Group 1 are automatically added as you create the Comp Group. To add another track to Comp Group 1, select the track, open the Comp Group menu and select Comp Group 1.

Removing a Track from a Comp Group

To take a track out of a comp group, first, select the track. In the Comp Group menu, select None.
**Comping Tracks Using a Comp Group**

With some tracks added to a Comp Group, it is easy to start comping.

1. Select one of the tracks then in the *Comp Group* menu select *Show Editor > Edit track comps*. This puts the tracks in to comp mode.

![Enable Comp Mode](image1.png)

1. Now you can start swiping to select phrases from any of the tracks. On playback only the selected phrases are played back.

![Swiping Phrases to Create a Composite](image2.png)

1. You can adjust the window of your selection by dragging either edge of range. This works very similarly to comping takes which we covered earlier in the chapter.

![Tip](image3.png)

**Tip:** If you want to have good control over the silent parts of a comp, it helps to add a blank track to the Comp Group. For the parts you want to silence, simply swipe over that range on the blank track.
**Comp Group Editor**

Here are few more things to know about the Comp Group Editor.

**Show Track Comps**

When you enable comp group editing using *Show Editor > Edit track comps*, another option, *Show track comps* is also turned on. This enables the color coding of the swipe selections on the tracks. You can turn this on separately if you want. This way you can see the comp selections but leave *Edit comp groups* turned off so you don’t accidentally change them.

**Render Comp**

When you have the composite complete, you can render the result to single track. The *Comp Group* menu gives you two options for this. *Render and replace comp group* replaces the all the comp group tracks with the resulting track. *Render comp group to a new track* leaves the existing tracks in place and adds a new track with the composite.
Rendering a Comp to a New Track

Add, Rename, Remove

These options on the Comp Group menu give you all the features need to manage your comp groups.

Comp Group Management Features

One interesting thing about comp groups is that you can have as many of them active in the Edit as you want. There are many uses beside typical comping, for example you could comp silence with tom tracks instead of gating. Comping is also a fast way to mash up two beats or two different songs.

Moving On

The comping features in Waveform are very easy to use. As you are learning Waveform, make sure to explore these powerful features.
Chapter 21 - Using an Amp Simulator Plugin

In this chapter, you will learn how to use an amp simulator plugin while recording direct with an electric guitar in Waveform. Out of the box, Waveform doesn’t include an amp simulator plugin. However, most of the third party amp simulator plugins will work. If you don’t have any of these, there is a great sounding free amp sim plugin from Voxengo called Boogex, used as an example for this chapter. You can download it from Voxengo.com.33

Free Boogex Amp Simulator from Voxengo

Setting Up the Track

Here is the setup:

1. Connect your guitar to the high impedance input on your audio interface as described in Chapter 16. If your interface doesn’t have a guitar input then use a suitable preamp.

33http://www.voxengo.com/product/boogex/
Connect Your Guitar to your Interface

2. Create a new track, select the input, and arm it for recording.
3. Make sure that direct monitoring of your signal though the audio interface is turned all the way down or disabled. To make this work you need to monitor 100% of your guitar signal through Waveform.
3. Select the input and turn on *Live Input Monitoring*. At this point you should be able to hear your dry unprocessed guitar signal.
4. Open the Browser and go to the Search tab, and type in a few characters of the name of your amp simulator plugin. Drag the plugin to the mixer section.

5. If the UI window for the plugin didn’t open, double click it. If you have Live Input Monitoring enabled you should hear sound through the plugin when you play. Select a preset and it should sound like you are playing through a guitar amp, maybe even amps, effects, cabinets, whatever your plugin simulates.

Tip: To bypass the plugin just click on the plugin to select it and press F. You can also enable or disable it using the Enabled control in Properties. The shortcut F will enable or disable any selected plugins.

Recording with the Amp Sim

At this point, recording works the same as before.
1. Record-enable the track, make sure the cursor is at the beginning.
2. Click Record in the Transport. If you want to do loop recording then have Loop on and then you can record several takes in a quick succession.
3. Once you have actually recorded the part, you can still tweak the sound.

A big advantage of recording this way is the ability to tweak the sound after the fact. You can also record using an endless variety of guitar rigs that you don’t own. Plus, you can do this without disturbing the neighbors!

An important but subtle advantage is when you go to edit your guitar tracks. Edits that occur before the amp and distortion sounds more natural and are way less apparent than when you edit a fully processed guitar part.

**Guitar & Impedance**

Guitars connect to your audio interface through a quarter-inch, unbalanced connection. This is a high impedance connection. It might not be super important to understand what that means electrically. You will get a better tone and feel if connect to a proper high impedance input. It’s just the nature of guitar pickups. Going into a standard input loads them down and you lose articulation and punch. On most audio interfaces, the first one or two channels of the interface have guitar inputs. Many times there is a switch or button to enable high impedance on those channels, meaning that it will accept high impedance pickup like a guitar or bass. So while your guitar might actually work through a normal low impedance input, it is going to give you better picking dynamics and tone if you go through the high impedance input and have the high impedance mode engaged.

**Managing Latency**

When working with guitar amp simulators, latency can be a factor. If you have the Audio buffer size set too high, you get a big delay between when you play and when you hear a note. If you set it too low the you might get pops and clicks if the computer doesn’t have adequate CPU power to handle the low latency you have chosen. The challenge is to find a good setting that feels responsive, but still has perfect sound quality.

Latency is determined by Audio Buffer Size parameter. Here is how to set that:
1. Navigate to the Settings tab, Audio Devices page.
2. Locate the Audio buffer size setting. The value shows a number of samples followed by a calculated latency delay.

![Settings Tab, Audio Devices Page - Audio Buffer Size](image)

3. Enter an Audio Buffer Size value. Values around 256 or lower tend to work pretty well depending on what else is going on in the Edit.

## Speed of Sound Through Air

Here is some background on the impact of the buffer size. In this example, a buffer setting of 256 samples offers 5.8 ms of latency.

What this means is that when you play a note on your guitar, you are going to hear the sound about 5.8 ms later. Now the speed sound through air is about 1 ms per foot (1ms per .3 meters). A 5 ms delay would be similar to playing your guitar amp if it were 5.8 feet (1.8 meters) away from your ears. You would need to add in the actual distance from your monitor speakers as well. If your speakers are two or three feet away, it might be like having your amplifier nine feet away. Most guitar players can deal with latency delay in that range. It’s similar to the distance you would be standing from your guitar amp on stage. If it starts getting much longer than that, then you are going to hear a noticeable lag and that will affect the feel and potentially impact your playing.

Here is another example. If you have your Audio buffer size set to 1024 samples, that gives you 23 ms of delay, That is going to give you the feeling of playing with your amplifier 23 feet (7 meters) from your ears. That is going to be really hard to work with.

Why not just set the buffer size as low as it will possibly go? That could affect the performance of the computer. If you set the buffer size too low, especially if you have a lot of other plugins and other virtual instruments going, the playback might halt or it might not sound clean.

**Note:** It’s always a balancing act between setting the buffer size as low as possible to get the latency down while keeping it high enough to have clean, solid playback. When mixing, you can increase latency to approximately 1024, mostly because that is required for Melodyne ARA.
Dialing in the Guitar Tone

You can dial in your ideal guitar tone using the controls on the amp simulator. Flip through the presets or start with a preset and tweak the controls until you get what you like. Keep in mind, one of the powerful things about recording guitar this way is you don’t really have to commit to the sound at this point. Just dial in something that’s inspiring so that you can get a good performance. You can always come back and tweak the amp settings later.

Using a Tuner Plugin

If you are recording direct with a guitar or bass, you might want to add a tuner plugin before the amp sim. Waveform does not include a native tuner, but if you have a tuner plugin, you can just drop it into the effects section of the mixer for the track. That will give you a quick and easy way to tune up.

Tip: If you don’t have a tuner plugin, consider downloading one as part the MFreeEffectsBundle from Melda Production34.

34http://www.meldaproduction.com/plugins/product.php?id=MFreeEffectsBundle

Assuming you have a tuner plugin available, here is how to get it going:
1. Open the Browser, go to the Search tab. Make sure Plugins is selected from the search options drop down menu. Type in a few characters of the name of your tuner plugin. The plugin will show up in the search list.

2. Drag the tuner and drop it in the plugins area of the track. Normally, as soon as you drop it, the user interface window will pop open. If not double click the plugin to open the UI.

3. Play a note on your guitar. If the tuner does not respond make sure to arm the track for recording and enable Live Input Monitoring. This is necessary for the signal to flow through the track to the mixer section and to the tuner plugin.

Tip: To keep the plugin open, click the pin icon in the upper right corner.

When you are finished with tuning, click the red X in the upper left corner of the tuner to hide its user interface.

Moving On

You can always record in the traditional way by miking your guitar amplifier. It’s also interesting to split your guitar signal and record the direct signal along with your miked guitar amp. That way you can blend the sound of the amp sim with the real amp when mixing.
Chapter 22 - MIDI Setup

We’re going to move on to MIDI recording and editing in this and the next few chapters. The first step is to set up a MIDI keyboard so that you can play notes into Waveform. If you don’t have a MIDI keyboard, you can enter notes manually into the MIDI editor, or you can use the computer keyboard as a virtual MIDI device.

The setup is quite simple. We are using a USB external keyboard controller, but the setup works much the same for other types of controllers.

MIDI Drivers

Before you dive in here, you might need drivers for your controller. Check the manufacturer’s website for drivers for the controller model and your operating system. With Waveform closed, download and install the drivers. Once you’ve done that, the rest is easy.

Set Up the MIDI Inputs

Go to the Settings tab, MIDI devices page. You will see a list of all available MIDI inputs and outputs that are connected to your system. In this example I have four of them. To enable the MIDI inputs and outputs, click to toggle between Enabled and Disabled next to each entry.

Click to Enable/Disable MIDI Inputs and Outputs

Tip: If you don’t see your devices listed, make sure the controller is connected and has power. If that checks out, then make sure the latest drivers are installed. At any time you can click Refresh. Refresh initiates a scan for connected MIDI devices.
Naming MIDI Inputs/Outputs

From the Settings tab, MIDI Devices page, click on a MIDI input or output in the MIDI devices list. Notice that in Properties, there is an **Alias** value. Edit that to give your MIDI input or output a friendly name. I often make this match the name of the controller that is connected.

**Tip:** You can customize **Alias** for a specific Edit, by selecting the input in the Edit tab and changing it in Properties. Changing **Alias** on the Edit tab takes precedence over the **Alias** property in the Settings tab.

Disabling Unused MIDI Inputs

Your audio interface might also include MIDI in and out hardware connections. Those allow connecting legacy controllers that don’t support USB. If you don’t plan to use the hardware MIDI in and out connections, you can leave them disabled. In this example we have them disabled.

This hides unused MIDI ports from the selection list when setting up track inputs later.

Configuring the Track

Back in your Edit, choose a blank track or create a new one.

1. Click on an input and select the MIDI input that matches the controller you just configured.
1. Play some notes on your keyboard. You will see the meter registering the MIDI activity on that track.

1. With the input selected look in Properties. Turn on *Enable Input Monitoring* if it isn’t already on.

With this done, MIDI events come into the track from your keyboard and the pass through to the virtual instrument that we’re going to setup next.

**Insert a Synth Plugin**

To hear what you play, you will need to insert a virtual instrument. Use the *Browser Search* tab to locate a synth plugin. In this example we are using the Waveform FM Synth.
1. Insert your synth plugin ahead of the Volume & Pan plugin. By ‘ahead’ we mean to the left which puts it ahead in the signal path. So in this example, we have dropped FM Synth to the left of Volume & Pan.

1. Play some notes on your keyboard and at this point you should hear synth notes.

**Note:** There is no difference between a MIDI track and an audio track in Waveform. To configure a MIDI track, just set a MIDI input and insert a virtual instrument plugin as a sound generating source. Then, as you record your performance, you’ll create a MIDI clip instead of an audio clip like we did in the previous examples.

### Using a Virtual Keyboard

If you don’t have a physical MIDI keyboard, you can use your computer qwerty keyboard to play notes. Here is how to set it up:

1. Go to the Settings tab, MIDI Devices page
2. Click *Create New Virtual MIDI Input*
1. Enter a name such as ‘Qwerty Piano’ into the Virtual MIDI device dialog box

2. Back in your Edit create a track
2. Choose Qwerty Piano as the input
1. Notice the piano keyboard along the bottom of the screen. To play the keyboard first click on any key with the mouse then use keys A,S,D,F,G,H,J,K,L as white keys. Use W,E,T,Y,U,O,P as black keys. This virtual keyboard lets you play notes in the range from C₄ to E₅.

Tip: Click the ‘lock’ icon in the upper left corner Properties. This locks the Waveform keyboard to the Virtual MIDI Piano feature. Also, when attempting to record, it helps to start recording using a keyboard shortcut. If you click record, the qwerty piano loses focus until you click a key on the virtual keyboard.

Lock the Input Properties While Playing the Virtual

Note: When you are finished using the virtual keyboard, unlock Properties by clicking on the lock icon again. It will stay stuck on the virtual keyboard until you do that.

Moving On

In the next chapter, you’ll learn how to record a MIDI performance onto the track. Waveform also includes powerful MIDI chord and melody generator functions which we will explore later in this manual.
Chapter 23 - MIDI Recording

In this chapter you’ll learn how to record a MIDI performance from your controller. Your controller could be a keyboard or any other sort of instrument that you can use to generate MIDI note data. We covered how to set up a MIDI controller in the previous chapter.

In this chapter, we’ll go further and cover the details of how to record your MIDI performance. You will also learn about the various MIDI recording modes. The MIDI implementation in Waveform is fairly comprehensive while also being quite easy to use. Let’s get started.

Setting up a Track

There isn’t a special type of MIDI track in Waveform. Any track can be used for audio, MIDI, or Step Clips. To record MIDI, pick any unused track or create a new track. On the track, set up the input by selecting your MIDI controller. Play a few notes on your MIDI controller to see if you have MIDI activity.

To hear any sound, you’ll need to insert a virtual instrument. Do so by dragging the plugin object to the mixer section, or search for the synth plugin in the Search tab on the Browser. When you find it, drag it over to the mixer section of your track. We usually recommend dropping it to the left of the Volume & Pan plugin. As soon as you drop it, the user interface will open up for the instrument plugin. Choose a suitable preset for the part.

We covered all of this in the previous chapter. If when you play notes on your controller you don’t hear anything, go back to Chapter 22 and make sure the MIDI input is set up correctly.

Recording a MIDI Performance

Recording MIDI is very much like recording audio:

1. Enable the track for recording by clicking the red R on the track input
2. In the Transport, click the red *Record* button to start recording. You can also do this using the keyboard shortcut R.

3. Record your MIDI performance

4. To stop, either press R again or just hit the space bar.

   **Tip:** To record your MIDI performance with a metronome click, configure and enable *Click* using the procedure outlined in [Chapter 15](#).

### Playing Back a MIDI Performance

If everything went according to plan, you’ll have created a MIDI clip. Notice, the MIDI notes on the clip. If you zoom the track vertically, the MIDI clip will, at one point, flip to the in-line MIDI editor mode. In this mode, you can edit MIDI notes, which we cover in [Chapter 25 - MIDI Editing](#). There is also large MIDI Editor which you can open for even more detailed control and editing. More on that later in the book.

Position the cursor before the newly recorded MIDI clip, the press the spacebar again to playback. You should be able to hear the exact performance.

   **Tip:** If you don’t like what you recorded, simply select the MIDI clip and press backspace to delete it then try again!
In-line Piano Roll View

As I mentioned above, as you expand the track vertically, you’ll notice that at a certain point MIDI clips will switch to edit mode. The in-line MIDI editor is what is commonly called a piano roll view (PRV). In this view, you can clearly see the notes along with a vertical piano graphic located along the left.

![Track Expanded to the MIDI Editor](image)

**Note:** The PRV in Waveform allows you to see the timing of notes as they relate to the timeline, and the pitch of notes as they relate to a piano keyboard. The graphic length of a note represents how long that note is held in musical time.

The MIDI editor PRV includes everything you need to edit MIDI data. You can add notes, delete notes, copy notes, and duplicate them. You can also work with velocity and other controller values. We’ll get into the details later when we go deeper into MIDI editing.

### MIDI Record Modes - The Action Property

Select a MIDI input and look in Properties at the item labeled *Action*. The drop down menu for *Action* gives you a variety of record modes.

![MIDI Record Modes](image)

**Merge Mode**

By default, *Action* is set to *Merge newly recorded MIDI into any existing clips*. If you rewind and record in some more notes, you will find that they’re merged into the MIDI clip that you created
in the first pass. It doesn’t replace notes that you recorded before; it just adds new notes and and
merges them with the original MIDI clip.

If you mess up an otherwise good performance in merge mode, undo the new notes by pressing Cmd + Z / Ctrl + Z.

Tip: Merge mode can be very helpful if you’re building up a part pass by pass, particularly
when layering a drum part and adding additional drum hits in each pass.

Replace Mode

If you wanted to replace what you played previously, change Action in Properties for the input
to Replace existing clips with newly recorded MIDI clips. Now when you start to record, the new
recording will create an entirely new MIDI clip and it will gradually overwrite what you had before.
It doesn’t exactly erase the original clip. If any portion of the clip is still visible, you can trim the
edges of it and expose the original data. Of course, Undo will get you back to where you started from
if things don’t go well.

Note: You can envision replace mode as being similar to tape recording. As you record
something new onto tape, you are erasing the section you are recording over.

Overlay Mode

In overlay mode, as you record you’ll get a new MIDI clip stacked on top of the original clip. After
you have recorded this way, you’ll hear the output from both clips mixed together.
During playback, you will hear the overlapping MIDI clips merged together.

MIDI Input Quantize

To find MIDI Input Quantize, click on the input and locate the Quantize property. The drop down
menu for Quantize offers a wide variety of beat subdivisions.

Notice how this works; you are selecting a subdivision of the beat (not the bar). For example, if you
want to quantize your input to the nearest eighth note, you don’t select 1/8 beat from this list, you
select 1/2 beat, because an eighth note is half of a quarter note (when working in 4/4 time).
As you record, you’re going to hear the notes however you play them, but on playback all of your notes will be snapped to the value you set in Quantize.

Note that the results of input quantizing can sound somewhat unnatural, because this approach quantizes both the note start and the note ending. Notes get stretched out and tend to sound mechanical. In general, input quantize is more useful for drum programming than playing something like a piano part.

**Note:** Input quantizing does not happen in real time. You hear the result during playback not during recording.

There are other ways to quantize and apply groove after the fact. We’ll be getting into that in Chapter 26 - Quantizing MIDI Notes.

**Moving On**

That’s an introduction to MIDI recording. You learned the essential options to set up a MIDI input. You learned about the MIDI record modes. We also took a quick look at input quantizing. Next up, loop recording with MIDI!
Chapter 24 - MIDI Loop Recording

In this chapter you’ll learn about loop recording and MIDI. Loop recording in merge mode can be useful for layering up a drum part, or building a chord over a couple of passes through the loop. Waveform also supports MIDI loop recording to layers, which gives you the capability to build a composite MIDI performance in the same way you can do with audio.

Loop Recording in Merge Mode

In the last chapter you learned about MIDI merge mode. Here are the steps again:

1. To put your track into MIDI merge mode, click on the track input, then in Properties set Action to Merge newly recorded MIDI into any existing clip.

   ![MIDI Merge Mode](image)

1. To prepare for loop recording, set the In-marker and the Out-marker over the area you want to loop.

   ![Set the In-marker & Out-marker](image)

1. Toggle the Loop button to until it’s enabled.
1. As Waveform cycles through the loop, you’ll immediately hear the results of what you played in previous passes. Keep adding passes until you’re happy with the part.
2. To stop recording, either click *Record* again or hit Spacebar.

Following loop recording, you’ll have a single MIDI clip containing the part you built up over successive recording passes.

This technique is particularly useful for programming drum parts, especially if drumming is not your main skill. For example, on the first pass play in the high hat. Then, on the second pass add the kick and snare. Finally, strategically add a crash on the downbeat.

**Recording to Prepare for MIDI Comping**

Comping is usually associated with audio recording and editing. With comping, you record multiple takes of a part then use simple editing tools to select the best phases from the various takes.

To prepare to comp with a MIDI recording, leave everything set up the same way as for merge mode, but change the *Action* parameter to *Overlay new clips containing newly recorded MIDI*.

Set the In-marker and Out-marker and turn *Loop* on. Hit *Record* and record a performance during each cycle through the loop.

When you hit *Stop* you’ll have separate takes in the MIDI clip for each loop pass, just like in audio loop recording.
Comping MIDI Takes

To see the takes, click the plus icon in the lower right corner of the MIDI clip; You’ll see a list of all your takes. From here, you can choose the best take from the list and that will make it active.

You can also expand the view to show all the takes below the track. Click the plus icon and select, *Show takes*.

Not only does this show the takes, but it puts you in comping mode. Swipe over the phrases you want to keep and build a composite from the best parts of each take.
Flattening the Composite to a Single Clip

Once you have the composite assembled, you can convert it to a single MIDI clip. Click the plus icon and select *Flatten current comp*. You will need to press *Delete* on the *Delete Unused Takes* dialog box to proceed.

*Note:* When you select *Flatten current comp* Waveform asks if you want to delete the unused takes. If you want to flatten the takes to a single MIDI clip, you need to accept this. Note that you can use *Undo* following this action.
Moving On

Loop recording and comping are really powerful tools for MIDI composition, just as they are when working with audio. Next up, learn how to edit MIDI clips and MIDI notes.
Chapter 25 - MIDI Editing

In this chapter you will learn MIDI editing. There are two aspects to MIDI editing. You can, of course, edit individual MIDI notes, but you can also edit the MIDI clip. Editing a MIDI clip is similar to editing an Audio clip, but with a few key differences. We will go over both approaches in this chapter.

MIDI Notes can be edited using the inline MIDI editor or the separate MIDI Editor window. Both editors have similar features and we will go over both approaches to note editing after going over how to work with MIDI clips.

Working with MIDI Clips

Many of the tools for working with clips work much like they do with Audio clips. Each MIDI clip header has several drag handles. Let’s take a look at how they work.

Trimming MIDI Clips

To trim a MIDI clip, drag one of the trim handles left or right. The trim handles are the hollow arrows at the left and right of the MIDI clip header.

![Trim Handles](image)

Trim MIDI Clips by Dragging a Trim Handle

Note: One difference between Audio clips and MIDI clips is that the MIDI clips don’t have fade handles.

Moving MIDI Clips

To move a MIDI clip forward or backward in time, drag from the header area. Don’t drag starting from any of the icons, but instead drag from the blank space in the header area.
Moving a MIDI Clip

Moving a MIDI Clip Track-to-Track

To move a MIDI clip track-to-track, grab the header area and drag it up or down. To move track-to-track without affecting the timing, hold down Shift as you drag.

Slip Editing MIDI Clips

The three solid color handles are used for slip editing: left arrow, right arrow, and the box. The essential tool for slip editing is the solid box in the center of the header. Grab the solid box and drag, in order to slip edit the notes within the frame of the window.

Reframing a MIDI Clip

The hollow box tool in the center of a MIDI clip allows you to reframe the entire window of the clip, leaving the notes in their original place. This is done by dragging the hollow box left or right.
Splitting a MIDI Clip

To split a MIDI clip, select it then position the cursor at the time you want to make the split. Press the slash key (/). This is the exact same workflow you use for splitting Audio clips.

Split MIDI Clips Using the Slash Key

You can also split using the Split Clips actions at the right side of Properties. The various actions give you more control over splitting.

Split Actions Button in Properties

Note: As you split MIDI clips, any notes that are sustained across the split area are separated into two notes.

You can even split a mixture of Audio clips and MIDI clips across multiple tracks, by selecting a combination of them at once.

Determining MIDI Clip Key

It’s often helpful to quickly determine the key of a MIDI clip. Waveform can quickly analyze the note data in a clip and give you it’s best guess at the key. It can be a helpful reference or just a double check. To this select a MIDI clip then choose Identify Key from Properties.
Identify Key Button in Properties

This returns the informational box that gives you percentage certainty for each potential key.

Key Results for MIDI Clip
MIDI Note Editors

As you increase the vertical size of a track holding MIDI clips, you’ll see that there’s a point at where it switches to the inline MIDI note editor. This gives you a comprehensive view of the notes contained within the MIDI clip. This type of view is commonly called a piano roll view (PRV).

If you double-click the on the MIDI clip header you will open the a separate MIDI Editor view docked above the Controls panel. You can do all your MIDI editing in this editor if you like. It can be undocked and made large on second screen if really want to zoom in your work.

Everything you can do with inline MIDI editing can also be done in the separate MIDI Editor view. It has some added features as well that well will cover later in the chapter.
Setting the Number of Octaves & Note Height

You can adjust how many octaves you see in the in-line MIDI editor in the Options menu. By default Options > Default MIDI editor vertical scale is set to 2 octaves, a reasonable starting point. If you want you can set this to show more or fewer octaves.

![Default MIDI Editor Vertical Scale Setting]

To fine tune the vertical size of MIDI notes, drag the arrows above and below the piano graphic.

![Drag to Adjust Vertical Size of MIDI Notes]

Use Arrows to Adjust Vertical Size
Mouse Wheel Options for MIDI Editing

You can use your mouse wheel to scroll vertically within the MIDI editor. During mixing you may prefer to disable this function, in order to prevent scrolling within the MIDI clips unintentionally.

![Mouse Wheel MIDI Scrolling Setting]

You may find it’s generally helpful to have MIDI scrolling on during MIDI editing. You’ll find this setting in the menu under Options > Mouse wheel action > Mouse wheel scrolls MIDI grid.

Basic MIDI Editing - Pitch

Next, let’s look at the tools for editing the actual MIDI notes. In general, editing works by selecting notes and then doing an action.

![Select a Note and Drag Up or Down to Change Pitch]

The most basic edit? Click a note to select it. Drag it up or down to change the pitch.
Per Note Automation

As you start to drag MIDI notes around, you will immediately see the per-note controller editing area appear above or below selected notes.

If you don’t see the per-note automation editing area, you can turn it on and off in Properties.

To begin, select any single note. The automation editing area will appear for the full length of the note. By default you will be editing Volume (controller 7). Select the pencil tool and draw in the desired automation curve by click-dragging over the editing area.

Note: You need to select the pencil tool to draw in the per-note automation.

The curve will appear as steps based on the current snap resolution. The snap resolution is set by the zoom level; To draw in a more detailed curve, zoom in more.
Selecting the Controller Type for Per Note Automation

You can select any other control by clicking the Type button on the MIDI editor toolbar. This type of editing gives you detailed control over performance details and articulations.

**Note:** Not all virtual instruments respond to this type of data.

**Nudging Notes**

Nudging notes works much like it does for Audio clips and MIDI clips. Select a note, hold down Shift, while pressing the arrow keys. Shift-up and Shift-down change the pitch. Shift-left and Shift-right change the timing.

Nudging is particularly helpful when changing the pitch, since there there’s no chance of altering the timing of the note.

**Tip:** Cmd + Z / Ctrl + Z works as undo for most editing operations.

**Note Length**

You can trim the length of a note by grabbing the left or right edge and dragging left or right.
Snipping During Note Editing

Many of these editing operations will snap to the grid as long as you have Snap enabled. To edit freely, disable Snap. The keyboard shortcut Q enables or disables snapping.

Copying and Duplicating Notes

To copy a note, hold down Cmd / Ctrl and drag the note to create a copy. Another way to do this is with the Duplicate keyboard shortcut. First select the note that you would like to copy, make sure the cursor is where you’d like the copy placed and then hit the keyboard shortcut D.

Adjusting Pitch and Velocity in Properties

Another way to adjust pitch and velocity is to select the note and then edit the values directly in Properties. Both Pitch and Velocity can easily be edited this way.
Note Start, Length, & End

You can also make very precise adjustments to the Length, Start Time, and End Time by editing the values directly in Properties for the selected note.

![Start, Length, & End Settings in Properties](image)

The Pencil Tool

The pencil tool is used to draw in notes. Simply select the pencil tool and then start painting in notes where you’d like them to appear on the piano roll.

![Draw in New Notes with the Pencil Tool](image)

The Eraser Tool

Use the eraser tool to swipe over any series of notes that you would like to erase.
The Line Tool

There’s also a line tool. We usually recommend using this for drawing in controllers, but it is also possible to use it for notes as well. Draw a line to create a stepped series of notes.

Tip: For quick access to the MIDI editing tools, right click in the MIDI editor and menu will popup to change tools or do other useful actions.
Note Colors

The color selection along the top edge of the MIDI editor allows you to select set a note color. Select a group of notes, click on a color and then it will change those notes to that color. It doesn't affect playback, but it gives you a way to visually organize a sequence. For example, when programming drums you could make snares, hi-hats, and kick drum all different colors.
Selecting Multiple Notes

Selecting multiple notes is easy. Use the arrow tool and drag a selection around any group of notes that you’d like to select together.

You can also add or remove notes from a multiple selection by holding down Shift (or Cmd / Ctrl) then clicking additional notes you’d like to toggle in and out of the selection.

To select an entire row of notes that are the same pitch, hold down Cmd / Ctrl and click on the PRV keyboard key corresponding to that row of notes; doing so selects the full row of notes.

Once you have a multiple selection, move all the notes in time or by pitch by dragging with the arrow tool. Alternatively, you can change values in Properties that will apply to all notes in the selection. Nudge also works on well on a multiple selection of notes (Shift plus the arrow keys).
Splitting Notes

Select one or more notes then press Cmd + slash / Ctrl + slash to split a note into two equal length notes.

Split notes with Cmd + slash / Ctrl + slash

If you have a selection of more than one note, you will split each note into two equal length notes.

Tip: Use the note split feature to draw in one note and quickly divide it into a series of notes by repeatedly pressing the keyboard shortcut.

Note split is also available from Properties. Select a note or notes then click Modify Notes in Properties and select Split Notes.

Quantising Notes

When you quantise a note you adjust the timing to match the rhythm of the tempo perfectly. In the Waveform MIDI editor, select group of notes and click Quantise from the MIDI toolbar. From her
you can select a variety of options. The most common option is to *Quantize note start times*.

In the image above, the selection is *Quantize note start times > To nearest 1/2 beat*. In 4/4 time that would mean quantizing to the nearest eighth note.

The same Quantise menu is also available from Properties for the selected MIDI notes.
Quantise Menu in Properties

To learn all about quantizing see Chapter 26 - Quantizing MIDI Notes.

Applying Groove

If quantizing notes seems to restrictive, you can apply groove instead. Groove gives you a flexible way to quantize in a way that doesn’t perfectly align to the bars and beats of the tempo. Groove is also way to import a swing feel to MIDI notes. The Groove menu is available from the MIDI editor toolbar and from Properties. Learn all about it in Chapter 26 - Quantizing MIDI Notes.

Legato Notes

You changed a series of notes have a more legato feel quickly. Select a series of notes then click Modify Notes > Legato Notes (shift + L) in Properties.
Legato Notes Action in Properties

This has the effect of adjusting the note lengths so that each note plays out to exactly the start of the next note.

Before Applying Legato Notes

After Applying Legato Notes

This is a great way to smooth out MIDI parts that might have sound too choppy.
Editing the Note Velocity

To quickly change the velocity of a note, select the note and then select a value from the Velocity drop down menu. This gives you a variety of preset values at popular levels.

If you choose Other, from the velocity drop down, you can type in whatever value you want from 0 to 127.
Tip: Here’s another trick way to adjust velocity. Select a note then hold Shift as you drag up and down over the note. Notice the Velocity value changing in Properties as you drag.

Step Entry Mode

When the Step button is toggled on, the MIDI clip goes into step entry mode. In this mode, any notes you play to the track will be entered at the cursor position. Then, the cursor will advance to the next step based on the Snap grid resolution. You can adjust that based on the level of zoom.

Hearing Notes While Editing

You have the option to trigger notes that are being moved so you can hear the pitch. You can enable or disable this using the speaker icon at the far right at the top of the MIDI editor tool bar.
Enable Speaker Button to Trigger Notes During Editing

The Velocity Editor

You can edit MIDI note velocity from the velocity area below the PRV. Click the Velocity button at the left of the MIDI editor toolbar to expose the velocity editor. For the selected note, grab the stalk which represents the velocity and drag it up or down. You will notice the Velocity parameter moving in Properties for that note as you drag.

You can also edit multiple velocities together by first selecting several velocities. Say we want to edit the velocity of all the C4s. Hold down Cmd / Ctrl and select all the C4s, then just grab one of them and they will all adjust together.

Editing other Controller Data

You can use a view similar to the velocity editor with any kind of controller. Click the Control button and then click Type to choose which controller to edit.
Example editing aftertouch: In the MIDI editor click *Control > Type > Channel Pressure*. Now the channel pressure data will appear in the same way velocity appears.

**Shaping Controller Data**

When you select a group of notes, notice three shaping handles above the controllers over the selection. Grab and drag either corner handle to tilt the shape of the series of controller.

Grab the center handle and drag to scale the magnitude of the controllers. This works great for velocity scaling as well as shaping any type of controller.
Randomising Velocity Data

Randomising velocity is a great way to add some variation to static sounding programmed parts. You can easily do this by selecting some notes and choosing *Modify Notes > Randomise Velocity* from Properties.

Choosing the Randomise Velocity Action

Following this, you see a dialog box where you enter the minimum and maximum velocity to use while randomly setting the values.
Setting the Minimum and Maximum Values for Randomising

The velocity for the notes will be truly randomized over that range. If you don’t like the results try again. The results will be different each time.
MIDI Editor View

As we mentioned before, you can double click any clip to open a full, dedicate MIDI Editor that by default is docked above the Controls panel. Everything we explained above can be done in either the inline MIDI editor or the separate MIDI editor view.

All the features of the MIDI toolbar are the same. The inline MIDI editor the toolbar is at the top of the clip while for the separate MIDI Editor the toolbar is along the bottom. There are however, several cool and unique things you can do with the larger, separate MIDI editor.

Show/Hide the MIDI Editor

At the top right of the Edit you will find several small buttons that show or hide various Waveform panels. One of those is the Show/Hide MIDI Editor button. It resembles a piano keyboard.
You can also show or hide the MIDI editor from Properties for a selected MIDI clip by clicking the *Show/Hide MIDI Editor* button.

**Show/Hide MIDI Editor in Properties**

**Undock the MIDI Editor**
With the MIDI editor visible, click the undock icon to launch it in a separate window.

**Dock the MIDI Editor**
With the MIDI editor undocked, click the dock icon to move it back to the Edit below the arrangement.
Click this Icon to Dock the MIDI Editor

**Hide Show Velocity Pane**

This is just like the inline MIDI editor. Click the *Velocity* button in the MIDI toolbar to open or close the Velocity pane for working with note velocity graphically.

**Hide/Show Controllers Pane**

Click the *Controllers* button on the MIDI toolbar to open or close the controllers pane. If the Velocity pane is already open, the controllers pane will appear below it. Click the small down arrow next to the *Controllers* button to choose which continuous controller to work with.

**Set a Background Audio Clip**

If you want to align MIDI notes to the rhythm of an audio clip in the Edit, click *Background Audio Clip* in the lower right of the MIDI editor. This allows you load in any Audio clip in the Edit by name. The waveform of the clip will be visible behind the note editing area. You can use this to align your MIDI notes to the audio transients visually.
Chapter 25 - MIDI Editing

This is Where You Set the Background Audio Clip in the MIDI Editor

Select the Background Audio Clip in the MIDI Editor

1  The background Audio clip is selected from clips that already exist on a track in the Edit. To choose the clip to use, click on the *Background Audio Clip* area at the lower right of the MIDI editor. There you can select from a list of available audio clips.

2  The audio clips waveform will be visible as the background for the MIDI editor but only at the place in time it occurs in the Edit.
Working with Clips Across Multiple Tracks in the MIDI Editor

The MIDI editor will work with all the clips you have selected in the arrangement. If you select clips across multiple tracks they appear in the list on the right side of the MIDI editor.
List of MIDI Clips
When you first select a group of clips, the notes will appear and be available to edit. When you add new notes using the pencil tool these notes are added to the clip you have selected in this list.

Lock Icon
When the lock icon is dim, the MIDI clip is unlocked and the notes can be edited. Click it to lock the clip. With the lock illuminate you can’t edit the notes for that clip but you can still see them for reference.

Note: If the clip is the one selected in the list, it becomes the active clip and you can edit regardless of the state of this lock.

Eye Icon
With the ‘eye’ icon illuminated the clip is visible in the MIDI editor. With the icon dim the clip is hidden and cannot be seen or edited.

Pencil Icon
The ‘pencil’ icon in the MIDI clip list is a further indicator that new notes entered will go into this clip. It is automatically set when you click to select a clip in the list.
Enter Chords

Waveform has several ways to help you enter the notes for common chord types. You do this by selecting a MIDI note then choosing the kind of chord from the *Chords* menu. The note you select is used as the root note for the chord. The additional notes are added above. The *Chords* menu is available from the MIDI editor toolbar or from Properties for the selected note.

1. Select a note then choose the chord type from the MIDI Editor toolbar:

![Choosing the Chord Type](image)

Waveform build the chord using your selected note as the root:
If you select several notes, then chords are built above each of them.

You can also choose the chord using the *Create Chord* menu from Properties for the note:
Create Triad and Create Seventh are available from the right click menu for each note.

Moving On

Those are the fundamentals of MIDI clip and note editing. We’re going to get into quantizing MIDI notes and applying groove in the next chapter.
Chapter 26 - Quantizing MIDI Notes

The idea of quantizing is to correct the timing your MIDI performances. At a basic level, quantizing snaps each note to the nearest correct note on a virtual grid defined by the bars and beats of your song. Waveform gives you tools to define that grid in musical increments like quarter note, eighth note, but it does so using divisions of a beat.

Waveform takes quantizing further with groove templates. Groove templates allow you to quantize in a way that’s not perfectly aligned to straight timing. An important use of this is to introduce musical swing to the timing. You have all the tools needed to impart the desired feel into your performance.

How to Quantize

Within a MIDI clip, select all the notes you want to quantize. If you want to quantize all of them, you can use select all (Cmd + A / Ctrl + A). The quantize actions are available by clicking Quantize in Properties.

There are four different quantize actions available, as shown above. The most common option is the first one - Quantize note start times. To complete the action, you pick which beat division to use.

The beat division selection can be a little confusing. Musical divisions in Waveform are represented as fractions of one beat. For example, if you want to quantize to eighth notes and you’re in 4/4 time,
then you select *To nearest 1/2*. One half of one beat would be an eighth note. If you want to quantize to sixteenth notes, then select *To nearest 1/4 beat* from this menu.

You'll will notice right away that quantizing perfectly tightens up the performance. It will snap the notes to the nearest increment of the division that you selected.

**Note:** If you're playing was so far off that it actually snaps it to the wrong note, then you might need to do some MIDI editing to clean that up!

**Tip:** Some styles of music are based on perfectly quantized timing while other styles aren’t. To get a more natural feel but also fix timing errors, you can always edit timing note-by-note manually with *Snap* turned off. Groove quantizing also gives you other options for “quantizing with feel”. More on that later.

### Quantizing Note Lengths

If you choose the option to quantize the note lengths you’ll see that the notes become the full length of that particular note value.
With something like a piano part, this can lead to a choppy, unnatural feel. You could try quantizing the note lengths to 1/4 beat (sixteenth note) if the playing is that inconsistent.

In most cases, it’s not really important to quantize the note lengths. It can be useful for things like quantizing the note lengths on drum parts, because it helps play out the full attack and decay of a drum hit.

**Quantizing with Groove**

Next let’s look at how to quantize with groove. This feature can be as simple a choosing a preset, or as complex as finely programming a groove template. Groove can be applied to both MIDI clips and Step clips, which we will cover in the next chapter.

First lets look at the basics:

Select the notes to quantize and click *Apply Groove* in Properties.

You will then get a large menu of groove presets. These are custom templates that allow you to apply fine adjustments to the timing.
Apply Groove Presets in Options

The most common scenario is to apply swing: Delaying the eighth notes that follow the four primary beats in a bar. To locate the groove templates for standard swing, look at those starting with Swing 1/2. Swing 1/2 as in half beat. In normal musical terms, that’s eighth note swing. To apply a nice groovy swing, try Swing 1/2 60%.
Note: In 4/4 music, eighth note timing is counted 1 & 2 & 3 & 4 &. In swing timing, the “&” beats are delayed. The swing presets in Waveform let you pick how much delay as a percentage from subtle (10%) to dramatic (90%).

After you apply swing, you’ll see it lays back all of the “and” notes to be a little late; groovy! Waveform will also adjust the note lengths appropriately as shown above.
Defining Groove Templates

To take groove to the next level, you can build grooves to your own definition using the Groove Template Editor. At the bottom of the Apply Groove menu, you'll find Edit groove templates. This is also available in the Menu section under Snapping > Edit Groove Templates.

Select this to open the groove template editor. Click on any of the presets to see how the logic works.

In the image above, we have selected the Swing 1/4 60% template we used for the examples in this chapter. A groove template consists of a pattern length, note subdivision, and the timing for each note. For each step of the pattern, you choose the amount that that note falls ‘early’ or ‘late’ relative to perfect timing.
The example in the figure shown above is the setup for a basic swing beat, with each ‘and’ eighth-note delayed. You can adjust the intensity of the swing feel by how much delay you put on the eighth notes.

**Complex Groove Templates**

Since you can create groove templates with as many steps as you want, you can dial in exactly the feel you want. For example if you want to vary the swing within the bar of music, you could create a template with eight notes with each swing element slightly different.

Alternatively, you can create a groove that pushes the timing over two bars, which will give excitement and tension like the FastSlow2 preset.
Tip: It can also be useful to create a ‘No Groove’ template to help you remove the effect of groove. This is particularly useful when applying groove templates to Step clips; more on that in the next chapter!

Managing Groove Templates

Waveform gives you all the tools you need to create new groove templates, rename them, and import and export them. Exported templates have the .trkgroove file extension. This allows you to share them with other Waveform users or installations.

While editing a groove template, you may reset it. This removes the late/early timing for the pattern, but doesn’t change the length or note division settings.
Any groove template that you don’t need, you can delete using *Delete Template*.

**Moving On**

You should now have a pretty good understanding of MIDI, MIDI recording, MIDI editing, and even quantizing with MIDI. But there is one more thing: Step clips. And that is up next!
Chapter 27 - Step Clips

On the surface, a Step clip is a simple MIDI step sequencer, allowing you to turn notes on and off. However, they go much deeper than that.

In this chapter, you’ll learn all about Step clips and how to use them to create drumbeats, synth lines, or bass lines.

Step Clips Overview

Step clips act like a special type of MIDI clip. However, the notes are represented on a grid where each column is a ‘step’ indicating a musical increment. By default, there are 16 steps in a pattern to match popular drum machines and step sequencers. That means in 4/4 timing, there are four steps per beat. You can change this to other values, but this is usually a good starting point for programming drumbeats.

Here is a breakdown of the key concepts you need to work with Step clips:

Step Clip
Step clips are similar to MIDI clips at a high level. You can add, delete, and copy them. They are always in loop mode so you can drag the right trim handle to roll out repetitions. Step clips need a synth plugin in order to make sound, just like MIDI clips.
Header
Click the Step clip header to select it. With the clip selected, you have access to a wide variety of settings and actions in Properties. Drag the Step clip by the header to move it forward or backward in time, or track-to-track.

Footer
Click the Step clip footer for access to a drop down menu and additional actions and values in Properties. These properties are related to working with patterns and sections.

Pattern
A pattern is the grid of notes that you program to do something musical. Each column is a ‘step’ and each row is a ‘channel.’ A Step clip can hold any number of patterns. Patterns and sections are easily confused, so keep in mind that they are not the same thing.

Step
A pattern is defined by how many steps it has, and what each step represents musically. By default a new pattern will have 16 steps with a step length of 1/4 beat. A step is one column of the grid that makes up a pattern.

Channel
Each row on a Step clip is a channel. A channel is assigned to a single MIDI note. Channels live at the clip level of each Step clip. Channel assignments are the same for all patterns within the clip. It is possible to assign channels within one Step clip to different virtual instruments. More on that later.

Note
A note is the cell formed at the intersection of steps and channels. You program patterns by clicking notes to toggle them on or off.

Section
By default a Step clip has a single section which is assigned to one active pattern. You can create longer Step clips by adding more sections. Each section is then assigned to a pattern.

Pattern Number
Patterns are numbered local to each Step clip. The pattern number for any section is shown on the footer.
Tip: You can think about Step clips as follows: Step clips hold a series of sections. Each section is assigned to a pattern. You can assign the same pattern to more than one section if you so desire.

Note: Patterns can exist in a Step clip that are not assigned to any section.

Inserting a Step Clip Into the Edit

There are four ways to insert Step clips onto a track:

**Insert Using the Clip Object**
Like all the other kinds of clips, you can drag the Clip object to a track and then choose *Insert new Step Clip* from the menu.

**Insert from the Track Header**
Another way is to select the track where you’d like the Step clip to go, position the cursor where you’d like it to start, then right-click on the track header and select “Insert Step Clip”.

A Step Clip with Four Sections
Insert from Track Properties
Select a track by clicking on the track name. In Properties, click “Insert New Clip > Insert New Step Clip.”

Inserting a Step Clip Preset
Since you can save Step clip setups as presets, a great way to get a starting point is to drag in a preset. You can find any existing Step clip presets in the Browser Search tab. Filter by Presets or enter a search term if you know the name.
Use a Step Clip Preset from the Browser

**Programming a Drum Beat with a Step Clip**

If you create a Step clip by dragging the Clip object to a track, the channels will be pre-assigned to General MIDI drum notes. This makes it really fast to get started programming beats.

Here are the basic steps to programming a drum beat using a Step clip:
1. Insert a drum instrument onto a track and select a preset.
2. Insert a Step clip on the track.
3. Set the In-marker and Out-marker over the Step clip and turn Loop on.
4. Start playback, and turn notes on and off by clicking on the individual note cells within the pattern.

As you toggle notes you will hear the result. You are now programming a Step clip pattern!

Video Clip: This video overview is a great way to get a better understanding of how all this works. While the video was created using Tracktion T6 the workflow is almost identical for Waveform. Step Clips Overview

Step Clip Properties

A Step clip has a header that is similar to that of MIDI clips and Audio clips. Click the header to reveal all the actions and settings in Properties. The following properties are the most important when working with Step clips:

---

35. https://w-edstrom.wistia.com/medias/pjf2cdmn5s4t
Name
Give your Step clip a descriptive Name. This will be particularly helpful when you go to save a Step clip as a preset. The Step clip name is used as the basis for presets.

Color
Use the color selection to give your Step clip a unique color.

Clear All Patterns
Clear All Patterns removes all the notes from all patterns contained within the clip. Since patterns act like layers, you might not be able to see all the patterns while you’re working on a Step clip.

Warning: Clear All Patterns clears all patterns whether you can see them or not, so really be careful when using this feature. Fortunately, you can click Undo (Cmd + Z / Ctrl + Z) if you change your mind right after zeroing out all your patterns!

Delete All Unused Patterns
With Step clips, you can string together a series of patterns by adding additional sections. Delete All Unused Patterns means that you’re going to remove all the patterns that aren’t assigned to play in any section. While you don’t need to use this feature, it’s a way to clean up unused patterns after you’re happy with what you have playing.

Add Channel
Add Channel will add another row of notes at the bottom the Step clip. You can also insert a channel from Properties for any selected channel. This inserts the new channel just above the selected one.

Render Clip
Use any of the Render Clip options to convert a Step clip to an Audio clip.
Note In the *Render* dialogue box, make sure you have *Pass Through Plugins* selected. If you don’t, then Waveform won’t produce any sound and will not be able to render the Step clip to audio.

**Standard Clip Operations**

Step clip properties also includes *Select Clip*, *Set Edit Tempo*, *Split Clips*, and *Move Clip*. These are standard operations shared by all the other kinds of clips.

**Render to MIDI Clip**

*Render to MIDI Clip* is an important feature of Step clips. This will convert any selected Step clips to a MIDI clip. This allows you to continue working on Step clips in the MIDI editor, using the piano roll view.

**Create Preset**

*Create Preset* gives you tools to create presets of a Step clips. This is an extremely useful feature that allows you to set up templates of grid patterns and channel assignments for specific drum instruments, or even create a library of popular drum patterns that you’d like to reuse in other songs. We’ll get into that more later in the chapter.

**Delete**

*Delete* allows you to delete the selected Step clip. Alternatively, just select the Step clip, press Delete, Backspace, or Cmd + X / Ctrl + X. Any of these will delete a clip.

Tip Just like any other clip, Step clips can be copied (Cmd + C / Ctrl + C), pasted (Cmd + V / Ctrl + V), and duplicated (D).

**The Step Clip Footer**

When you click on the Step clip footer, you select the section and whichever pattern is actively showing. With the footer selected, you are selecting both the section and the active pattern. You can tell which pattern is active by the small number indicated on the footer.
In Properties, the first two columns of controls are related to the pattern. The last column is related to sections. Let’s go through what these options are all about.

**Note:** The section and pattern numbers are shown in the title line of Properties when a footer is selected. For example, “Section 1 (Pattern 8).”

If you have more than one section in a Step clip, you select a specific section by clicking its footer. Right-click a footer (or click the footer if the clip’s already selected) and you’ll get a menu of actions related to that section. All of the actions also appear in Properties. They are available from the right-click menu, for your convenience.
Pattern Options

Set Active Pattern
If you have more than one pattern available in your Step clip, you can choose which one is active from the list. This is also available by right-clicking on the section footer.

Step Length
By default, step length is one-quarter beat. This means each beat is divided into four steps. If you change this to some other value, it will change it for the active pattern but not for the entire Step clip.

Number of Steps
Number of Steps is the number of steps in the pattern. By default, this is 16. With a step length of one-quarter beat and the Number of Steps set to 16, each beat in 4/4 timing is divided into four steps. This is the most common setup for a step sequencer. This also gives you one bar of music.

Common Length Setups
Common Length Setups gives you some preset combinations of Step Length and Number of Steps to create one or two bar patterns.
Step Clip Pattern Actions

**New Pattern**

*New Pattern* simply creates a new blank pattern and makes it active for the section. You’ll notice that the pattern number is automatically assigned. It will be the next available unused pattern number.

**Copy to New Pattern**

If you want to quickly make a variation on a pattern that you really like, click *Copy to New Pattern*. This copies the active pattern to a new pattern so you can program a variation.

**Clear All Notes**

*Clear All Notes* clears all steps of any notes that have been turned on. This is a simple way to erase the active pattern and start over with some new programming.

**Randomize Each Step**

The *Randomize Each Step* button randomly turns on and off notes throughout the entire pattern. This might give you some creative inspiration or just simply serve as a quick way to test creating a new pattern.

---

**Video Clip:** Step Clips Randomize Each Step[^36]

**Tip:** The Randomize function worked differently back in T5. In T5 *Randomize Notes* gave you a cacophony of overlapping sound. Starting with T6, this was refined to trigger a single note per step, which can be more musically useful. If you skipped over this feature in the past, give it a try!

**Note:** Keep in mind you can also randomize a channel of notes. We’ll get to that shortly.

[^36]: https://w-edstrom.wistia.com/medias/ztgsqpw2y5
Apply Common Groove

*Apply Common Groove* is usually used to impart a swing feel to your programmed pattern. This button applies groove to all the channels in the pattern. There is a way to apply groove individually to separate channels and we’ll cover that a bit later as well.

**Step Clip Section Actions**

*Insert Duplicate Section*

*Insert Duplicate Section* makes a copy of the selected section and inserts it pushing any existing sections to the right.

**Tip:** If you insert or duplicate a section but don’t see it, grab the right trim handle and pull it to the right to expose any hidden sections.

*Append Duplicate Section*

*Append Duplicate Section* puts a copy of the current section at the end of any existing sections.

**Note:** To be clear, *Append Duplicate Section* doesn’t simply insert a copy of the section to the right of the current section. It puts it all the way at the end of any existing sections.
Tip: Keep in mind that after you append or duplicate sections, you can quickly assign them to play whatever pattern you like. Right-click the footer and select which pattern you want it play.

![Assigning the Active Pattern to a Section](image)

**Remove Section**

To remove a section, select it then click *Remove Section* from the menu or Properties. This doesn’t remove any patterns; they’re still there and can be assigned to other sections.

**Step Clip Channel Properties**

In Step clip terminology, each row of the grid is a channel. Each channel has a note assignment, a name, and a variety of actions you can use to manipulate the notes on that channel. Channels can even be set to a destination. This allows you to route individual channels to different virtual instruments which is a really cool feature. We’ll be covering that shortly.

![Step Clip Channel Properties](image)

Here are the things you can do with Step clip channels:
Assign a Note Value
If you know the MIDI note value you’d like the channel to play, then you can set it with the Note property. Alternatively, drag the yellow arrow along the virtual keyboard at the bottom of Properties and set it to the desired note there. As you drag the arrow, you’ll hear the notes play.

Velocity
Velocity sets maximum MIDI velocity for the channel. Using the Step clip V/G editor (more on that shortly), you can set each note to a percentage of this value. The default Velocity value is 96.

MIDI Channel
MIDI Channel sets the output MIDI channel number. If you’re playing into a multi-timbral virtual instrument, this sets which instrument is being played from this Step clip channel.

Note On Every
The Note On Every parameter is followed by a series of buttons. Those buttons complete the sentence “Note on every (blank) steps.” Your selection fills in the black. For example, click 2 to mean “Note on every 2 steps.” This works as a shortcut for programming repeating sequences of notes on one row.

Groove
Earlier, we explained how you can set the groove for an entire pattern by selecting the pattern and choosing Apply Common Groove. You can set the groove for an individual channel by selecting the channel and then choosing Groove in the groove drop-down list. Also, if groove has been applied to the pattern through pattern properties, that groove setting will show up here in the channel groove property. In reality, groove is set at the channel level. When you apply it at the pattern level, it just copies the groove to all the channels.

Note: Normally, groove is used to apply swing. In real mathematical terms, that means slightly delaying off-beat eighth notes assuming a 4/4 time signature. Applying different groove per channel would be an advanced programming technique and I wouldn’t recommend it unless you really know what you’re doing. More on groove a bit later.

Video Clip: Step Clip Groove

Name
Name is the Step clip channel name. As you hover the mouse pointer over a Step clip, you’ll see the channel names appear along the left. If you want to set a unique name for a channel, then select the channel and update Name in Properties.

https://w-edstrom.wistia.com/medias/ad5zrq9oux
Step Clip Channel Actions

Insert New Channel
To insert a channel into your Step clip, select a channel and then click Insert New Channel. This will put a new channel row above whichever channel you started from. Channels are always numbered from the top down, so if you insert a channel, all of the following channels get renumbered.

Clear Channel
The Clear Channel button simply erases any notes that have been programmed into that row. This gives you a blank row to program.

Randomized Channel
Randomize channel randomly programs the on or off state for all of the notes on that row. If your Step clip has multiple sections, it will randomize the row across the active patterns on all of the sections.

Shift Notes
The left and right arrow buttons following Shift Notes does exactly that. It shifts the series of notes in each step one increment left or one increment right per click. This interesting to experiment with and can lead to unexpected and useful rhythms.

Set Destination
Set Destination opens up one of the coolest features of Step clips. It allows you to choose which, of many, virtual instruments you assign that particular channel. For example, you could have your bass drum being played by EZdrummer while your high hat is played by MDrummer. Then, you can set up a hand clap being played by the Waveform Sampler.

Note: For this feature to function, Waveform automatically wraps the virtual instruments you drag into the track in a plugin rack. For the most part, Waveform handles the details automatically when you apply Set Destination.
Deleting a Channel

Select any channel in your Step clip, click Delete Channel and that removes that channel. All the following channel numbers are then re-sequenced to keep them in numerical order.

Tip: When programming Step clips, there’s really no reason to have all eight default channels taking up space on your screen if you are not using that many at first. Use Delete Channel to simplify your Step clips. It’s easy to add another channel at any time using Insert New Channel.

Velocity Gate Editor

Take your Step clip programming to the next level using the Velocity Gate editor. When you click V/G in the upper left corner of any Step clip, the V/G view appears below the patterns. This give you a quick graphical view of the velocity per note for the selected channel.

---

38https://w-edstrom.wistia.com/medias/vncjr2ilh9
Here is how to use it:

1. Click V/G at the upper corner of the Step clip to toggle the V/G view. If you don’t see it, expand the vertical height of the track a bit until it appears.
2. Select one of the channels in your Step clip by clicking its name. The V/G editor shows the velocity of each note in a bar graph format. Click or drag within one of the velocity bars to adjust its percentage.
Note: The V/G setting is a percentage of the velocity value set in Properties for the channel. By default it starts at 100%. If you want the notes to hit harder, then increase the channel Velocity and adjust the V/G percentage to taste.

1. To adjust the velocity for a series of notes, hold down Shift and drag across the bars. This allows you to paint in velocities for an entire sequence of notes. This is really useful for channels with lots of notes like high-hats or snares.

![Adjusting a Series of Velocities with Shift Drag](image)

1. You can also gate the length of notes by dragging the right side of any velocity bar to narrow it. This give you freedom to get gated, glitchy notes if you want, or just to tighten up the hits.

![Adjusting Note Gating in the V/G Editor](image)

Video Clip: Step Clip Velocity/Gate

Looping Step Clips

MIDI Clips and Audio clips have a loop mode that allow you to roll out repetitions by dragging the right trim handle. Step clips are always in loop mode. Grab right trim handle at any time to loop it over part of your song.

39 https://w-edstrom.wistia.com/medias/mz2dg3v98s
By default, Step clips loop only the last section. We find it more useful to loop the entire Step clip. Fortunately, there is an option for that in Properties: *Repeat Whole Sequence*.

When you get to a point where you want to do more detailed ending on your Step clip sequence, convert it to a MIDI clip and use the MIDI editor, as follows: Select a Step clip and then choose *Render to MIDI Clip* in Properties. A new MIDI clip will be created right on top of the Step clip. From there, you can drag it away or delete the underlying Step clip.

Waveform includes the ability to save presets of your Step clips. This is very useful for creating a library of beats, as well as other elements for use in future productions. You may want to create presets and use them as templates, holding your preferred starting points for Step clip channel assignments and names.
Always use *Create Preset > Include patterns*

To save a preset, select the Step clip by clicking the header. Then click *Create Preset > Include patterns* in Properties. You can name and tag your preset. To find it later, use the Browser Presets tab and filter by *Step Clips*.

Preset Details Dialog Box for a Step Clip

**Tip:** We suggest you always use *Create Preset > Include patterns*. *Create Preset > Exclude Patterns* is also available, but that will always have the default 16 step blank pattern since the save function doesn’t include any patterns. If you use this option, you may be disappointed to see that presets don’t appear to save correctly. If you want a blank preset, clear all the notes, then save it using *Create Preset > Include patterns*.

**Moving On**

Step clips are an incredibly powerful and fun way to work with MIDI data and virtual instruments. They are also unique to Waveform, and are one of the key things that makes it special. Use them as a secret weapon for creating cool and expressive beats!
**Video Clips:** Check out this series of videos, which you may find helpful when learning to use Step clips:

- **Step Clips Overview**
- **Step Clips Velocity/Gate**
- **Step Clips Randomize Each Step**
- **Step Clips Groove**
- **Step Clips Route Channels to Different Synths**

40 https://w-edstrom.wistia.com/medias/pjf2cdmnms4t
41 https://w-edstrom.wistia.com/medias/mz2dg3v98s
42 https://w-edstrom.wistia.com/medias/ztgspwp2y5
43 https://w-edstrom.wistia.com/medias/mz2dg3v98s
44 https://w-edstrom.wistia.com/medias/vncjr2ihh9
Chapter 28 - Scanning Plugins

In this chapter, you’ll learn how to get Waveform to recognize your third-party plugins. This is essential to do before using third party effects and virtual instruments. The next few chapters are all about using plugins, so learning this step is essential before moving on.

Scanning Plugins

All scanning action happens on the Settings tab, Plugins page. If you have previously scanned plugins, you’ll see a list of all the plugins on your system. If not, the list will be blank.

To scan your system, click Scanning and Sorting. If you’re on a PC, you can scan for VST or VST3 plugin. If you’re on a Mac, you can scan for AudioUnits, VST, or VST3 plugins.

If you are just getting started with Waveform and the plugin list is blank, run scans for each type of plugin. You will also do this each time you install new third party plugins.

To reset your list of plugins, choose Clear List. That will reset the list, removing all the plugins. Remove any plugins who’s file no longer exist is also useful to cleanup the list, especially if you have been trying out and deleting a lot of plugin demos.
When you run a scan, Waveform increments through all plugins on your system. This might take several minutes, depending on how many plugins you have.

**Note:** If Waveform can’t load a plugin correctly, you’ll see a message indicating that the plugin was deactivated sometimes. This will often abort the scan. If you get a message like this, redo the scan for that type of plugin. Waveform also makes sure to skip plugins that are deactivated during successive scans.

**Tip:** When you have trouble loading a plugin, first make sure both Waveform and the plugin are on the latest version. Also, report any plugin issues to Tracktion Software so they can work with the manufacture to establish compatibility.

**64-Bit Versus 32-Bit Plugins**

Keep in mind that the 64-bit version of Waveform will only load 64-bit plugins. If you rely on 32-bit plugins, then you need to run the 32-bit version.

**Sorting the Plugins List**

Once your plugins are all loaded they appear in alphabetical order. You can sort the view by clicking any of the column headers.

![Sorting Plugins List by Clicking the Headers](image)

Once sorted by a column, clicking that header again toggles the sort order between ascending and descending alphabetical order.
Setting the Style of the Plugin Object

To insert an effect into an Edit, grab the plugin object in the upper right corner and drag it to the in-line Mixer section of any track or Mixer view.

Drag the Plugin Object to Insert a Plugin

As you drop it, you’ll see the selector menu. Pick the plugin you want from this menu. There are numerous ways to have the selector menu displayed, based on the the Plugin Selector and Selector Sorting options at the bottom of the Settings tab, Plugins page.

Plugin Selector

The default for this is Popup menu but you can choose a Popup tree view instead. You can optionally organize a fully custom configured menu as described here shortly. The custom popup can also be in tree or menu format. If those options aren’t already enough, you can optionally tag all your plugins and select a view based on the tags, a very flexible approach.

Selector Sorting

The Selector Sorting property allows you set the sort order of the selector menu or tree. Many of us set this to Sort by manufacturer when using the standard popup menu, however Sort by category and Sort by disk location are available options.
Building a Custom Plugin Selector

If you set Plugin Selector to Custom popup menu or Custom popup tree, you can organize the menu however you like in the Custom Plugin List. To do so, drag plugins from the main list and drop them on the Custom Plugin List pane on the right.

Note: If you don’t see the Custom Plugin List, then enable Show Custom Menu Editor below the plugin list.

To further organize your menu, create groups to hold collections of plugins like ‘Favorites’ or ‘Compressors.’ To create a group, click the ‘plus’ icon at the lower right. This adds a New Group folder to the bottom the Custom Plugin List. Right-click the group to rename it or remove it. Drag it to the desired position and then drag some plugins to the group.
Opening Plugin Windows

The Settings tab, Plugins page includes the setting *Opening Plugin Windows*. Here, you can choose whether you want to single-click or double-click to open plugin windows. You are choosing whether you single-click it or double-click plugins in the in-line Mixer or Mixer view it to see its UI window.

Note that this feature may work inconsistently. If you set it to single-click, some plugins may still require a double-click. You might want to experiment with this to see how it works with your plugins.

Locking (Pinning) Plugin Windows

You can make any plugin window stick on the screen, using the padlock icon in the upper right corner. Since the icon is a padlock we call it locking here in the manual. The same concept is referred to as ‘pinning’ on in some places.
By default, a plugin window is not locked, unless you specifically click the icon to lock it. However, you can change that behavior on the Settings tab, Plugins page. Changing the property *Pinning Plugin Windows*.

![Open Plugins Pinned, or Not](image)

Plugins can be locked or unlocked when open. Test this behavior by opening a plugin and make sure it is unlocked. Now, open another plugin and notice that the first one closes. Next repeat this with the plugin pinned. The pinned plugin stays visible as you open additional plugins.

**Setting Tags**

You can add tags to your plugins if you want, and can then use these tags in the Browser Search tab to filter for specific kinds of plugins. You can also use tags to organize the Plugin Selector menu as described above.

The Settings tab, Plugins page has a drag and drop approach to set tags. Select some plugins from the list and drag them to the *Add Tag* button at the lower right. This gives you options to choose any exiting tag or create a new one.

![Drag and Drop to Set Tags](image)

To remove tags, drag a selection of plugins from the list to the *Remove Tag* button and choose which tag to remove.

Tip: You can also set tags directly in the Browser from a right-click menu whenever you see a plugin in the search results.

**Moving On**

Once you have your plugins scanned and recognized, you are ready to use them in Waveform, and that’s what’s coming in the next chapter!
Chapter 29 - Using Plugins

In this chapter, we will show you how to apply effects plugins using the flexible In-line Mixer section. Most this applies to the newer Mixer view as well.

Note: Back in the day, Tracktion used to called effects and synth plugins ‘filters.’ Over the past several releases we moved away from this nomenclature and have adopted the industry standard term: ‘plugin.’ You might still run into the old terminology in the older tutorials or in conversation with long term Tracktioneers!

The In-line Mixer

The In-line Mixer section resides along the right side of the Edit, and completes the left-to-right signal flow of each track. You can open and close the Mixer using the open/close icon at the upper right, or also using keyboard shortcut M.

Whenever you create a new track, it will automatically have a Volume & Pan plugin and a Level Meter plugin inserted. These behave just like any other plugin. You can change the order, remove them, or even add additional instances of them on the same track.
For example, you might want a level meter before and after a compressor. Of course, you can add other plugins, both built-in and third party to the Mixer section.

Tip: Each Mixer channel is stereo. If the track contains mono clips, you will still typically want to choose stereo versions of plugins for the Mixer, as mono plugins might only effect the left side of the signal.

Adjusting the Size of the In-line Mixer Section

Try moving the mouse pointer from the arrangement slowly to the in-line Mixer section. As your pointer crosses over from the arrangement to the Mixer, notice the vertical highlight line.
Drag the highlight line to the left to expand the Mixer section. If you drag it right, then you can make the Mixer section smaller. All of the plugins on the Mixer are dynamically resized.

Tip: If you accidentally delete, change, or move a plugin, or simply change your mind, click Undo on the Menu (Ctrl + Z / Cmd + Z) to restore it.

Working with Plugins

You can fully customize the in-line Mixer channel for each track by inserting a chain of plugins. This is a compelling feature of Waveform. There is no need to switch between a horizontal track view and a vertical console view - that is, unless you want to! A full Mixer view is also available.

Here are the essentials for working with plugins in the Mixer:

Inserting Plugins

To insert additional Waveform plugins or third-party plugins, drag the Plugin Object to a track and then select the plugin that you would like from the list.

![Drag the Plugin Object to Insert a Plugin](image)

For third-party plugins, the UI window will pop up. Apart from the core built-in plugins, each has its own graphical user interface.

Right-click to Insert

Right-click on any existing plugin and select Add new plugin. This pulls up the plugin selector menu and you may pick any plugin to add. It will be added to the left of plugin you started from.

Note: If you don’t see some of your plugins, review the previous chapter that details how to scan your system for all available plugins.
Visual Plugin Selector
A right-click to the Plugin Object launches the Visual Plugin Selector. This is another great way to get to your favorite plugins quickly and visually. For all the details refer to Chapter 39 - Visual Plugin Selector.

Plugin Properties
To select a plugin, click on it. When selected, Properties shows a wide variety of settings and actions related to that plugin. Most of the built-in plugins have the entire user interface in Properties.

Duplicating Plugins
To duplicate a plugin, select it and press D. This gives you a new instance of the plugin to drag to a different position or to another track.

Deleting Plugins
To delete a plugin, simply select the plugin and hit Delete or Backspace. You may alternatively click the red Delete Plugin button in Properties.

Moving Plugins
To move a plugin from one track to another track, simply grab the plugin and drag it wherever you would like to put it, even to a different track. As you drag, a red illumination appears showing where the plugin will be after you drop it.
Copying Plugins
To copy a plugin, hold down Opt / Alt and drag it to where you want the copy. Alternatively, press D to duplicated it then drag the duplicate to the target location.

Bypassing a Plugin
To bypass a plugin, select the plugin then turn off Enabled in Properties. Or, simply select the plugin and press the keyboard shortcut F. A bypassed plugin appears crossed with a red X the Mixer.

Plugins in the full Mixer view show with an LED style indicator at the left when active. When bypassed this will LED appears dimmed. Access the Enable or Disable for plugins on the Mixer view with a right click.

Tip: You can bypass several plugins at once, by first selecting them and then pressing F.

Assigning a Quick Control Parameter
You can assign a quick control parameter to any instance of a plugin. This allows you immediate access to tweak one parameter without mousing back to Properties or opening the UI for the plugin.
For example, we like to set the mix control for the delay plugin as quick control. You could also set this to the delay time.

![Quick Control](image1.png)

**Delay Mix Set as a Quick Control Parameter**

To set up a quick control parameter, right-click the plugin and choose *Select quick control parameter*. Next, choose which parameter to use.

![Right-click to Set the Quick Control Parameter](image2.png)

Waveform Delay has only two parameters, but many third-party have many more to choose from. Quick control parameters appear on plugs in the full Mixer view as a slider below the plugin insert. If you don’t see it, expand the height of the mixer.

![Quick Control in the Full Mixer View](image3.png)

**Third-Party Plugins**

Third-party plugins are inserted in the same way as built-in plugins. One difference is that the UI (user interface) does not appear in Properties. Each plugin has its own UI window.
Sonimus SonEQ, an Example 3rd Party Plugin

To open the UI for a third-party plugin, double-click the plugin in the Mixer.

**Note:** You can change to a single-click to open plugin windows the Settings Tab, Plugins page. The parameter is *Opening Plugin Windows*.

### Searching for Plugins

The Waveform Browser includes a Search tab. This allows you to search for plugins. When you find one you want to use, drag it to your Edit. Here are the steps:

1. Open the Browser and click the Search tab
2. Type in a few characters of the name of the plugin
3. From the search results, drag the plugin from the Browser to the Mixer.
The search uses an index that includes plugin names, tags, and manufacturer. We covered how to set tags in the previous chapter.

**Tip:** It often helps to disable the options for *Loops* and *Presets* when searching for a specific plugin. This gives you more targeted results.

Limiting Search Filters to Plugins

### Using Master Plugins

To apply processing to the full stereo mix, add plugins to the Master section. The drop target says *Drop Master Plugins Here*.

Typically, you might put a bus compressor, a limiter, and maybe an EQ on the master. Another great option is Waveform’s own Final Mix plugin, which combines all of those functions into one package expressly designed for use on your full mix.
Master Mix inserted in the Master Section

Tip: You can right click the Drop Master Plugins Here area then choose Add new plugin to open the plugin selector menu. You may find this a bit faster than dragging the plugin object down there!

Right-click to Add new plugin

Using the Visual Plugin Selector

To open the window into the Visual Plugin selector, right-click on the Plugin object. You will see all your plugins represented by thumbnail images along with the name.

Right-click to Open the Visual Plugin Selector

Note: If all you see are a lot of question marks, then read on; we will explain how to scan your plugins to capture thumbnails in a bit.
From here you can scroll through all your plugins. When you find one you want to use, drag it and the window will close but continue dragging. Now drop it on the track in-line Mixer or the plugins area of the Mixer view.

The Visual Plugin selector window offers just few controls to make finding the right plugin simpler.

1. After opening the Visual Plugin selector, start typing in search characters to filter the list.
2. Adjust the size of the thumbnail images using the slider at the right.
3. If you decide not to pick a plugin, click the X at the upper left or press ESC to close the window.
4. As you drag a plugin, the window will close and you’ll be dragging a transparent image of the plugin which you can drop wherever you want to use it.

**Dragging a Plugin**

**Determining Plugin Technology**

As you over the mouse pointer over a thumbnail, an icon will appear in the upper left corner. This indicates which interface technology is used by that plugin: AU, VST, or VST3. This helps you pick from plugin thumbnails that otherwise look the same.

**Audio Units Icon**

**VST Icon**
VST3 Icon

These same icons are used in the Browser Search tab to differentiate the plugin technology.

**Customizing the Thumbnail Image**

Open any plugin in Waveform and notice the camera icon in the upper right corner. Click that camera to take a snapshot of the plugin window and update the thumbnail image. If you want more interesting thumbnails, use this to capture the plugin in action with the meters moving or with an interesting EQ curve.

**Scanning to Capture Thumbnails**

When you first start using Waveform, the Visual Plugin selector thumbnails appear as blank question marks. When you open a plugin for the first time, Waveform grabs the thumbnail image. Over time, the thumbnails will begin to fill in.

If you want all of the thumbnails populated right away, you can! Locate *Scan for plugin thumbnails* on the Settings tab, Plugins page.
There are three options: You can scan all plugins, scan for new plugins (those without thumbnails), or scan from a selection in the list of installed plugins. When you first start with a new Waveform installation you probably want to use Scan for all plugins.

Opening Visual Plugin Selector with a Shortcut

There is a macro action to open the Visual Plugin selector. To use it create a new macro, right-click on the script editor on the Settings tab, Keyboard Shortcuts page. Navigate to Advanced Actions > Plugins > Show or hide the plugin selector page.

That adds the necessary code to the macro.

Assign a keyboard combination that makes sense. In this example, we have used Option + F11 / Alt + F11.
Plugin Sidechains

Plugins that support a sidechain input have a side chain assignment list in the plugin header at the upper left. Pick which track you want to route into this plugin’s sidechain.

In the above example, we selected the kick track to feed the sidechain input of a gate on the bass track. It’s a common trick to lock the bass to the kick.

Video Clip: Here is a video tutorial[^45] demonstrating how to use the plugin sidechain feature.

Moving On

Plugins give Waveform complete flexibility in processing sound and using virtual instruments. Waveform has many ways to organize, find, and apply plugins. Now you should have a pretty understanding of the range options.

[^45]: https://youtu.be/PEan2nhPCOA
Chapter 30 - Built-in Effects Plugins

The Waveform built-in effects are really quite simple. They act as plugins that you can combine to build up more complex effects chains in the mixer, or within plugin racks. We won’t touch on every single effect here, but we will go over the essential ones. Let’s get started.

Tip: Some bundles of Waveform include the excellent Tracktion DAW Essentials\(^6\) plugins. These plugins are more advanced and can be used in place of many of the standard plugins outlined in this chapter. Each of the DAW Essentials effects has a link to its manual from within the Help menu within the plugin. Make sure to check them out!

Waveform Effects

Drag the plugin object to the mixer and select Waveform Plugins. You’ll see the list of built-in effects.

\(^6\)https://www.tracktion.com/products/daw-essentials-collection
In this chapter, we will go into more detail about the plugins highlighted in the image above. The other effects provide specialized functions, or are not typical audio effects. We’ll get into some of those in later chapters.
**Volume & Pan Plugin**

Whenever you create a track, you will see a Volume & Pan plugin at the right in the mixer section. This gives you basic level and pan controls like you’d expect to find on any mixer channel. Since the Waveform mixer is made up of plugins, the Volume & Pan plugin can be moved before other plugins or deleted entirely. You can even add another Volume & Pan and use it as a trim control for gain staging.

**Adjusting Volume**

To control volume, click and drag the volume slider up and down. A large volume slider appears as you drag giving you nice readable dB markings for fine level adjustment. The numeric value for the Volume setting appears in Properties.

![Volume & Pan Plugin, Adjusting Volume](image)

**Adjusting Panning**

The pan adjustment works similarly. Click the panner graphic then drag left or right to adjust left to right stereo positioning.

![Volume & Pan Plugin, Adjusting Panning](image)
Resetting Controls

To reset either Volume or Pan to their default position, hold down Opt / Alt as you click the control.

Properties

With a Volume & Pan plugin selected its values and actions appear in Properties.

The Volume slider is repeated in Properties along with buttons for Reset and Mute. Pan is repeated in Properties along with a Centre Panning button that resets panning.

Pan Law

Properties also holds a setting for Pan Law. By default this is set to Linear but you can change it to other popular formats. For example, many DAWs use a -3 dB pan law so that as you pan to the center it lowers the volume slightly to make it easier to keep a track in balance as you adjusting panning.

Tip: To apply a velocity offset to notes going into a virtual instruments, insert a Volume & Pan plugin before it and enable Apply to MIDI velocities. Adjust the fader to offset MIDI velocity to increase or reduce the velocity. This is a quick way make your MIDI drums hit harder - much easier than going back to editing the MIDI data. This only works if you insert Volume & Pan ahead (to the left) of the virtual instrument.

Level Meter

The Level Meter plugin is also at the right end of the mixer for every track by default. Level Meter is stereo and shows what the left and right levels are doing.
When you select a *Level Meter*, Properties displays a large horizontal version of the meter, that also includes dB markings.

The meter indicates signal overload with a red indicator at the top of the meter. You can reset the meter by clicking the red overload indicator.

**Tip:** To clear all overload indicators in the Edit, right-click any level meter and choose *Reset all overload indicators* (Backslash).

By default the *Level Meter* is set to peak mode. This is typical of the metering in most DAWs. You may change the meter mode in Properties or from the right-click menu. Here is an explanation of each of the modes:

**Peak Mode**
Peak mode shows the digital peak. This is the normal mode for Waveform and most other DAWs. From a technical point of view, you want to keep this out of the red to prevent ugly digital clipping.

**RMS Mode**
To get a sense of the overall perceived volume your signal, try RMS mode; it emulates the response of legacy VU meters and gives you a better indication of how loud one track is perceived, compared to others.

**Sum & Difference Mode**
*Sum & difference* is a specialized mode that gives you a visual representation of both the level and the stereo spread. The left part of the meter shows the level of sum of left plus right. This represents the combined level of the stereo signal.
The right side of the meter shows the difference between left and right. The more difference you see the wider the stereo spread between the two channels. This gives you a visual indication of stereo spread. If both channels are playing exactly the same thing, then left minus right will cancel to zero and the right side of the meter will show no activity: a mono signal.

Tip: The level meter will also indicate MIDI activity if you enable Show MIDI activity in Properties. This can be a very useful diagnostic if you ever wonder why a virtual instrument is not triggering.

The 4-Band Equalizer

The 4-band Equalizer has a graphical interface that shows up in Properties. You’ll immediately notice that there are four bands, which correspond to four movable nodes on the frequency response plot. The high band and the low band are shelving filters, the middle two bands are peaking filters.

To adjust the gain of any of the bands, grab the node directly in the middle by the small square and drag up or down. To set the frequency of any band, drag the node left or right. To adjust the width (or Q) of the filter drag within the perimeter of the node clockwise to make the band narrower or counterclockwise to make it broader.

On the shelving bands, drag clockwise to make the slope increase or drag counterclockwise to make the slope shallower. As you adjust these values you’ll see the actual numeric values over to the right for Frequency, Gain, and Q.

Just under the frequency plot, notice the Reset button. Click Reset to return all four bands back to their default values giving you a flat frequency response plot.
Also, notice the controls for saving and loading presets. Using these you can create a library of common presets to use in your mixing projects. The 4-band Equalizer is very simple and the graphic adjustment makes it very quick to sweep through the frequencies to quickly locate your cuts and boosts.

**Reverb**

Waveform’s *Reverb* plugin doesn’t have a fancy user interface; you get just a few simple sliders. It is however a very effective, low-CPU tool to add some depth to a track, and may be all you need to get a nice variety of reverb sounds.

![Traction Reverb](image)

**Tip:** You may find it speeds up mixing to assign *Wet Mix* (Wet Level) as the quick control parameter when using *Reverb*. Mixing with a little reverb on a track gives you another dimension to mix with, in addition to level and panning. More reverb pushes the track further back, less reverb sounds closer. Combine that with left and right placement from panning for more spacious mixes.

![Reverb, Wet Level as the Quick Control Parameter](image)

**Delay**

The Waveform *Delay* is an extremely simplified mono delay effect, with delay times up to one second. You control *Length* with a slider, allowing you to enter delay times between zero and 1000 milliseconds. You can also adjust the *Feedback* amount with the *Feedback* slider, from no feedback all the way up to 0 dB (which is essentially full feedback). The *Amount* parameter
is a mix control, and allows you to set the percentage of the effected signal to pass through.

The *Delay* plugin also has a *Tempo* parameter. It is not really a host sync, but rather just helps you calculate delay times based on musical divisions of the beat at the current tempo.

Waveform Delay *Tempo* Selection

For example, if you want to get an eighth note delay, click *Tempo* and select *Set delay length to 1/2 beat* and it calculates the delay time and sets the value in *Length*. It is a one time calculation; If you change the Edit tempo, then you need to set it again.

**Chorus**

The *Chorus* plugin gives you a classic chorusing effect. It works as a type of doubling and provides a shimmery, smooth quality. It can be used on just about any source, but is common on guitars, pads, electric pianos, bass, and vocals.
To get the classic chorus effect, the plugin modulates the delay time; the delay time is gradually changing, getting longer and shorter. The amount of variation is controlled by the Depth parameter. The Speed slider controls the quickness of modulation to get results from warbling to smooth. The Width slider adjusts how far apart the dry signal and the wet signal are panned to give you a wide stereo effect or a narrow doubling. Finally, Amount controls the overall mix of the original signal with the chorus effect.

The Phaser

Phase shifter pedals became popular in the late ‘60’s and during the ‘70’s. It gives you an intense swirling impression you will instantly recognize. While a phaser is most commonly used as a guitar effect, it is also frequently used on synths or any track that needs some movement.

The Phaser Plugin

The Speed parameter controls the speed of the LFO that modulates the phase shifting effect. Depth controls the number of octaves the phase shift will sweep through. Feedback lets you adjust resonance which makes the phasing more or less intense. The Tempo parameter allows you to set the Speed of the LFO to a musically useful division of a beat based the current tempo.

Tip: As you work with effects you can easily change the order of effects on any track by grabbing the plugin and dragging it left or right. As you drag, a red drop target will glow in the spot where the effect will be inserted when you drop it.

The Compressor/Limiter

Waveform’s Compressor/Limiter is a very basic compressor, that includes most of the common parameters you expect to find in a compressor: Threshold, Ratio, Attack, Release, and make-up gain (Output).
The Compressor/Limiter Plugin

As the signal goes above the Threshold, the compressor reduces the output signal by the amount set by Ratio. So, if you set Ratio to 4:1, Attack sets how long it takes for the 4:1 ratio to fully kick in. Release is the amount of time it takes for the compressor to recover after the signal goes back below the threshold.

You can set Threshold and the Ratio by dragging the appropriate nodes on the frequency response transfer plot.

Compressor/Limiter functions as a limiter when you set the Ratio to the maximum of 20:1. When used as a limiter you also want to set a very fast attack time. In this mode it really clamps down on transients.

Note: The built-in Compressor/Limiter lacks metering, but you can insert a Level Meter before and after the compressor and look at the difference between the two meters get an idea of gain reduction.

Pitch Shifter

The Pitch Shifter plugin uses DSP processing to change the pitch of the signal in real time. For audio tracks, this uses the Elastique Pro algorithm, or whichever algorithm you select in the Type parameter.
The Waveform Pitch Shifter Plugin

*Pitch Shifter* is set in semi-tones; if you want to go up an octave, set *Pitch* to 12. If you want to go down one octave set it to -12. To reset back to the original pitch, select *Pitch* and type in zero.

Tip: You may find it’s usually a lot easier to control the *Pitch* value by typing in the digits than it is to use the slider.
Note: If you insert *Pitch Shifter* ahead of a MIDI instrument, it works on the MIDI data stream to transpose notes up or down by the value you set in the *Pitch* parameter.

**The Low/High-Pass Filter**

You may use this plugin frequently because of its simplicity. Drag the *Low/High-Pass Filter* to any track; in Properties choose if you want it to be *Low-pass* or *High-pass*.

![High/Low-Pass Filter Properties](image)

Once you’ve made that selection, drag the *Frequency* slider or type in the frequency. For example, if you want to just create a common rumble filter to apply to a vocal, Choose *High-pass* and set *Frequency* to 100 Hz.

Tip: A quick way to create a low-fi effect on any track is to insert two of these filters, one set to *High-pass* and one set to *Low-pass*. For example, set the high-pass frequency to about 300 and set the low-pass frequency to about 3,000. That will give you a nice starting point for a low-fi sound.

**Text Plugin**

The text plugin is a convenient tool to keep your Edit organized as you record, edit, and mix. Drag *Text* it to a track, give it a *Name* and then type in a *Description*. 
Text Plugin Example

You can type in as much text as you’d like describing how the recording was made, the kind of microphones used, the artist name, and really anything you’d like to make a note of. Text plugin Name appears right in the mixer on the thumbnail. While Text doesn’t do anything to your audio path it can help you remember what you were doing when you come back to a project later on.

Tip: You can enable or disable several plugins at once by simply selecting all of them and using the keyboard shortcut F.

Saving Presets

Most of the built-in plugins allow you to load, save, and delete presets. Once you have your favorite presets saved, you can search for presets on the Presets tab or the Search tab of the Browser.

Load, Save, or Delete Presets

As you create presets you can also add tags to make it quick to filter to exactly what you are looking for; Vocal EQ, Guitar Focus, Bass Boost for example.

Moving On

Now we’ve touched on the built-in effects plugins in Waveform. The built-in effects, along with the Tracktion DAW Essentials\(^\text{47}\) plugins, and third-party plugins give you tremendous creative potential when composing and mixing.

\(^\text{47}\) https://www.tracktion.com/products/daw-essentials-collection
Chapter 31 - Effects Bus Tracks

In this chapter, you’ll learn how to set up an effects Bus track in Waveform. A Bus track is configured to be shared by multiple tracks within your Edit. Sometimes this is called a master effects bus. This is an extremely common production technique that originated when recording was done using large mixing consoles. When mixing with a console, effects like reverb and delay are created using outboard hardware.

In the early days, studios only had a limited number of reverbs and chambers to use. The solution was to use a common bus for the effect and then send the desired amount of each track over to the effect bus. Sharing and effect with different tracks can add cohesion to a mix and thus the technique is still extremely popular even in the digital era. It can also help save on CPU load when using great sounding but CPU hungry effects plugins.

It works the same way in Waveform. You dedicate a track to the effect and then use a special Aux Send plugin to send part of the signal from your instrument, vocal, or drum tracks to over to the effects Bus track.

Create the Bus Track

To get started create a new track. The fastest way is select any track and hit T. That creates a new blank track right after the one that you started with. You can drag the new track anywhere you’d like.

Next, click on the track name, and rename the track by editing Name in Properties. In this example you can use a reverb effect and name it “Master Reverb.”

Adding the Effect Plugin

The next step is to insert an effect plugin on the Bus track. In this example we’re using Waveform Reverb.
Insert the Reverb Plugin

Check that the *Dry Mix* fader is turned all the way down. You want only the wet signal to go through *Reverb*. You can tweak the other parameters later, after you get some sound going through it.

Set the Mix to 100% Wet

Tip: If the plugin you’re using has a mix control, make sure it’s turned to the 100% wet position. The critical thing here is you don’t want any dry signal being mixed back in through a different, parallel path.

**Aux Return Plugin**

So this seems like a pretty ordinary track. How do you make this track behave like a bus? You do so by inserting the *Aux Return* plugin, one of the built-in plugins in Waveform. It pairs up with the *Aux Send* plugin for just this purpose.

Insert the Waveform *Aux Return* plugin to the left of *Reverb*.

Notice that it is labeled *Aux Return #1* in Properties. Also, you can see it is automatically assigned to the next available bus: in this case *Bus #1*. 


Automatic Bus Assignment for Aux Return

It’s optional but you can type in something descriptive for the Bus Name property. In this case Verb 1.

Adding a Descriptive Bus Name

The descriptive name appears right on the plugin thumbnail in the mixer, making things much clearer. This will help even more when you have several effects buses configured.

How the Bus Name Appears in the Mixer

Adding Aux Sends to the Channels

Now that your effects Bus track is set up, all you need to do is insert an Aux Send plugin on each track where you would like to apply this effect.

Insert Aux Send on a Track

This is important. Insert Aux Send after the Volume & Pan plugin. This way as you adjust the track volume, you’re also adjusting the amount sent to the Bus track proportionally. Even if you lower the volume all the way down, you won’t hear a ghosting of the effects bus from that track playing in your mix.
Note: On a conventional mixing console, this position is called “post fader.” Hardware consoles will have a special switch or maybe even a special knob that allows you to send post fader. In Waveform you do this in a very direct way: rearrange the order of the fader so that it comes before the Aux Send plugin.

Adjusting the Send Level

Now that it’s all set up, as you play back, adjust the send level by clicking on the Aux Send plugin, and adjusting the Send level slider that pops up.

![Adjust the Aux Send Level](image)

Alternatively, you can just click on the Aux Send plugin and adjust Send in the Properties section. The more you turn it up the more effect you’ll get. As you turn it down, you get less and less of the effect.

Assigning the Aux Bus

You can create as many effects Bus tracks as you need for your mix. You might want a reverb for drums, a different reverb for vocals, a delay for vocals, and other delay for guitars. The steps to set up the additional buses are the same as outlined above. You just need to make sure your Aux Sends and Aux Returns are assigned to the correct bus numbers.

![Setup with Three Bus Effects Tracks](image)

When we set up Verb 1, we used Bus #1. For DLY1 we used Bus #2 and gave it a unique name.
Assigning Buses to the Aux Returns

As you insert the Aux Send plugin onto each track, select which effect you want to use by choosing the correct bus.

Tip: Feel free to assign more than one Aux Send to the same track.

Your effects tracks aren’t limited to a single plugin. You can create an entire effects chain, for example combining compression, EQ, reverb, or delay on a single Bus track.

**Solo Isolate**

There’s a special solo mode that you will likely to want to use on Bus tracks, called Solo isolate. To do so, right-click the Solo button on one of your Bus tracks and choose the option Solo isolate.
Notice how that the Solo button changes from “S” to “SI.” With Solo isolate enabled, if you solo any track, this track will also be soloed. This is useful because when you solo a track, you usually want to hear it along with its send effects. If you don’t use Solo isolate on your Bus tracks, the effects get muted when you solo a track.

Tip: Waveform includes a track tagging feature that allows you to quickly view any tracks that share a tag. You can tag all of the effects buses with the tag "FX", which makes it really easy to pull up a view of all of your effects Bus tracks using the Tracks tab in the Browser. Take organization one step further by giving your effects Bus tracks a specific color.

**Effects Bus Track Presets**

If you commonly use a similar set of send effects, you can create some presets for your Bus tracks, and then recall them for your next project. To do so, right-click the track name and select Save preset > whole track.

In the Preset Details dialogue box, put in an appropriate name for your preset such as “Master Reverb.” In the tags area, the tag Track will automatically be entered. You can also add another tag such as Effects Bus.
Remember to separate tags with a comma. Click OK, then the next time you want to create a very similar effects Bus track, go to the Search tab in the Browser and filter by *Effects Bus*. Drag the preset onto any track to instantly configure your favorite master effects set up.

**Moving On**

In a full mix, you may have four or more effects buses configured at once, such as two reverbs and two delays: drum reverb, vocal reverb, stereo delay, and a mono slap back delay.

One key is to group the Bus tracks together and to put them at the top of the Edit. You can also make them a unique color, tag, and label them appropriately.

Bus tracks set up this way also appear on the full Mixer view as with channel faders just like they would on a mixing desk. If you move the Mixer view to a second monitor you can quickly control the levels of your effects from these faders.

Once you get a hang of the set up, using effects Bus tracks in Waveform is very straightforward.
Chapter 32 - Clip Effects

In Chapters 29 through 31 we covered using effects plugins in a variety of ways. Now, we want to show you how to apply plugins to individual Audio clips. Let’s get started.

Inserting Plugins on Clips

To insert a plugin on an Audio clip, drag the plugin from the Browser or the plugin object, and drop it onto the Audio clip. You’ll notice that the plugin thumbnail appears in the lower right corner of the clip. You can add as many plugins as you’d like to create a chain of effects, all operating on that one clip.

Plugins Using Clip Effects

Note: Clip effects work with Audio clips, but not MIDI clips or Step clips.

The rest of the operation is pretty much the same as using plugins in the mixer. Select a plugin and hit F to enable or disable it. You can also enable or disable the effect with the Enabled button in Properties.

For third-party plugins, clicking or double clicking on the plugin opens its user interface.

Tip: How plugins open, depends on a setting in the Settings tab Plugins page: Opening Plugin Windows. It can be set to either Single-click on a plugin to open its GUI window or Double-click on a plugin to open its GUI window.

Removing Clip Plugins

To remove a plugin, simply click on the plugin to select it then press Delete or Backspace. You can also select multiple plugins by holding down Cmd / Ctrl to select multiples, and then press Delete to remove them.
Creative Uses

One of the reasons to use clip effects is if you want to put an effect on just part of a track, even a single word or a single phrase. Without using clip effects, you’d need to move a piece of the clip to another track to apply a different type of an effect. This is really useful for something like an echo throw where you’re applying an echo effect to a single word, or if you want to process one phrase of a vocal line with a lo-fi effect. Just separate the phrase or word to its own clip, then apply the effect only to that short clip.

Echo Throw Example

An echo throw is taking one word, usually the last word of a phrase and then applying an echo to it. Here are the steps:

1. First, separate the final word of the phrase from the rest of the phrase. To do that position the cursor where you’d like to make the split and hit the slash (/) key.
2. Now that clip is separated into its own clip, drag in the Delay plugin.
3. Dial in the Delay parameter so it echoes out in a musically useful way, maybe using eighth notes or quarter notes. Add a little bit of Feedback so you get some echoes that die out over time.
4. Playback and tweak the Delay parameters until you get the echo throw effect that you like.

Moving On

The same technique is great for lo-fi effects as well. Apply a high pass and a low pass filter in order to cut the highs and the lows, or even apply chorusing to a few words in a vocal line. Clip effects are super easy to use in Waveform, and they unlock all kinds of creative options!
Chapter 33 – Folder Tracks

With the Folder tracks feature, you collect a group of tracks into a folder, allowing you to work with them together as a unit. The obvious advantage is to collapse the view so that related tracks, like your drum tracks, can be viewed as a single entity.

Folder Tracks also give you a convenient way to apply volume automation, so that you can do a fade across a number of tracks at the same time. Folder tracks allow you to solo every track that is contained within it with a single click. You can also do basic editing across a folder of tracks. Let’s take a closer look.

Creating a Folder Track

To create a Folder track, right-click the track name for any existing track and select *Create a new Folder track*. The Folder track appears below the original track.

![New Empty Folder Track](image)

Alternatively, right-click on the background of the Track section and choose *Create a new folder track*.

Either of these methods will create a new empty Folder track. There are easy ways to create a Folder track containing existing tracks, which we will cover that shortly.

Working with Folder Tracks

Putting Tracks into a Folder Track

To put a track into a Folder track, simply grab the track by the track name, drag it, and drop it on the folder. Just before you drop it, the Folder track will glow, usually with a red color, indicating it’s ready to receive your track.

![Folder Track after Dropping in One Track](image)
If you already have some tracks in the folder you can drag it over the folder and then downward; you’ll notice a red glowing insertion point, where you can put your track between other tracks to get the order you want.

**Naming a Folder Track**

Naming a Folder track works exactly like any other track. Click on the header part of the track where the name is, and then edit *Name* in Properties. By default, it will have a name similar to *Folder 1* or *Folder 2*.

---

**Tip:** One of the most common uses of Folder tracks is to organize all of your drum tracks into a folder. In this case, you might want to name it ‘Drums’ or ‘Drums Folder.’

**Reorder Tracks within a Folder Track**

To reorder the tracks within your Folder track, grab any track and drag it to the correct position. The red insertion line shows the target, so you know exactly where the track is going to go. When you drag a track directly onto the Folder track and drop it, that track goes to the topmost position.

---

**Collapsing and Expanding a Folder Track**

Click the small triangle to the left of the Folder track name to expand or collapse the folder. When the folder is collapsed it doesn’t affect playback. All the tracks that are contained within the folder still play and respond as normal.
Soloing/Muting a Folder Track

Folder tracks have Solo and Mute buttons, just like any other track. However, they operate on all of the tracks that are contained in the folder. So if you have a Folder track set up for your drums and you click Solo, you will solo all of your drum tracks. Likewise, Mute mutes all the tracks within the folder.

Note: When you solo a Folder track, the tracks contained in it are soloed with a blinking Solo button. This indicates that the track is being soloed by the Folder Track and not directly. If you click the blinking Solo it will change to the standard solo state with a steady indicator.

The Solo and Mute functions are really good reasons to set up Folder tracks for the different instrument types. You can set up Folder tracks for drums, for guitars, for keyboards, and another for vocals.

The Folder Track VCA

VCA stands for “voltage controlled amplifier.” For those of you with experience with analog gear, that name relates to a similar feature on automated mixing consoles. In essence, the VCA on the Folder track remotely controls the level of all the included tracks proportionally. This gives you a master level control for all the tracks in the folder.
Folder Track VCA

Keep in mind that no audio passes through the Folder track itself. The VCA acts as a remote control, proportionally controlling the volume of all of the individual Volume & Pan plugins of the tracks contained within the Folder track. It’s a very convenient way to add high-level mixing to your groups of instruments, without going through the complexity of adding numerous additional bus.

Note: You can’t insert plugins on Folder tracks, since no audio actually passes through the track. To do so you would need to create a Submix track, which we’ll cover in the next chapter - Chapter 34.

Creating a Folder Track with Existing Tracks

With multi-track drums, you often have 10 tracks or more that you need to put into a Folder track. Rather than drag each track individually, there is a quick way to pack all of them into a Folder track at once:

1. Select the first track by clicking on the track name. Hold down Shift and click on the last track. All of the drum tracks will then be highlighted.
2. Next, right-click on the track name for any of the tracks and choose the option Create new folder track containing. This instantly creates a Folder track containing all of your drum tracks.
3. Finally, select on the Folder track and give it a descriptive name in Properties.
Tip: This isn’t limited to drum tracks. *Create new folder track containing* is a great way to create Folder tracks for any related selection of instruments or vocals.

**Editing With Folder Tracks**

Folder tracks get even cooler when you discover the editing possibilities. Here is a rundown of what you can do:

**Splitting Contained Clips**

Split clips across all of the contained tracks by simply selecting the Folder track clip, position the cursor, then press Slash (/).

![Split All Clips Within a Folder Track](image)

**Rearranging**

After splitting the Folder track clip, you can rearrange everything within the folder by dragging the Folder track clips to any order. You can use this rearrange a song or just swap verse 1 and verse 2. If you put all your tracks in to a Folder track you can use this to block arrange your song.

![Rearranging Clips within a Folder Track](image)
Trimming

The beginnings and the endings of the Folder track clips have trim handles. Drag to trim all the included clips.

Deleting

In addition to moving and splitting clips, you can delete entire sections of the contained tracks by separating out a section, selecting it, and pressing Delete or Backspace.

Automating a Fade within a Folder Track

You can automate the VCA fader to create a fade-out or fade-in on a Folder track. We’ll get into more detail about automation in a later chapter, but here is a step by step recipe for creating fade-outs:

1. Grab the little “A” icon on a Folder track. That is the automation icon. Drag it and drop it on the VCA fader. A red line appears on the Folder track. That is the automation curve for the VCA fader.

2. Double-click the automation curve to add points. Add two points: one before and one after the section you would like to fade.
Add Automation Points to the VCA Curve

3. Drag the last point all the way down to the bottom of the clip to draw in your fade-out.

4. Between the two points you added, notice an additional point was automatically added. This is a curvature point. Drag the curvature point to adjust the shape of the fade.

Customizing the Fade with **Curvature**

Tweak the speed of the fade by dragging all these points until it the fade sounds right. The automation points snap to the current snap increment. Turn **Snap** off for finer adjustment.

This technique is really a time-saver because you don’t have to go in and edit each individual clip in order to do a fade-out.

**Moving On**

Folder tracks are a powerful feature in Waveform. You may have seen this concept in other digital audio workstations. Once you get the hang of how this works in Waveform, you will be amazed at the creative things you can do.
Chapter 34 - Submix Tracks

In professional mixing, it is common to submix drums to a stereo bus to add compression, EQ, and limiting before mixing it with other other tracks. Actually, it is common to submix other things like vocals, guitars, or instruments. A Submix track resembles Folder track but with an important twist; you can process a Submix track with plugins.

You also have the option to use any track as a submix. This is carried over from earlier versions of Tracktion. We will show you how to configure a track as a submix later in the chapter.

Creating a Submix Track

Creating a Submix track in Waveform is super easy:

1. First, select all the tracks you want to include.

1. Right-click any of the tracks and choose Create submix track containing. The same action is also available in Properties as Create Submix Containing.
Chapter 34 - Submix Tracks

A Submix Track

The result looks very similar to a Folder Track. It differs in that the audio actually passes through the Submix track. You can use the Volume & Pan plug and add any additional plugins you want.

Working with Submix Tracks

Adding Tracks
To add a track to a Submix, just drag and drop it on the Submix folder. You also drag tracks up or down within the Submix track to re-order them. This works exactly like it does for Folder Tracks.

Removing Tracks
To remove a track from a Submix, simple grab it by the track name and drag it back out.

Tip: When dragging tracks, grab them by the track name.

Open/Close a Submix
A Submix works just a like Folder track in that you can open and close it with a triangular icon at the far left of the header.

Adding Effects
You can add any built-in or third-party effect you want (accept for the Waveform Freeze Point) to Submix tracks. Just drag them to the mixer like any other track.

Muting
Mute works like you would expect, muting everything within the Submix track.

Soloing
Soloing works a little differently than you might expect. When you click Solo on a track contained in Submix track, it mutes all other tracks, including the others contained within the Submix track.
Creating an Old School Submix Track

The tradition way to create a submix in older versions of Tracktion was to configure a track as a submix. We will review how this is done since you may encounter older Edits that used this method.

1. Create a track in the normal way.

![Creating an Old School Submix Track](image)

1. Name the track appropriately. In this example, we named it *Drums Submix*.
2. Select all the tracks you want to route to the submix.
3. In Properties, click *Track Destination*. Select your the *Drums Submix* track. This effectively routes the output of each selected track through to the drum Submix track.

![Set the Track Destination on the Source Tracks](image)

Now, you can use the *Volume & Pan* control on your *Drum Submix* track to control the volume of all the tracks that you have just routed to it. You can also add any plugins you want to the new Submix track. In this example, we have inserted a tape simulator and a third party bus compressor.
Of course, you can use any processing that you like. That depends largely on which kind of tracks and the style of music.

**Moving On**

Like Folder tracks, Submix tracks help you organize an Edit especially when the number of tracks starts to get high. Submix tracks also allow you to apply plugin effects processing across the mix of the tracks contained in the submix. This is a powerful technique that is used in studios on hit songs all the time. Submitting is particularly useful when mixing drums but it extends to any collection of tracks such as background vocals, guitars, horns, or keyboards. Waveform makes this powerful production technique easy to set up and use.
Chapter 35 - Automation

This chapter is an introduction to the automation features in Waveform. Automation allows you to program changes to many of the parameters that exist within a track. You can easily program changes to volume, pan, and plugin parameters. You can program automation using external hardware, like controllers that have knobs and faders. Alternatively, you can program automation by adding points and changing the shape of the graphic automation curve that appears as a line on or below the track.

Waveform has excellent features designed to keep all of your automation nicely organized. For example, you can add Automation tracks that appear as lanes nested below a track. You can open Automation tracks when you’re working on automation changes and edits, and then close them when you move onto other tasks.

Tip: You can also do volume and pan automation using Clip Layer Effects which are explained in detail in Chapter 41 - Clip Layer Effects.

In this chapter, we’re going to focus on Volume & Pan automation and then offer an example of how to extend automation to parameters within plugins.

Activating Automation on a Track

The keys to automation are the A icon and the ‘plus’ icon that reside at the far right of each track.

The A and Plus Automation Icons

The first step is to click the plus sign, to add an Automation track. You’ll instantly see the Automation track appear below your original track. The Automation track will have minus, A, and plus icons.
Click the minus icon to remove the Automation track. The A icon allows you to set up the track, and the plus icon will add yet another Automation track below this one.

**Choosing What to Automate**

For this example, we’re going to automate volume on the track. To do that, click the A icon. Then select the menu item, *Automatable parameters for this track > Volume & Pan Plugin > Volume.*

You’ll see an “automation curve” appear as straight line. The line is labelled with the name of the parameter, and the value of the parameter is listed over on the right. This line is the “automation curve.” There’s no literal curve to it yet, because it’s just a line. As you will see shortly, it’s easy to draw curves, steps, and ramps.

Click the curve to select it, then check out its Properties. You can change the *Name* or choose from several actions. Those make more sense once you have some automation points on the curve.
Tip: A fast way to set the automation parameter for the track is to grab the A icon and just drop it on the thing you would like to automate. Then choose the parameter from the list. For example, to automate panning, drag the A and drop it on the Volume & Pan plugin and then choose Pan from the list. This also works for third party plugins.

### Adding Points to the Automation Curve

To give your Automation curve some shape, you need to add some points to it. Add points with either double-click or Opt-click / Alt-click. Here is how to work with the automation points:

#### Creating a Ramp

To draw a ramp add two points then drag one of them up or down. This adjusts the steepness of the ramp. Drag the points left or right to adjust the start and ending of the ramp.

#### Shaping with Curvature

To shape the line segment between points drag the Curvature point. A Curvature point is automatically inserted midway between two automation points. Adjust Curvature by dragging diagonally.
Adjusting a Curvature Point

Tip: An Automation point can also be adjusted in Properties using the Value parameter slider. You will also find a slider for Curvature in Properties.

Drawing an Automation Step

Insert two points that define the position of the step. Hold down Cmd / Ctrl and drag the line segment between the points up or down. You’ll see that the line segment moves separately from the overall automation curve. This makes it really easy to draw in a step shape on your automation. If you don’t hold down Cmd / Ctrl, then the entire automation curve moves.

Automating Fade-ins and Fade-outs

To program a fade shape with automation, add a point where you’d like the fade to start, then add another point where you’d like the fade to end. Drag the second point all the way down until the value reads zero. Adjust the speed of the fade by dragging the other point right for a quicker fade or left for a more gradual fade. Drag the curvature point to adjust the shape of the fade ramp. Of course, you always have the option to adjust the parameters directly in Properties.

As we discussed in a Chapter 33, if you program an Automation curve for a Folder track, you can apply a fade across all the tracks together.
**Converting a Clip Fade-in or Fade-out to Automation**

As you’ve already learned you can easily apply fade-ins or fade-outs to Audio clips with the fade handles on the upper left and right corners of the clip body. If you’d like more control over the fade shape you can convert a clip fade to an Automation curve.

To convert a clip fade to automation, first select the clip and then click *Copy Fade To Automation > Transfer Fade-in to Automation, Transfer Fade-out to Automation* in Properties.

That will redraw the automation curve in the shape of the fade and remove the clip fade from the clip. Now you can apply additional points and shaping using the automation tools.

---

**Reading Automation**

Once you’ve drawn automation as described above, Waveform performs the automation dynamically during playback, as long as you have *Automation Read* enabled on the Transport.
As you playback, watch the controls changing in real time as the cursor moves through the Edit. If you go back about three decades that feature would cost you about a million bucks!

**Automation Curve Properties**

The automation curve has several of its own properties. Click on the curve to selected it and look at Properties. Here is a rundown of the controls:

**Curve**

The *Curve* property is the name that appears above the automation curve. This is shown for reference only. You can’t change it directly. It is made up of the track name, the plugin name, and the parameter.

**Displace Curve**

*Displace Curve* allows you to drag left or right which offsets the curve up or down. It basically takes the entire programmed curve and set of points, and moves them down if you drag left or up if you drag right. This is very useful to make minor mix changes after the automation is already programmed.

**Scale Curve**

Think of *Scale Curve* to function like an intensity control. As you drag to the left, it proportionately lowers all of the points on the curve, squashing the shape of the curve. Dragging to the right expands the curve, scaling it upward.

**Only Displace/Scale the Marked Region**

This parameter works along with *Displace Curve* and *Scale Curve*. When enabled, any scaling or displacing, only occurs between the In-marker and the Out-marker.
Simplify
If your automation curve becomes very complex with lots and lots of points, use Simplify to thin out the points. You can usually choose Simplify the entire curve and then pick from Light, Medium, and Strong. The Light option does the least thinning where Strong thins the most. This is particularly useful if you recorded automation from a hardware controller that added hundreds of points.

You also have the option to Simplify only in marked region. You can use this if you want to simplify a section that was recorded from hardware while leaving the rest of the curve unchanged.

Delete Points from Curve
This set of options allows you to completely reset the automation curve. If you delete all points from the curve, you’ve basically taken it back to a flat line. Sometimes this results in the automation value being set very low. You might need to drag the Automation curve line back to a good starting position.

1 You can also *Delete points within the marked region* which means you’ll delete all the points between the In-marker and the Out-marker. You can do the same thing and "close the gap," means to take out the time within the marked region.

Copy the Marked Region to the Clipboard
Set the In-marker and the Out-marker over a region of automation and click Copy Marked Region to the Clipboard to copy that region of the curve. Then, position the cursor to the destination and select Paste From Clipboard > Paste Curves at Cursor Position and that pastes the automation. This makes it fast to create repeating patterns of automation.

This is also useful if you’ve created a very specific effect using automation and want to reproduce that effect in a later part of the song.

Paste from Clipboard has two options. Most of the time I would use Paste curves at cursor position. You can alternatively do that with Cmd + V / Ctrl + V.

Alternatively, choose Paste curves to fit between the in/out markers. That allows targeting the destination only within the merged region. Normally you paste at the cursor position.

Tip: You don’t need to manually copy automation when moving or duplicating clips on a track. Enable Auto Lock in the Master section and the automation follows along as you move or duplicate clips.
How to Find Out What Automation is Active for a Track

It’s pretty easy to program a lot of automation, but sometimes you don’t have all of the automation curves visible. To see which ones are available click the A icon and select *Active Parameter Curves for This Track*. This shows all automation curves for the track and you can choose which one to make visible.

This is particularly helpful if you don’t have each parameter on a separate Automation track.

Remap on Tempo Change

Each plugin has a *Remap on Tempo Change* setting in Properties. With that enabled, as you change the tempo of the song, the automation will track the tempo changes. That means it will get smaller if you speed up the tempo or it will get longer in order to match the clips in your Edit. This is a great feature but is not enabled by default; You need to turn it on for each plugin.

Tip: We suggest you turn *Remap on Tempo Change* on as a global option for all new Edits. To do so, enable *Timecode > Default remapping options > Remap plugin automation* from the Menu section.
Chapter 35 - Automation

**Make Remap the Default**

[Image of software interface showing settings]

*Note:* Remap Plugin Automation is not set as the default or turned on by default, to maintain compatibility with older projects.

---

**Writing Automation on the Fly**

During playback, you can adjust a parameter in real time and have Waveform record it as automation. You can do this with a MIDI controller, or simply by manipulating plugin controls on-screen during playback. All you need to do is setup your Automation track and enable *Automation Write* mode.

[Image of transport controls with Automation Write enabled]

*Automation Write* Enabled

To go into write mode, enable the *Automation Write* button on the Transport. Now, during playback, Waveform will record any dynamic changes you make to the parameter.
Note: You don’t need to be in Record mode to record automation changes. All you need is to have automation write turned on during playback.

Tip: When you’ve written automation this way, it’s often a good idea to use Simplify to thin out the automation points. You will usually get good results with the Medium option.

Automation Lock

Notice in the Master section, there is an Auto Lock button. By default it’s not engaged. If you move a clip around on a track, the automation will not follow it to the new position.

With Auto Lock engaged, automation will follow as you drag the clip to a different place in time. It’s a great feature, assuming that’s what you want to do.

Tip: If you are automating volume or pan for clips, check out Clip Layer Effects in Chapter 41. This style automation always stays with the clip.
Automation Patterns

Waveform lets you quickly create repeated automation patterns between the In-marker and the Out-marker using a new feature located in Properties.

1. To get started, create an automation curve for a parameter you would like to modulate. In this example we are using a simple volume curve.

2. Next, set the In-marker and Out-marker over the range to which you want to apply the pattern.

3. Select the automation curve, then in Properties click Create Pattern Between the Marked Region.

4. Next, choose from the various pattern shape options. For this example we chose Triangle.

5. Choose a note division for the pattern or number of repeats. In typical Waveform fashion, we chose 1/2 beat in order to repeat the pattern every 1/8th note.
Select Beat Division or Repetitions

Here is the resulting automation.

Repeating Triangle Automation

6. Adjust the curve using the Displace Curve and Scale Curve drag controls or by editing the automation points in the usual way.
Displace and Scale Curve Controls

Here are examples of the other automation pattern shapes:

Sine Wave

Square Wave

Ramp Up
Automation Ramps

As a companion to automation patterns, Waveform allows you to ramp patterns up or down in a very simple and effective way. This works in conjunction with patterns to allow you to increase or decrease the intensity of a pattern over time. The two Ramp options work as modifiers to the existing Displace and Scale tools.

Automation Ramps are best explained with an example:

1. Set the In-marker and Out-marker over a segment of automation you would like to ramp in.
1. Click on the automation curve to select it.
2. In Properties, click *Ramp from the start of Marked Region* to enable the ramp behavior.

Enable *Ramp from the start of Marked Region*

1. In Properties, manipulate the *Displace Curve* and *Scale Curve* sliders. Notice how these affect the left side of the curve allowing you to fade in the automation pattern.
The companion *Ramp from the end of the Marked Region* allows you to taper automation down.

These new features are easy to miss at first glance, but they provide tremendous creative potential when programming automation.

**Tip:** The automation ramp features are also available when working the *Volume & Pan* Clip Layer effect which is explained in Chapter 41 - Clip Layer Effects.

**Video Clip:** Here is a video clip\(^4\) that demonstrates the automation ramp modifiers.

### Moving On

There is a lot more you can do with automation, because you can automate almost any parameter. You can automate sends to effects. You can even automate your Master plugins. Simply create a separate track then drag the A icon from that track over to the Master section plugins to automate them.

\(^4\)https://youtu.be/koDUoO3XD-0
Chapter 36 - Mixing Down

In this chapter we’re going to go over the steps required to mix down your Edit to a WAV or MP3 file.

Master Section Processing

Before you mix down, you might want to add some Master effects, so that the entire stereo mix is processed. Master plugins often include a compressor and a limiter to give the final mix a professional sound.

We won’t get into the details about exactly what you’d apply there, although the included Waveform Master Mix plugin is a nice choice. It’s a multi-band compressor, EQ, and limiter all in one.

Make sure that the metering for the Master section is not going into the red before you export the mix. Exactly how you process the mix depends on what you plan to do with the file after it’s mixed down.
If you’re having professional mastering done, then you probably don’t want to put any plugins on there. However, if you are immediately going to upload to your website or SoundCloud, you will want to put some mastering effects on to make your mix sound like a finished product.

Exporting to a WAV File

Here are the steps to export your song as a WAV file:

1. Set the In-marker exactly at the beginning of the song. This defines the start of the export. Adjust the position of the In-marker to skip any extra bars or count-in at the beginning of the Edit.

1. Set the Out-marker right after the end of the song. This allows you to control the exact length of the exported file. We recommend leaving a couple of extra milliseconds after the final fade.

1. Select Export > Render to a file from the Menu section. The Render dialog box appears.
The above example shows the most common settings for exporting a WAV file. You can customize the file location and name if you want. Also, make sure to select Only Render Marked Region so that the In-marker and Out-markers are used to define the export region.

1. Click Render and the export will begin. Waveform starts processing in the background as you adjust the settings. Much of the time export is already done as soon as you click Render!

**Locating the Exported File**

Unless you change the file path, the file saves to the project folder. You can find the file either on the Projects tab or from the Browser.

**Locating the Export on the Projects Tab**

Click the Projects tab and look at the Exported Audio/MIDI list at the right. Unless you have changed the filename, your exported file will be there with the word “Export”, and an export number appended. The exported files appear in the third column. If don’t see the list, make sure you have Show Exports selected in the View Options list at the upper right corner of the Projects tab.
The Exported File on the Project Page Files List

To locate the file in Finder or File Explorer on your computer, select the exported file and look at Properties. In Properties, click the … button to the right of File and choose Open the folder containing this file. That opens the folder on your system, giving you direct access to the file.

Locating the Export in the Browser

Open the Browser and go to the Files tab. Click the folder icon and select Project folder.

Locate the Project folder from the Browser

Double-click the folder named Exported and you will see your file. To located it in Finder or File Explorer, right-click and choose Open the folder containing this file.

Exporting to an MP3 File

The steps to create an MP3 file are almost identical. Follow the same steps above except when you get to the Render dialog box select MP3 for Format. That selection gives you a few extra options for Rendering.

Add ID3/Vorbis Info

With MP3 exports you can select this option to add metadata to the file.
To enter the metadata, click *Edit* to the right of the option. That gives you the *ID3/Vorbis Info* dialog box. Fill in any information you want to embed into your MP3 and click *OK*.

This information is not required. So, if you don’t care to include the information, leave the *Add ID3/Vorbis Info* deselected.

**Quality**

You can choose from common MP3 quality settings. VBR stands for “Variable Bit Rate” and helps optimize the file size in exchange for a bit more complicated encoding. CBR stand for “Constant Bit-rate” and gives you slightly larger files that are encoded consistently.
With today’s fast internet speeds, including for mobile users, we recommend choosing the maximum 320 KB/s CBR. Those will give you good sounding MP3 files to upload to various sites or use in your own player.

### Additional Render Properties

The *Render* dialog box has numerous settings. Often you can skip looking at all of this stuff and just hit *Render* and you will get an output file. However, it is a helpful to know what the other properties do:

**File Name and Location**

The first line is the file name and the location of the output file. You can edit that to name the file with the song name. You can also update the destination folder location on your system. By default it will be export to an “Exported” folder location in the project folder.

**Format**

While WAV and MP3 files are the most common choices, Waveform also supports several other file types:
Export File Format Options

**Stereo**

For music it is most common to export to stereo files. If you deselect *Stereo* the file is exported as mono. You can use mono exports for voiceover files, for example.

**Remove Silence at Start/End**

This does, as it says. If there is excess silence before the song or if there is a long silence at the end, Waveform will take that out.

**Dithering Enabled**

If you don't know anything about dithering, then leave this enabled and move on. If you do know about dithering, then you can turn this off and add a third-party dither plugin in the Master section, configuring it to dither as you please.

**Only render the marked region.**

Whenever Waveform indicates “marked region”, it means the range between the In-marker and the Out-marker. When enabled, the exported file only includes the audio between the In-marker and the Out-marker.

**Render Each Track to a Separate File**

If someone else is going to mix your song using a different digital audio workstation, then
you might want to export every single track in a fashion that can be imported into another system. If that’s the case, turn this option on and you’ll wind up with a whole collection of files: one for each track of your project. For a normal stereo export, leave this turned off.

**Render at 1X Play-Speed**
If you are using the Insert plugin to mix through some external hardware effect, turn this option on when exporting your mix. Normally, you leave this option turned off. When enabled the Edit will render in real time, meaning, it will mix it down in exactly the same amount of time it would take to play back once. Some feel you will get the best sound quality rendering at 1X and for that reason, some Waveform users enable 1X rendering for the final master exports.

**Normalize**
Normalize adjusts the overall gain of the file so that the highest peak fills up the available bit depth. Most of the time you will leave this turned off.

Adjust Level Based on RMS
Adjusting the level based on RMS is a way to set the output to match a perceived volume level. Modern broadcast standards require your files not to exceed standards based on the country and use.

**Render Automatically**
With this feature, in the background, as soon as you open the Render dialog box, it starts mixing down. It even shows you the progress on the lower waveform display. If you don’t make any changes to the settings, as soon as you hit Render it’s done instantly. Waveform already created the file in the background. It’s sort of like working ahead. If you do make changes, it will start re-rendering right away. If you have a slower computer you can turn Render Automatically off.

**Add to Library**
Add to library means you will add what you are mixing down to your loop library, so that you can search for it and use it in another project. It’s a useful feature if you are mixing a lot of things to add to your library.
Mastering with CloudBounce

CloudBounce is an automatic online mastering service that was developed as part of the Abbey Road Red incubator program. It does nice general purpose mastering at a very low price. A single track runs $4.90 USD but low monthly plans are also available.

Waveform is directly integrated with CloudBounce, making it very convenient to get quick masters done without doing it yourself, or paying high fees for professional mastering. For many projects, it’s all you really need.

To use CloudBounce, first export your Edit in the normal way using Export > Render to a file. With the export complete, switch over to the Projects tab and select the exported file from the Exported Audio/MIDI list.

With the file selected, you see the waveform and other controls in Properties. This is where you find the button Master With CloudBounce.

Click Master With CloudBounce to upload the exported file to the service.

https://www.cloudbounce.com
File Uploading to CloudBounce

When the upload is complete, CloudBounce immediately runs the file through its machine listening and mastering processors, and creates a 45-second preview.
Click *play* to listen to the Preview. If you like the results, login or sign up and select a payment option or subscription plan. You can also access options to tweak the processing and then download the finished file.

CloudBounce is fast, effective, and low cost. Would you use it for your most critical projects? Probably not. But if your budget, time, or mastering skills are limited, it might be exactly what you need.

**Moving On**

We have gone all the way from installing the program, to recording, editing, adding virtual instruments, to using guitar amp sims, mixing, and mixing down. There’s still a lot more that you can learn and explore about Waveform and your own music. Have fun, and make a lot of music. So let’s keep going!
Chapter 37 - Macros

Waveform includes not only programmable keyboard shortcuts, but also a full macro programming environment. You can develop keyboard shortcuts that combine actions in new ways to streamline your workflow. If the standard keyboard shortcuts don’t meet your needs, you can create custom macros and assign keyboard shortcuts to them.

While you might think of macros as keyboard macros, you don’t have to assign them to keyboard shortcuts. You can always launch them from the Run Script button in the Menu section. This approach can be useful because you don’t have to remember the shortcut to macros you only use occasionally.

Script Editor

To open the Script Editor, go to the Settings tab, and select the Keyboard Shortcuts page. Enable Show Script Editor at the bottom right of the Keyboard Shortcuts page. The Script Editor will open.

The Script Editor

You can resize the height of the Script Editor by dragging the line that separates it from the keyboard shortcuts list. The Script Editor is a basic text editor that you use to enter and edit macro scripts.

Tip: With the Script Editor open, try clicking on some of the existing keyboard shortcuts. The Script Editor will show you the underlying code, you can use this to get familiar with the syntax of the actions triggered by each shortcut.

Creating a Macro

To create a new macro, click Add a new macro on the Script Editor. This adds a new macro named “Untitled Macro” to the bottom of the keyboard shortcuts list under the Macros section.
Adding a New Macro

As soon as the new macro is created, the name defaults to *Untitled Macro* and is selected. Start typing to give it a suitable name.

In the body of the macro, you can type in a list of actions to create the script. The easiest way is to build your macros using the right-click menu; more on that in a bit! Actions are separated by semicolons.

Deleting a Macro

While you can’t delete the built-in keyboard shortcuts, you can delete any custom macros you create. To do so, select the macro to delete in the keyboard shortcuts list, and click *Delete macro* in the Script Editor.

Programming a Macro

The simplest macro is made up of a single action. You can pick any available action by right-clicking the Script Editor and navigating through the three collections of actions. When you find an action you want to use, select it and the appropriate code is inserted into the script.
Selecting Actions from the Script Editor Right-click Menu

- **Actions > Standard Shortcuts** includes all the built-in keyboard shortcuts shown on the Keyboard Shortcuts page.
- **Actions > Basic Actions** includes available actions that are not necessarily available as pre-assigned shortcuts.
- **Actions > Advanced actions** includes actions that allow you to manipulate selected objects and even display messages on the screen. Advanced actions are provided as tools for more advanced script programming.

### Running a Macro

There are several ways to run a macro:

1. Assign it to a keyboard shortcut. Keyboard shortcuts are assigned to macros in the very same way as the built-in shortcuts. Find the macro in the list and click the “+” to the far right and enter the desired key combination.
2. Click **Run Script > User Macros** from the Menu section of the Edit tab. All your custom macros appear there automatically. Select the one you want to run.
1. Add macros to the Custom Menu. At the bottom of the Keyboard Shortcuts page, click to enable Show Script Tree Editor. Then drag your macros (or any built-in actions) to the tree editor. Arrange it using drag and drop, add groups, and rename groups. Access the Custom Menu from the menu in the Edit: Run Script > Custom Menu.

**Javascript Programming**

Beyond creating simple step-by-step lists of actions, you can take macro programming to the next level using the power of Javascript. The Script Editor allows you to program loops and conditions using Javascript syntax. It even provides color coding for the elements of the script.
Note: Waveform actions are exposed as methods using ‘dot’ notation. By that, we mean that they start with the word Waveform, then a dot, then the method. Following the method you can provide one or more parameter in parenthesis.

Macro Actions ‘dot’ Notation Syntax

Hover Tooltip

If you hover over an action in the script editor for a second or two, you will see a tooltip bubble explaining what parameters the action takes. If the action returns values, you will see the syntax of that. These tooltips give you key information when programming macros. Waveform’s developers use this to give you meaningful clues about how each of the actions work.

In the above example, the tooltip shows that the zoom action takes two double precision numeric parameters. The first is the x-proportion (the amount of vertical zoom), and the second is the y-proportion (the amount of horizontal zoom).
RTZ Macro Example

By default Waveform doesn’t have a true return-to-zero (RTZ) keyboard shortcut. The built-in command stops first if it encounters the In-mark so you need, to hit it twice to really get back to zero. However, you can create a macro that does the action twice, always returning the cursor to the start of the Edit.

![RTZ Macro Example]

For example, you could assign the RTZ macro to the Home key.

Merge Clips Macro Example

Another feature that you may use often is Merge Clips. Normally you use this by selecting a few clips on a track that you want to combine to a single clip. Then you select Render Clips > Merge the Selected Clips from Properties. If you do this frequently, you could do it with a single keyboard shortcut, for example assigning it to Cmd + G / Ctrl + G.

![Merge Clips Macro Assigned]

Importing and Exporting Macros

Macros are actually just simple text. You can easily copy and paste the text directly in and out of the script editor. In addition, Waveform has dedicated buttons to import and export macro scripts as XML files with a .tracktionscript extension.

![Script Input and Export Buttons]

Code Samples

TCS engineers have supplied code samples of several macro scripts to get you started:
Rename Clips From Track

```javascript
// Rename Clips From Track
var tracks = Waveform.getSelectedEditElements ('track');

for (var i = 0; i < tracks.length; ++i)
{
    var track = tracks[i];
    var trackName = Waveform.getName (track);
    var clips = Waveform.getClipsFromTracks (track);

    for (var c = 0; c < clips.length; ++c)
    {
        var clipName = trackName + " " + (c + 1);
        Waveform.setName (clips[c], clipName);
    }
}
```

Reset Tracks Solo/Mute

```javascript
// Reset Tracks Solo/Mute
var tracks = Waveform.getEditElements ('track');
Waveform.setSolo (tracks, false);
Waveform.setSoloIsolate (tracks, false);
Waveform.setMute (tracks, false);
```

Next Active Automation Parameter

```javascript
//Next Active Automation Parameter
var track = Waveform.getTrackFromSelectedObject();
Waveform.changeActiveAutomationParameter (track, 1);
```

Insert Plugin with Preset

```javascript
```
// Insert Plugin with Preset
var track = Waveform.getTrackFromSelectedObject();
var plugin = Waveform.insertPlugin (track, "Massive", 0, "AudioUnit");
var preset = Waveform.getPresetFromLibrary ("Massive All Souls");
Waveform.setPluginPreset (plugin, preset);

Jump to Tab 2

// Jump to tab 2
var index = Waveform.getWindowTabIndex();
var delta = 2 - index;
Waveform.changeWindowTabIndex (delta);

Rename Selected Tracks

// Rename Selected Tracks
var tracks = Waveform.getSelectedEditElements ('track');
Waveform.setName (tracks[0], 'Kick');
Waveform.setName (tracks[1], 'Snare');
Waveform.setName (tracks[2], 'Hats');
// etc.

Save Selected Plugins as Preset

// Save Selected Plugins as Preset
var plugins = Waveform.getSelectedEditElements ('plugin');
Waveform.saveObjectsAsPreset (plugins);

Park the In-Marker & Out-Markers
/* Park the In-Marker & Out-Markers */

Parks the In-marker and Out-marker at Zero then Restores Cursor Position. We wrote this macro to help a KVR forum member find a quick way to hide the In-marker and Out-marker.

```
var SavePosition = Waveform.getPosition('cursor');
Waveform.moveTransportToStart();
Waveform.moveTransportToStart();
Waveform.markIn();
Waveform.markOut();
Waveform.setPosition('cursor', SavePosition);
```

## Search Plugins

/* Search Plugins */

Opens the Browser to the Search tab, enables the Plugin searching while disabling searching for Presets and Loops.

```
Waveform.showSidePanel('search'); // Opens Browser to the Search tab
Waveform.enableSearchLibrary('plugin', true);
Waveform.enableSearchLibrary('preset', false);
Waveform.enableSearchLibrary('loop', false);
Waveform.setSearchPanelText(''); // loads blank text so you can start typing the search term right away
```

## Rename selected clips to ‘Drums’

// Rename selected clips to ‘Drums’

```
var clips = Waveform.getSelectedEditElements('clip');
for (var i = 0; i < clips.length; ++i)
  Waveform.setName(clips[i], 'Drums');
```

## Undo and Redo Zoom Levels

// Undo Zoom - great companion when using the Shift + Opt / Shift + Alt zoom tool

```
Tracktion.undoSelectZoom();
```
// Redo Zoom
Tracktion.redoSelectZoom();

**Pin Properties**

// Pin Properties Panel - Pins Properties bubble open when using the compact Toolbar. It toggles between pinned and unpinned states.
Tracktion.lockPropertiesPanel();

**Group Clips - Group and Ungroup**

// Group Clips
Tracktion.groupSelectedClips();

// Ungroup Group Clips
Tracktion.ungroupSelectedClips();

**Moving On**

These are fairly simple examples. Waveform users are only just starting to explore the powerful capabilities of macro programming in Waveform. You can use this to assign just about anything to keyboard common, string together sequence of command, or develop detailed scripted actions. It’s a wonderfully powerful feature that makes it possible to extend Waveform in new and interesting ways.
Chapter 38 - Mixer View

Before it was called Waveform, the Tracktion DAW was famous for the inline Mixer section on every track. This design allowed you to stay in one screen for recording, editing, and mixing. However, many users still wanted a console view with vertical channels organize like a real life mixing desk.

Waveform gives you a Mixer view that is flexible while staying completely optional. If you are used to the Tracktion workflow you can keep the Mixer view closed and ignore it. However, if you prefer this way of working, Waveform has a mixer that is both flexible and great looking! This chapter is all about how to use the Waveform Mixer view.

Tracks and Channels

Waveform automatically maintains perfect sync between the tracks in the arrangement and channels in the Mixer. Track order is the same as the channel order. Track names are the same as channel names. If you change the order or name in one view it changes in the other. Even Folder tracks and Submix tracks stay in sync between the two views - including the open/closed state.
**Note:** For the most part, tracks and channels in Waveform are two views of the same thing. Tracks hold clips of your arrangement while channels in the mixer don’t show that detail. Tracks are represented horizontally with signal flowing left to right. Channels are represented vertically with signal flowing top to bottom.

### Open/Close Mixer View

To open or close Mixer view, click the Mixer icon button in the upper right corner of the Edit window.

### Mixer View Controls

The view controls for the Mixer are along the right side. Use this series of icon buttons to turn or off sections of the Mixer.
Dock/Undock
Click to undock the Mixer and move it to a separate tab within the Waveform. You can then drag the tab free to put the Mixer on a separate monitor if you like.

Channel Width
Use the channel width buttons to select between three different widths: large, medium, small.
Arrangement Overview

Click to show/hide an arrangement navigator view at the very top of the Mixer.

This only appears with Mixer undocked. On the overview, you can do the following things:

- Zoom the timeline in or out by dragging up or down. You can also use Up-arrow and Down-arrow to zoom.
- Drag the cursor to position it for playback. This is great if you are working in the mixer view while recording.
- Drag the In-marker and Out-marker to set the loop for playback or to prepare for punch-in recording.

Show/Hide Meter Overview

The meter overview shows a compact view all the track meters at the top of the mixer. This works something like a meter bridge - a feature of traditional studio consoles. It gives you a full overview of mix levels and overloads. Click any of these meters and it selects that channel in the mixer and pans over to bring it on screen if necessary. It’s great to quickly identify and address overloads in a large mix.
Meter Overview

Show/Hide Inputs
Click to show the inputs. This allows you to configure inputs for recording right from the Mixer. If you really like to working with Waveform in the same way as you would with a tape recorder and mixing desk, this gives you a way to do that. You can run your complete recording session from the Mixer view if you like. With the inputs shown, access the options from the right click just like you do when working with a track in the arrangement. You can also drag inputs from channel to channel to quickly set up for recording the next overdub.

Show/Hide Big Meters
If you like to see detailed meters at the top of each channel enable the big meters view. Big meters have helpful dB markings. The meters show the level of the final Level Meter plugin in the plugins area per track. You can increase the height of these meters by dragging the boundary next to the plugin section or by turning off some of the other option parts of the mixer. If you hide the big meters, then meters appear next to the channel faders. Showing the big meters is useful and impressive if you have a large secondary monitor and display the Mixer full screen.

Tip: To set the meter response for a channel right-click the last level meter plugin and chose from the options.
Selecting Meter Response Option

Setting Levels and Panning

Setting Fader Level
Drag faders up or down to set level of the last volume pan plugin on the track. Ctrl-drag for fine resolution adjustment. Double-click to reset to 0 dB. Opt-click / Alt-click will also reset the fader to 0 dB.
Setting Pan Position:
Drag pan knobs up or down to set level of the last volume pan plugin on the track. Ctrl-drag for fine resolution adjustment. Double-click to reset to the center. Opt-click / Alt-click will also reset pan to the center.
Working with Mixer Channels

Renaming Channels
Double click the channel name to editing the name. Type in the name you want then press return. Renaming a channel in the Mixer renames the corresponding track in the arrangement.

Selecting Multiple Tracks
The typical ways for selecting multiple objects also work for channels. To select a channel click on the channel name or on the meter. To select additional channels hold Cmd / Ctrl and click the each of the other channels to add to the selection. Shift-select also works. Click the first channel to select, hold shift and click the last one and it selects those plus all those in between. Multiple selection works along with reordering, deleting, and duplicating Channels that we discuss next.
Reorder Channels

To reorder channels, drag a channel to its new position. A red insertion guide illuminates behind the channel so you know where it will go when dropped. You can also drop channels into Folders or Submixes from Mixer view using this technique. Reordering the Mixer channels also reorders the tracks in the arrangement.
Folders

Channels for Folder tracks appear in the Mixer with an open/close triangle and a VCA fader. There is no pan control and the plugin, output, and meter sections are will all be blank. You essentially remote control the faders of the contained tracks with the VCA fader. This works exactly like the corresponding controls on a Folder track in the arrangement. You can add or remove channels to a Folder using drag and drop. You can also open or close the Folder using the triangle control at the upper left. The channels inside a Folder appear slightly indented downward. If you add plugins to a Folder it automatically converts to a Submix.

Submixes

Channels for Submix tracks work much the same as Folders except they have meters, pan controls and can take plugins. Use a Submix when you want to apply plugins to a submix of set of channels.
Deleting Channels
To delete a channel, select the channel and press delete. This also deletes the corresponding track in the arrangement so be careful!

Adding Channels
Adding channels is the same as adding tracks. Press T to add a track to the arrangement which also adds a channel to the Mixer. You can add multiple tracks at the same time from the Tracks menu in the Controls panel.

Duplicate a Channel
Select any channel and press D. This immediately copies the corresponding track and inserts the copy right after the original one. A corresponding channel is appears in the Arrangement at the same time. This also works for a selection of multiple channels making it really quick to duplicate a setup ready to add more takes or parts.
Channel Colors

Channel colors are the same as the track colors. To set the color, select the channel or track and pick the color in Properties. You can access Properties from the Mixer just like you do when working in the arrangement.

Working with Channel Plugins

Adding Plugins

To add a plugin to a Mixer channel, click the ‘plus’ icon on the plug section of the mixer. If the plugins are not shown, then turn on that section from the Mixer controls to the right. Alternatively, if the Mixer is docked below the arrangement, you can drag plugs in using the Plugin object or drag them from the Browser.
Reorder Plugins
Reorder plugins using drag and drop. You can also drag them to other tracks or copy them by holding down Cmd / Ctrl while dragging.

Removing Plugins
The easy way to remove plugins from the Mixer it to select one and press Delete or Backspace. You can also right-click a plugin and choose *Delete this plugin* from the list of option. One more way is to select the plug then click *Delete plugin* from Properties.

Using More than One *Volume & Pan* Plugin
Waveform allows you to use as many *Volume & Pan* plugins as you want on a channel.
Normally, there is just one and that is the one that is controlled by the channel fader and pan control. If you have more than one for gain staging or whatever reason, the last one in the chain is the one that will be controlled by the channel fader. You will also notice that additional Volume & Pan plugins will show quick controls right on the plugin in the mixer. Click the volume or pan icon and a corresponding slider will pop up ready to adjust.

![Channel with Two Volume and Pan Plugins](image)

**Using a Quick Control**
For each plugins, let you can pick one control to assign directly for quick access from Mixer view. Right-click a plugin to choose the control from the list of its available parameters. A horizontal slider appears below the plugin which you can use to adjust that parameter.
Moving On

While simple, the Waveform Mixer gives you another view to give you a different perspective. For mixing, it might offer a more comfortable way to interact with the recordings. Even though it’s simple it retains Waveform’s flexible plugin architecture and allows you hide or show the features that are most important to you.
Chapter 39 - MIDI Chord Player

MIDI Chord player is special plugin that transforms MIDI data. If one note comes in a three note triad comes out. You can use this before a virtual instrument to make it easy to create harmony parts even if you have limited keyboard skills. You can also use it as a composition tool to compose chord progressions by ear.

MIDI Chord Player features a key switching map that you can use with your left hand to chose from many chord types, then play the root of the chord with your right hand. It also has a mode that keeps all your chords in the correct key. In this chapter you will learn how to use it.

Getting Started

First make sure your you have a keyboard or other MIDI controller connected and routed to the input of a track. Load a virtual instrument, select a patch and make sure you get sound when you play. We we chose Warm Concert Grand from Tracktion Collective.
Insert the MIDI Chord Player to the left of the virtual instrument. It’s one of the built-in Waveform plugins.

Now as you play a single note on your keyboard, you will hear a three note chord. By default this will be a major triad.

Using the Key Switch Modifiers

Hold down one of the notes in the key-switch range as you play your note to play the most common harmonized chord types. You aren’t limited to simple major triads.
Key-switch range is highlighted blue and starts at C4 by default. Drag the arrow at the left to move the key-switch range to a convenient location on your keyboard.

**Rendering the Chords**

If you record the MIDI performance to a MIDI clip, the clip will show a single note. To render all the chord notes to the MIDI clips on the track click *Render Clips* on the MIDI Chord Player.
After you render clips, Chord Player is automatically removed as a plugin. This exactly what you would expect. Playing chords through chord player usually does not create pleasing results!

**Locking MIDI Chord Player to Properties**

When working with MIDI Chord Player, it shows the notes you are playing on its virtual keyboard. It is particularly helpful to see if the notes are in the key-switch range. The problem is that if you select a MIDI clip or other object in Waveform, Chord Player is no longer visible. You can keep it in Properties by engaging the lock icon. This is helpful trick if your programming the MIDI notes by hand or playing them from keyboard. Just remember to unlock it when done!
**Chords in Key Mode**

The normal mode for Chord Player is *All Chords*. In this mode it will create chords based on the note you play but doesn’t do anything to keep you in a particular key.

If you change the mode to *Chords in key only*, Chord Player will prevent you from using notes that are outside the key. Outside notes, will not even sound if you play them.

Set the key by clicking on the Tempo track header.
As you play notes, each note will represent one of chords in the key. This allows you to play around with progressions in any key by ear.

There are only two key-switch modifiers in this mode. Since the chord formula is already decided by the key, you are choosing from two different four-note chord harmonies 6th or 7th. Like before you can move the key switch range by dragging the arrow to the left of it.

Chords in key mode is a great companion for songwriting especially if keyboards are not your first instrument.

**Moving On**

MIDI Chord Player is one of the cool musicality features of Waveform. It is a useful and fun assistant when you need some creative input.
Chapter 40 - Track LFOs

Track LFOs allow you to quickly provide movement to any automatable plugin parameter. In this chapter, we will show you how to use the Track LFO feature.

Inserting a Track LFO

Assign a track LFO to a track by dragging the LFO Creator object to the mixer section of any track. You either drag it to the top of the track then assign it to a parameter later, or drag it directly to any plugin and choose the parameter to modulate right away.

Track LFO Creator Object

You can assign as many LFOs to a track as you want. The LFO objects appear above the plugins for the track. The shape of the LFO is indicated on the object and you can choose from several colors in Properties.

Track LFOs on a Track

Track LFO Properties

To control how a track LFO behaves and looks, select the LFO then adjust the parameters in Properties. Properties also lists what parameters are being modulated.
To choose and LFO shape, select the LFO then click *Wave* in Properties and choose one of the five shapes: Sine, Triangle, Saw Up, Saw Down, or Square. The shape will be represented in Properties and on the thumbnail image on the LFO object.

With the shape selected you can choose how to control the modulation speed by clicking *Sync* and then choosing *Time* or *Beat*. If you choose time adjust the speed by dragging the *Frequency* slider left or right, or double click *Frequency* and type in a value in Hz.

If you choose Beat, then the Beat divisions menu appears. Click it and select one of the musical divisions.
In addition to the speed you can adjust the Intensity, Phase, and Offset using additional parameters. Also of the are useful but I find Intensity to be the most essential.

**Other Properties**

Properties for track LFOs contain several other useful controls. Here is an explanation of what these do:

**Enabled**

*Enabled* turns the LFO on or off. If you want to suspend the operation of the LFO without deleting it, turn *Enabled* off.

**Remap on Tempo Change**

If you choose Beat synced frequency the value is calculated at the time of the selection. If you want to recalculate the value anytime tempo changes, then leave *Remap on Tempo Change* enabled. Normally you will want to leave this on.

**Highlight Controlled Plugins**

With *Highlight Controlled Plugins* enabled it does exactly that. It draws a unique color outline around any plugin that has a parameter tied to the LFO.
Color

Select one of the nine colors to use for the track LFO object. This is useful if you have several of them on the same track.

Tip: The LFO is also used for the highlight color if you have Highlight Controlled Plugins enabled.

Learn

Click Learn then move any plugin parameter and it will be added to a temporary list. Then click the check symbol to confirm the assignments. This is a great way to assign numerous parameters to the same LFO.

Removing LFO Assignments

When you select a track LFO, all assigned parameters are shown in the list at the right side of Properties. To remove any assignment, click the “X” at the right of the assignment in the list.
Tip: To remove a track LFO entirely, simply select it then click Delete LFO in Properties.

Video Tutorial

We have published this video tutorial explaining Track LFOs. It shows a few examples of using them with a virtual instrument.

Moving On

Track LFOs are a great way to add movement to effects or virtual instruments. They can also be used to add subtle dynamic panning or aggressive tremolo. The best part is that they are super simple to use.

Video: https://youtu.be/9UVEAJAvFZ0
Chapter 41 - Clip Layer Effects

Clip Layer effects were introduced with T7. They offer quick offline rendering of many common audio processes but arranged as layers. You can add or remove layers at will and the effects are rendered in quickly. You can even rearrange the layers. Effects are applied from the top down through the layers.

You may find Clip Layer effects to be most useful for things like applying clip based volume automation, conversion to mono, and normalizing. However, those are just a few example of Clip Layer effects capabilities.

Example Clip Layers

To use Clip Layer effects, click on new FX icon in the header for any Audio clip.
Audio Clip Header FX Menu

From there, select from any of effects. More details on each of these options follows.
The Clip Layer will appear. As you hover your mouse over it, a set of controls appears to the right. The following diagram illustrates the available options.
Adding a volume layer is the Waveform way to do clip based volume automation. You may find yourself using this instead of track automation when it comes to automating volume.

When you click the “gear” icon for a volume layer, you will see the Volume & Pan control values in Properties.
While somewhat useful, you are probably more interested in working with the volume automation curve itself. To do so, click on the volume curve (which initially shows up as a line) and then you have access to the Properties for the that.

*Tip:* See Chapter 35 for more on editing the automation curve. Everything about editing automation curves for tracks applies to volume Clip Layers as well.

**Volume - Fade**

Fade-ins and fade-outs are also available as layers. After creating the fade layer, drag the left or right fade handles to create the fade in or fade out.

*Tip:* Right click a fade handle to set the fade shape.
**Volume - Step**

Add a step volume layer to rhythmically gate the clip.

With the step Clip Layer in place, click the gear icon at the right of the layer and then work with all the Properties to set the step size and divisions. You can then click on the steps to turn them on or off for unlimited synced gating options.

**Time/Pitch - Pitch Shift**

Add a pitch shift Clip Layer to get access to an automation curve for pitch. Add points and automate like any other effect to apply anything from simple pitch offsets to dramatic pitch sweeps.

When you select the pitch curve on the clip, Properties gives you access to the normal range of controls for automation curves.
Pitch Curve Properties

**Time/Pitch - Tape Stop/Start (Pitch Fade)**

You probably already know that you can right-click the fade handles on any Audio clip to apply pitch fades. Now you can do the same thing as a Clip Layer effect.

Right-click the fade handle to choose the shape for the curve.
Time/Pitch - Warp Time

Before Clip Layers, you had to go to Properties and then to the click the Loop Properties tab... then click *Warp Time* to get going. While that still works, it’s much easier with the clip layers feature; Just add a warp time Clip Layer.

The header area of the Clip Layer will appears shaded. Click anywhere in the shaded area to add a warp marker.

Drag a warp points to time stretch audio between warp markers.

If you want to remove a warp marker, right-click and remove it or all markers.
You may find this implementation of Warp Time much more convenient, especially if you want to align transients to things happening on other tracks in the Edit. With the old way, you couldn’t really see timing in relation to the rest of the Edit.

**Effects - Plugin Layer**

A plugin Clip Layer allows you to add any plugin including 3rd-party effects to a layer.

You will be prompted to select a plugin as you add the layer. The name of the plugin appears on the Clip Layer at the lower right when the layer is selected.

Here are the key things to know when working with the plugin Clip Layers:

1. Click the gear icon at the right to open the plugin UI. When you tweak parameters, a few second later the change is rendered in.

   **Note:** Because of the way rendering works, it is a bit hard to audition changes to plugin parameters. You may find plugin Clip Layers are best for applying known presets. If you want to do a lot of real time tweaking, then you will probably be better off to use a Clip effect or normal track plugin.
1. Click the A at the top right to show automation curves. Any exposed automation parameter can be selected which makes its curves visible. Use all your standard automation editing tools to draw in appropriate automation.

**Effects - Reverse Clip Layer**

Using the reverse Clip Layer is really easy. Add the layer and the audio within the clip will now play backwards.

![Reverse Layer](image)

**Mastering - Normalise Layer**

Normalise adjusts the gain of audio so that it use all of the available the bit depth. The concept is analogous to “zoom-to-fit” in image editing software.

To use it, first add Normalize layer.

![Normalise Layer](image)

Then adjust the Normalize value to keep peaks where you want. In voiceover work, many customers request the audio to be normalized to -3db.

![Normalise Property](image)
Mastering - Mono Layer

To convert to mono, the mono Clip Layer is a great feature. It is much more convenient to use this than other approaches in Waveform.

First add a mono Clip Layer:

The choose one of options for determine how to render to mono from stereo:

Note: Most of the time you will probably select Average of all Channels. This mixes the left and right channels to create a mono version.

Mastering - Phase Invert Layer

The phase invert Clip layer is pretty straightforward. It flips the polarity of the wave.
Moving On

We think you will enjoy exploring and working with Clip Layers. It is really only from experimenting with this approach that you will understand how it works. There are likely many new editing workflows that have yet to be discovered, that leverage the power of Clip Layers.
Chapter 42 - Working with Presets

Presets are featured throughout Waveform. You can save your setups and recall them to streamline your workflow. You can also search for your favorite presets using the Browser Search tab.

Saving Presets

To use the Search tab on the Browser to effectively locate presets, you need to prepare by saving presets. Here is a quick summary for the most common types.

Preset Line in Properties Section

Plugins
For instrument or effects plugins, select the plugin in the mixer, then click Save in the Preset line in Properties. This will load the Preset Details dialog box where you can add a name, description, and tags. After you enter the information, click OK to save the preset.

Plugin Racks
To create a preset for a Plugin rack, open the window for it (usually by double-clicking) then select Save from the Preset line. This opens the Preset Details dialog box to complete the process.

Step Clips
Select the Step clip by clicking on its header. In Properties, click Create Preset. You can choose to include or exclude patterns. Choosing either opens the Preset Details dialog box to complete the process.

Tip: If you exclude patterns, a Step clip will use the default Step Length and Number of Steps. We suggest always choosing Include patterns. If you want to create a blank template, simply clear all the notes, before saving.
Tracks

To save track presets, right-click on the Track header then click Save Preset. You will then choose between saving the Whole track or part of the track - Track inputs, Track outputs, Track plugins. We recommend using Whole track however you might want to use Track plugins for a convenient way to save a channel strip configuration for quick recall.

Using Presets

Click the tags to filter presets and search for them by name using the Search field. Once you find a preset to work with, drag it to the appropriate section of the arrangement. Here are some other important features.

Renaming a Preset

Right-click any preset in the list and select Edit Preset. This opens the Preset Details dialog box. Here you can update the name, description, and tags.
Deleting a Preset
Right-click a preset and select *Delete Preset* to remove it permanently.

Export a Preset
To export a preset to share with another Waveform user or transfer to another computer, right-click the preset and select *Export Preset*. The resulting file contains a description of the preset and has the .trkpreset file extension.

Importing a Preset
The easiest way to import a preset file is to drag it from your system and drop it on the Waveform browser. You can also load a preset by right-clicking an existing preset and selecting *Import Preset*.

## Applying Presets

To use a preset, drag it to the appropriate object in the arrangement: Track, clip, or the mixer. There are other ways to work with presets, as follows:

**The Apply Button**
To quickly audition Track or effects plugins, turn on *Apply* in the Presets tab footer. Next, select a track to use to try out the presets and start playback. Click on any preset you want to try for that track and it will be instantly applied. Select various presets to quickly audition. When you disable *Apply*, use *Undo* (Cmd + Z / Ctrl + Z) to remove any plugins applied this way.
Using Part of Preset
Rack and Track presets are made up of several components (e.g. plugins, instruments, mixer plugin setups). Click the triangle to the left of this type of preset to expand the view to show all the components. Now you can drag any of those components to your arrangement.

Auditioning Instrument Presets
Select the instrument preset you want to audition. Make sure Preview is enabled at the bottom of the Presets tab. Click Inputs and enable the MIDI controller or keyboard to use to audition the sound. Play notes on a keyboard to audition the sound. You can also audition Instrument presets, by selecting a track that contains MIDI clips and playing it while Apply is enabled.

Moving On
Use presets to customize Waveform and quickly access your favorite settings for plugins, tracks, clips, groove just to name a few!
Chapter 43 - Plugin Racks

Plugin Racks are an amazing and flexible feature of Waveform for both mixing and creative sound design. Racks allow you unlimited options to wire together series and parallel combination of plugins and virtual instruments.

Example Plugin Rack - Phased Delay Preset

On the surface, you use a Plugin track just like any other plugin. However since you can use the same instance of the plugin on multiple tracks you can do very interesting routing with them. They are also the key to setting up multiple output instruments when you want to mix the outputs on separate channels.

Inserting Plugin Racks

You can insert Plugin racks in all the ways you would insert normal built-in or third party plugins. Drag them in from the plugin object, click the plus (+) on the Mixer plugin section, or right click an existing plugin and select Add new plugin.
Inserting a Plugin Rack

You may start with an empty rack or load a preset. Saving and re-using customized racks is a powerful way to speed up music production and mixing. Waveform comes with some cool presets to get you started.
Plugin Rack Presets

Hide/Show Rack Panels

Plugin racks include input, output, and Properties panels that you can hide or show from the icons at the top. Properties is integrated directly into the Plugin rack window. This is very useful if you are using the rack editor in a large view or on a separate monitor.
Properties

To start getting familiar with the Plugin rack layout, load the *Phased Delay* preset. Open both the inputs panels and the Properties. Clicking different objects and areas of the screen reveals different sets of properties.

Plugin Properties

Click any of the plugins used in the rack to see its parameters in Properties. In use, this is how you tweak and program a Plugin rack when mixing or designing a rack from scratch. Later we will talk about patching wires between the plugins, Assuming that is already done, you can set the values for the component plugins by opening the Plugin rack, clicking a plugin and adjust the values.
Preset racks usually include a text plugin that explains more about the rack and how to use it. It’s a great idea when creating your own racks to put in a text plugin to explain what it does and how it works.

**Rack Properties**

Click the background between the plugins and wiring to select the rack itself and see the Plugin rack Properties.
Rack Shown Selected and its Properties

Use these properties to rename the rack and work with presets. You can also add input and output pins as we will explain in a bit.

**Track Properties**

With the inputs and output shown click to select the track. This shows the track properties. Here you can work with routing and adjust the input and output gain levels for the rack.

*Note:* A single Plugin rack instance can reside on more than one track. In that case the other tracks will appear here as well so you can visually patch the routing. This is a more advanced feature that we will get to later.

**Starting with an Empty Rack**

Making your own rack with a chain of effects is quite simple. Drag in the Plugin object and select *Plugins Racks > Create New Empty Rack*. Double-click to open the new empty rack.
Add a plugin to your empty rack. Drag the plugin object from the upper right corner and drop it on the workspace.

As you drop the plugin, a dialog appears with two choices *Auto-connect* or *Leave Unconnected*. Choose *Auto-connect* to automatically route the left and right signals from the input, to the plugin, then from the plugin to the output. This sets it up to immediately work on the track. You can also route MIDI to and from the plugin.

Racks use virtual patch cables to connect the left and right audio signals to plugins. When you drop in a single plugin and select *Auto-connect*, these essential cables get wired up automatically. You can change these around or draw them in yourself and we'll talk about that shortly.
An EQ Plugin with Cables Auto-connected

Note: Even if the plugin doesn’t specifically use MIDI, it’s a good idea to route the blue virtual MIDI connection through it. Not doing so can negatively affect plugin delay compensation.

Working with Virtual Patch Cables

If you add plugins to your rack unconnected, you can draw in virtual patch cables to complete it. Patch cables connect between pins. The pins start with the input to the rack. By default there are three input pins: MIDI, audio left, and audio right. Here are the basics for working with virtual patch cables:

Pins  Pins appear as dots in the rack editor. The left pins connect from the track or previous plugins to the rack then through your wiring and plugins from left to right. There are input pins, plugin pins, and output pins.

Connecting Virtual Patch Cables
To draw in the virtual patch cables, drag from one of the input pins and drop on a plugin pin. As you drag the patch cable appears. When you drop on the connection pin the cable sticks to that pin making the connection. Once connected, you can even drag the plugin around on the screen and the cables stay connected as if they are flexible and stretchy.

Disconnecting a Virtual Patch Cable
To disconnect a patch cable, grab the cable from the wire part and pull it free. If you drop it away from another pin the cable will disappear, effectively deleting it. You can also drag it to
a different pin to change the routing. The wire will disconnect on the end nearest to where you grab it.

Tip: Don’t grab the cable exactly on the pin to disconnect it; grab from the wire part. If you grab from the pin you start drawing in a new patch cable.

Once your plugin is wired up, you can drag the plugin around in the rack workspace all the patch cables will stay connected. As you create more complicated setups with more plugins this allows you arrange the plugs in and wiring in an organized way.

Creating a Chain of Plugin Effects

To create chain of plugins, drag in all the plugins you want and wire them up in order. If you start with the the first plugin Auto-connected, additional plugs will be dropped in with no connections. You will need to detach some patch cables from your first plugin and wire into the next one. Drag the plugins around to organize the view to your liking.

Tip: It’s a good idea to add text plugin to your rack. Add a text plugin then change the name to “Read Me” or something similar. Describe how to use the rack in the Description property.

Note: In the diagram above, notice that the blue MIDI connection is connected through all the plugins. This helps with plugin delay compensation.
Creating a Parallel Effects Setup

Plugin racks allow you to do something you can’t with normal insert effects in other DAWs - you can create combinations of series and parallel effects. This is great for many applications and particularly good for crafting effects for lead vocals or solo instruments without worrying about setting up busses in the Mixer.

To set this up, drag in several effects then draw in all the patch cables as described earlier. Since any pin can have multiple connecting cords, you can wire the input to several plugins.

![Rack With Parallel Effects](image)

This example is a set of lead vocal effects that includes delay and reverb running in parallel. In addition, we added a volume and pan plugin to mix back in some of the dry signal. The two plugin effects are set to pass 100% processed signal. We have assigned Wet level to the quick control for each plugin. We have also added a parallel Volume and Pan plugin to use to mix in some of the dry signal.

Working with Presets

Plugin racks allow you to save, load, and manage presets just like you can for any other plugin. The important thing is that the preset is the entire rack configuration. This allows you reuse common chains of effects for tasks like processing vocals, guitars, or drums. It is also great for loading combinations of virtual instruments and effects setups with stacked virtual instruments.

Saving a Preset

To save a preset, click the background of the rack to select it. In Properties at the lower left
click the *Save* button. Now select from an existing preset to save over, or create a new one.

![Saving a Plugin Rack Preset](image)

**Loading a Preset**
You can load a preset into an existing rack by clicking *Load* in Properties for the rack. Click in the background of the rack to selected it, then click *Load* and choose from available presets.
Loading a Plugin Rack Preset

Deleting a Preset

To delete a Plugin rack preset click *Del* in the Properties for the rack. Choose one of your presets to delete and it goes way.

*Note:* There is no confirmation for deleting Plugin rack presets. So be sure that’s what you want to do before clicking *Del.*
**Import/Export**

You may have noticed that the *Save* button includes an *Export* option. This saves your rack preset details to a file that you can later load into another installation of Waveform or share with others. The file has the `.trkrack` extension.

**Plugin Rack Editor Properties**

In addition to preset management, plugin rack Properties includes many addition parameters and actions that give you great flexibility when working with racks. Here is a run down of those parameters and actions:

**Name**

Click on the *Name* value to edit the name of the Plugin rack.

**New Input Channel**

Add an input pin at the left. Then add virtual wires from inputs to plugins in the rack editor.

**Delete Input Channel**

Remove an input pin on the left that is not needed.

**Rename Input Channel**

Customize an input pin name based on how it’s used. You can make the names more concise or descriptive if you like.

**New Output Channel**

Just like for the input, you can add extra outputs to route the signal flow to different or multiple tracks.

**Delete Output Channel**

If you wind up with extra, unneeded output pins you can delete them. Click *Delete Output Channel* and the extra pin goes away.
**Rename Output Channel**
You can give the outputs a custom name if you want. This name appears when you hover the pointer over the output pin. It also appears on the Properties for the racks’s track inputs and outputs.

**Drag to Insert Rack**
Use the Plugin object that resides in Properties for the rack to insert an instance of this rack onto a track in the arrangement or the Mixer.

## Track Input & Output Properties

You can set routing, balance the input and output levels, and set the overall wet dry mixing for a Plugin rack using the track Properties from the Rack editor. You can also access these settings from Properties in the Controls panel for the rack in the arrangement or Mixer.

**Note:** You can edit a rack name from here as well. This is repeated from the Plugin rack editor Properties.

![Plugin Rack - Track Input & Output Properties](image)

**Input/Output Routing**
You can set the routing from tracks to the input pins of the rack using these settings. You can also do this graphically if you have the side panels open on the Plugin rack editor. Adjusting routing graphically works just like explained for the main rack editing panel.

**Input/Output Levels**
Adjust the input and output levels with separate control for left and right. This is done per track first select a track in the side panel of the Plugin rack editor to choose which track to work with. You can also make this adjustments graphically by clicking on the track input and adjusting the popup horizontal fader. Use the *Link Inputs* and *Link Outputs* buttons to adjust left and right together.
**Wet & Dry**

Normally the *Wet* value is turned all the way up and the *Dry* value turn all the way down. All the signal passes through the rack. It is possible to mix some of the dry signal with the signal being processed by the rack. The *Wet* and *Dry* faders allow you to do that.

*Note:* Racks can get pretty complicated with both the routing and plugin delay compensation. Generally it’s better to set up the wet/dry mix within the rack design than use the *Wet* and *Dry* faders in Properties.

**Virtual Instruments in Racks**

When you place virtual instrument (VI) plugins in a rack you connect it so that the MIDI data comes in and audio goes out.

**Stacked Instruments**

You can connect one or more VIs in parallel to create stacked instrument sounds. By stacked we mean that more than one synth is played from the same MIDI performance data.
Combining Instruments with Effects

Use the flexible nature of racks to create any combination of virtual instruments and effects.

Using a Rack with More than One Track

When you copy a Plugin rack from one track to another you are not actually duplicating it, you are adding the same rack to another track.
Warning: Copying a Plugin rack from one track to another does not duplicate the rack, it adds the same instance of the rack to the new track. This combines the signal through the same plugin. This is a common point of confusion when working with racks. To avoid this problem, duplicate your rack setup by saving it as a preset then load the preset to the other track.

That fact that you can have the same instance of a rack on multiple tracks allows for flexible and advanced routings. It can be helpful for setting up sidechains with in a rack and is also used when setting up virtual instruments with multiple outputs.
**Rack for Multiple Output Virtual Instruments**

The most common benefit to use the same instance of a Plug rack across multiple tracks is then you want to use a multi-output virtual instrument AND you want to run those outputs to separate channels for mixing. This is a common scenario with drum instruments in particular.

There is a complete walkthrough of configuring a rack for a drum instrument in the next chapter - Chapter 44 - Multiple Output Instruments

**Sidechain Routing**

If you are using plugins that have side chains inputs within a rack, you can copy the instance to the source track to route as a sidechain source.

![Using a Rack for Sidechain Routing](image)

**Note:** For normal sidechain setups, plugin windows include a sidechain input selector at the top left. You don’t need to use a rack to route your side chain unless you want to create a more complex set or preprocess the side chain. For more on this see Chapter 29 - Using Plugins
Learning More About Plugin Racks

Plugin racks could fill an entire volume and the uses and possibilities are endless. To explore racks further, check out this video series at Groove 3 called Tracktion Plugin Racks Explained\(^\text{51}\). The series covers all the essentials of creating effects chains as well as using racks to route multi-output virtual instruments to separate tracks.

Additional information on racks is covered in the series in the Groove 3 series Tracktion T7 Update Explained\(^\text{52}\).

Those two resources along with this chapter should get you well on your way to understanding how to use racks in your projects.

Moving On

Racks are an incredible, powerful feature of Waveform. Even though it is an advanced feature, you can get started easily because you combine plugins and routing visually.

\(^{51}\text{https://www.groove3.com/Tracktion-Software-training-video-tutorials/Tracktion-Plugin-Racks-Explained}\)

\(^{52}\text{https://www.groove3.com/Tracktion-Software-training-video-tutorials/Tracktion-T7-Update-Explained?itemid=10016}\)
Chapter 44 - Working with Multiple Output Instruments

In Waveform, Plugin racks are used to configure multi-output instruments to route the outputs to different tracks or channels in the mixer. This chapter is a walkthrough of setting it up with a virtual drum instrument.

We are demonstrating with the free [MTPower Drum Kit](http://www.powerdrumkit.com) but the setup works in a very similar way with EZ Drummer or any number of other similar drum instruments.

Overview

With this set up we will create a rack to hold the virtual instrument then copy that rack to a series of tracks, one for each stereo output. We will also use a Submix track to hold the entire setup.

---

53. [http://www.powerdrumkit.com](http://www.powerdrumkit.com)
Step by Step

Here is how to set it up:

1. Create tracks for all the outputs you want to mix separately. In this example we are using Kick, Snare, HH, Toms, OH, and Room. Here you see the track as channels in the Mixer. It’s easy to rename them from this view by double-clicking the name at the top of each channel.

   ![Naming the Drum Channels](image1)

2. Move all these tracks to a Submix track. To do that, select all the tracks - click the first track, hold shift while clicking the last track. Then in Properties click Create Submix Containing.

   ![Creating the Submix to Hold the Instrument Output Channels](image2)

3. Name the newly created Submix “Drums.” The Submix gives you an overall level for the instrument and the ability apply effects to the drum mix if you like.
4. Create a new empty rack on the first track and rename it appropriately. You can do this from either the in-line Mixer or the Mixer view.

5. Add MT Power Drum Kit to the rack and allow it automatically wire the plugin.
6. Copy this instance of the rack to all the other drum tracks by dragging while holding Cmd / Ctrl.
Wiring the Rack

When you get to this point, the routing in the rack won’t make much sense. The next step is to sort the output routing. Our plan is to route our available drum sounds to the six tracks we defined earlier.

Note: Keep in mind that all tracks and mixer channels in Waveform are stereo. Typically outputs for drum instruments like this are also stereo so we will be routing left and right pairs for each type of drum.

1/. Clear all the output wiring by pulling all of the wires free from track outputs in the right side panel. The result should look like this:
2. Now connect pairs of outputs to each track output. There will be some extra because we are only connecting six stereo pairs to match up to our six stereo tracks. Here is the resulting routing:
Note: MT Power Drum Kit has sixteen outputs configured as eight stereo pairs. If you use another virtual instrument it will probably have different numbers of outputs.

3. By default MT Power Drum Kit mixes all the drums to the first stereo output. We want to change this and route out to our six stereo tracks. We do this assignment in the mixer for the plugin. This will look a bit different in other drum instruments but the idea is the same. In MT Power Drum Kit, the outputs are numbered by stereo pair. The next image shows the setup.
MT Power Drum Kit with the Outputs Assigned to Our Six Stereo Tracks

At this point the configuration of the rack is finished. If you want you can clean it up by removing unused input and output pins and also the audio input routings which are not needed. Here is the resulting rack:

Using the Plugin Rack Drum Instrument

Record or Program MIDI

Record MIDI clips in the normal way on any of the tracks and the drums will play to the different outputs based on what assignments we made before. You can play from a keyboard or program the notes onto a blank clip. Using a Step clip is a great way to test the setup. Just Drag a new Step clip to one of the tracks and start programming a beat.
Using a Step Clip to Drive the Drum Rack Setup

Mixing

Now we can mix using faders and plugins on drums just like mixing a multi microphone live recording. Control the level of the entire drum part using the Submix track fader.
Mixing the Drum Output Channels

Processing the Submix

If you like you can apply limiting, compression, or tape emulation to the Submix. Here we have renamed it Drums and applied bus compression.
Moving On

When setup this way you have flexible control over multiple output virtual instruments. By containing all the tracks used for the outputs in a submix you can control the entire level from a single fader and even collapse it to one track when working on another aspects of your song.
Chapter 45 - MIDI Pattern Generator

Waveform has many features that fall into the broad category of musicality functions. Of those, the pattern generator for MIDI clips has the richest set of tools. That’s what we will be covering in this chapter.

To locate the pattern generator feature, select a MIDI clip and notice the Pattern Generator tab in Properties.

The pattern generator will assist you when composing arpeggios, chords progressions, baselines, and melodies. It helps you build chord progressions then gives you suggested notes and chords that you can use as a starting point for further development.

Generating Chords & Progressions

To get started, set up a track with a virtual instrument and drag in a blank MIDI clip. With the clip selected click on the Pattern Generator tab in Properties. Select Chords from the Pattern Style list.

This will reveal the full set of actions and properties for working with chords and progressions.
Choosing the Fundamental Parameters

If you just play around with these properties you will start to generate chords in your blank MIDI clip. Let’s walk through what these are for so you can get more predictable results - starting with the musical properties.

**Key**  
Click Key to choose from a list of keys for your chord progression. If you choose Global Track, Waveform will use the key assigned in the Tempo track.
Octave
The octave value determines which register for the chord notes. The default is 4 which puts the chords toward the center of the range on a piano. Lower values will give you lower registers. Higher values will give you higher pitched chords.

Velocity Scale
This value sets the MIDI velocity for all the notes in the chords. This value is in percent so 100 means 100% which translates to a MIDI velocity of 127.

Note: All generated notes will have the velocity you set here. If you want some variation you can do that by editing the notes later. The MIDI note action Modify Notes > Randomize Velocity might be a good way to do that.

Gate Gate sets the note length in percent. At 100 notes will hold out until the next note starts - typically giving you a legato feel. Shortening this value will make the notes shorter giving a more staccato feel.


**Chord Preset**

You can choose from presets that apply rhythmic patterns to the chords. This makes more sense after you have generated some chords. We will come back to this a bit later.

**Entering Chords**

You can enter chord progressions three different ways. Chords typically entered by number rather than by letter names. For example you would enter I, iii, IV, V independently of the key. This makes it easy to see the chords role in the progression in a way that doesn’t change if you decide to change the key. You can alternatively enter chords by letter number using the Custom Chord option.

![Generated Chords from a Simple Progression](image)

**Entering Chords**

To enter a chord click the plus icon in the progression area of the Pattern Generator tab in Properties for the MIDI clip. Select a chord number from the list. The list includes three-note chords (I, ii, ii, IV, etc) and four note 7th chords (I, ii7, iii7, IV7, etc.) As you add chords to the progression, the MIDI notes that make up each chord will be automatically drawn into the clip.
Chord Suggestions
If you want help determining which chord to select next, refer to the Suggestion area to right of the progression. This list suggests the most likely next chord based on music theory and statistics. When entering chords like this, all chords will be in the correct key so feel free to experiment.

Custom Chord (Adding a Specific Chord)
If you want to directly enter a chord by letter name and formula click the plus icon and select
Custom Chord. From here navigate through the chord root and then choose the exact chord you want. Custom chords are fixed, meaning they won’t change if you update the key.

Add a Specific Chord

Choose Popular Progressions
Another way to enter chords is to start from a pre-defined progression. Choose from popular three chord or four chord progressions by clicking the *Preset * option.
Choose from Popular Progressions

Choose Preset Progressions
You can also choose preset progressions from the menu on the preset button. By default the list contains some well known songs. You can also save your own presets here using Save as Preset.
Choose from Preset Song Progressions

- 16 Bar Blues
- 50s
- All the Small Things
- Awesome
- Basket Case
- Believing
- Black Magic Woman
- Blues
- Call Your Girlfriend
- Cannon
- Descending Flamenco
- Effective
- Fool on the Hill
- Free Fallin
- Game of Thrones
- Good Love
- Humoresque
- Jambalaya
- Jazz
- La Bamba
- Like A Rolling Stone
- Montgomery-Ward bridge
- Passamezzo antico
- Sensitive
- Shake It Off
- Smoke
- Sweet Home
- Test Progression
- The Weight
- Timeless

Save as Preset...
Delete Preset...
Using Chords from Other Clips

If you have already put together other MIDI clips with chord progressions you can copy the progression to a new clip. To do so, click the menu icon for the progression and select Other clips. From here you pick from any other clips in the Edit that have a chord progression. When you select one of the clips, Waveform copies the chord progression to your new clip.

![Copy a Chord Progression from another MIDI Clip](image)

Working with Chords

Getting a progression entered and some generated chords is just the starting for composing a song or part. Open the MIDI editor by double-clicking on the header for the MIDI clip. Notice along the lower edge, the chords for the generated progression are shown. At first these are shown one chord per bar but you can change that which we will explain shortly.

![Chord Progression Shown in MIDI Editor](image)

You can work with the chords using several tools integrated into the chord progression as it appears along the bottom of the the MIDI editor. The first thing you will notice is that the exact chord names are shown here. You can use this as a reference when adding other live instruments like guitar or bass to your song.
Chord Tools in the MIDI Editor

Inversions
The chord generator enters chord notes into the MIDI clip with the notes stacked with the root note at the bottom. To make a smoother progression, you will likely want to try other chord notes as the lowest. The variations of the note stacking order are called inversions. Shift-click the up/down icons at the right of each chord to try other inversions.

Tip: You can try inversions with keyboard shortcuts too. Select all the notes in the chord and pressCmd + T / Ctrl + T to up through inversions. Press Cmd + Shift + T / Ctrl + Shift + T to move down through inversions.

Adjust the Length of Chords
Drag the divider between chords in the MIDI editor to adjust the start time and chord length for the progression. As you drag, realize that it will affect the timing of the rest of the progression. For example if you drag the start of a chord a beat earlier, you might want to adjust the ending so the next chord starts on the down beat of the next bar.

Trying other Chords
Click the arrow icons at either end of the chord range to cycle through the chord choices for the key. If you entered chords using the Custom Chord menu, you can increment to the next root note by shift-clicking the arrow icon. At any time, you can just click the chord in Properties and pick a different one from the list.
Removing Chord
To remove a chord click the chord in Properties and select Remove.

Removing a Chord

Duplicating a Chord
If you want a chord to play for an extra bar you might want to duplicated it. To duplicate a chord click the chord in Properties and select Duplicate.

Changing Chord Order
As you build out the progression, you can change the order of the chords using drag and drop. Drag any chord and drop it to a new place in the progression. The other chords will move to make room.

Auto Update
With Auto update enabled, each change you make to the progression or its parameters will immediately generate a new set of MIDI notes in the clip. If you start to manually edit or move note around, Auto update becomes disabled so progression changes don’t accidentally wipe out your changes. If you want to regenerate the progression turn Auto update back on.

Auto Update for Chord Generator

Note: Enabling Auto update will over-write any direct changes you have made to MIDI notes in the clip.
Adding Rhythm to Chords

You can use all of the available MIDI editing tools and techniques to add rhythm to the notes in your progression. We find that *Modify Notes > Split notes* action is particularly useful to subdivide notes - say you want to quickly change from whole note chords to quarters, eighths, or sixteenths. Just select the notes of the chord and press Cmd + slash / Ctrl + slash a few times.

Applying a Chord Preset

You can also pick a chord preset that contains rhythmic patterns and apply it to your progression. Click on *Chord Preset* in the Pattern Generator tab of Properties for the clip to see the list of preset patterns.

Pick a preset from the list. You can keep trying them to until you find something interesting or something that fits your song.
Chose a Chord Preset to Add Rhythm to the Progression

Progression with Trance 1 Chord Preset Applied

Managing Chord Presets

Back in the Pattern Generator tab of Properties, click the menu icon on the right end of the *Chord Presets* button to access addition options to import, export, or delete chord presets.
Create Chord Presets

You can easily create your own chord presets. Select any set of MIDI notes that contain the rhythm you might like to apply to chords progressions. In Properties for those notes, click Create Preset > Create Chord Preset. You will be prompted to name the chord preset. After you have done that, it will appear in the chord preset list ready to use.

Generating Basslines

The process of generating a baseline is nearly identical to that of chords. If you started reading here then go back and read the section on generating chords because we won’t repeat it all! The biggest difference is that you select Baseline for the Pattern Style in the Pattern Generator tab of Properties.
Select Bassline to Generate Bassline Notes in a MIDI Clip

You will have all the same options for selecting the key, scale, and apply presets. Initially the generated baselines will be very simple just following the root of the chord progression. Adjust the Octave value to put the bass notes in the correct octave. Adjust the Gate value to set the note length.

Simple Bassline

If you already created a clip with the chord progression, you might want to quickly just copy the progression to the baseline clip. We went over that before but here it is again. Click the menu icon for the progression and select Other clips. From here you pick from any other clips in the Edit that have a chord progression.
Copy the Chord Progression from another MIDI Clip

To make your baseline more interesting, try loading a Bass Preset from Properties. Bass presets apply both rhythmic and pitch variations to the baseline pattern. Many of the presets will simply apply rhythmic patterns to the root note. Some of the presets also contain scale patterns or even harmony. When you apply these, Waveform will make sure the pitch snaps properly to the key and chord.

Bass Preset: Complex 1

Bass Preset: On Beat Arp

Saving bass presets works just like it does for chords. Refer back to that section if necessary. You can create a bass preset from any selection of notes. If you customize these presets for your style of music you can really speed production and songwriting.
Generating Melodies

The pattern generator for melodies generates notes for the chord or scale that represent what are essentially “safe” notes in the key. The trick is that the notes generated are initially all muted. You use the MIDI note mute tool to un-mute the ones you to use. Waveform doesn’t generate the actual melody for you but instead assists you with suggested notes that you can turn on or off.

To start, select a blank MIDI clip and go to the Pattern Generator tab in Properties. Select Melody for the Pattern Style. Adjust the values for Key, Scale, Octave, and Velocity Scale.

Set Note Length in musical divisions. For example if you set it to 1/4 your melody will be divided into quarter notes which will be 4 notes per bar in 4/4 time. Adjust Gate to shorten the note lengths - just like for chords or baselines discussed earlier.
At this point Waveform shows you a grid-like series of muted notes. Use the mute brush tool in the MIDI editor to toggle the mute state of the notes presented. This allows you paint in a melody using only “safe” notes.
A melody will start to emerge. Feel free to loop playback over the selection as you try out different notes. Turn on and off notes with the mute brush or just swipe across a range of notes to toggle them.

When you are happy with the melody, you might want to delete the extra muted notes. To do that select any note in the clip using the arrow tool, then in Properties click Select Notes > Select all muted notes in the clip. Press Delete to remove the extra notes.
Select Muted Notes and Delete Them

This leaves you with a MIDI clip containing only the melody you created.

From here, you might continue to edit the melody -possibly adjusting note timing, lengths, and velocity.

Initially, the medley generator will suggest only the notes that are in the chords of the progression. If you want to work with all the notes in the scale, you can by enabling *All notes in key* on the Pattern Generator tab for the clip.
Generating Arpeggios

An arpeggio, in musical terms, is a chord played in a pattern one note at a time. Arpeggios are used in virtually all kinds of music from classical to modern dance styles. The Waveform arpeggio generator is particularly powerful and interesting. It gives you a tremendous amount of arpeggio shapes along with an easy way to visually select and audition them.

The starting point is similar to the other types of patterns - create a blank MIDI clip then in Properties go to the Pattern Generator tab. Next, select Pattern Style: Arpeggio and set the Key and Scale.
Arpeggio Parameters

As soon as you have the basic parameters set, Waveform will generate the notes for the arpeggio. Most these parameters are the same as for the other kinds of patterns. Let’s go over those there are unique to arpeggios.

**Pattern Length**

Set *Pattern length* to number beats for one cycle of the arpeggio to play. If you want the arpeggio to play out over one bar of music then set it to 4 assuming your time signature is 4/4. If you set it to 1 then it will cycle through the notes much faster - four times per bar in this case.

**Steps**

Set *Steps* to the number of notes you want to play in one cycle of the arpeggio. You can see here that the values can be between 2 and 8.
Steps Sets the Number of Notes in the Arpeggio

Up/Down

Enable *Up/Down* to mirror the arpeggio. Whatever you have the arpeggio shape set to it will repeat using the opposite note order.

Arpeggio
Note: Enabling *Up/Down* effectively doubles the number of steps in the arpeggio. As a result the notes will play twice as fast when enabled. If you want the notes to play at the same rate, then double the pattern length when you enable *Up/Down*.

Play root note

With *Play root note* enabled the root note of each chord is held out out during arpeggio. This is useful in many situations when you really want to express the the fundamental strongly. If you don’t like or need this, disable *Play root note*. 
Arpeggio Style (Shape Thumbnails)

When you change the various parameters for arpeggios, Waveform calculates the possible note sequences and shows you thumbnail shapes of the possible arpeggios. Click on any of them to try out arpeggio patterns. This is a fast and fun way to get creative inspiration.

Click Style Thumbnails to try out Arpeggio Shapes Shapes

Moving On

1. The pattern generator features a powerful set of musicality tools that can really aid in composing any style of music. You need to provide your own taste and editing, while Waveform serves as a creative partner offering up ideas for you to build upon. And as a reminder, Waveform also features other musical tools including the chord player plugin, the chord entry menu for MIDI notes, and the identify key function for MIDI clips.
Appendix A - Video Links

Listed below are links to helpful Waveform videos. Many are now featured on the Waveform website and YouTube. For a complete commercial video series on T7 new features, check out Tracktion T7 Update Explained from Groove3.com.

54https://www.groove3.com/Tracktion-Software-training-video-tutorials/Tracktion-T7-Update-Explained
Creating a Tempo Map
Punch In/Out on the fly
Tracktion Compressor Sidechain
Track Tags
Automation Improvements
Insert Plugin
Creating a Submix
Basic Audio Editing
Warp Time
Pitch Fade
Comp Groups
Merge Selected Clips
Step Clips Overview
Step Clips Velocity/Gate
Step Clips Randomize Each Step
Step Clips Groove
Step Clips Route Channels to Different Synths
Drag to Set the In-marker and Out-marker
Track LFOs Demonstration
Sync Preview with Multiple Browsers
How to Invoke Melodyne
Automation Patterns and Ramps
Appendix B - Keyboard Shortcuts

macOS Default Keyboard Shortcuts

These are the standard keyboard short Waveform shortcut assignments for macOS

General

<table>
<thead>
<tr>
<th>Description</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flip between edit/project screens</td>
<td>F3</td>
</tr>
<tr>
<td>Go to project screen</td>
<td></td>
</tr>
<tr>
<td>Go to edit screen</td>
<td></td>
</tr>
<tr>
<td>Go to settings screen</td>
<td>F2</td>
</tr>
<tr>
<td>Save the current edit</td>
<td>Cmd + S</td>
</tr>
<tr>
<td>Save the current edit as</td>
<td>shift + Cmd + S</td>
</tr>
<tr>
<td>Quit the application</td>
<td>Cmd + Q</td>
</tr>
</tbody>
</table>

Help

- Show Tracktion’s help documentation
- Enable/Disable the popup help
- Show popup help for whatever the mouse is currently over

Transport Controls

<table>
<thead>
<tr>
<th>Description</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start/stop playing</td>
<td>spacebar</td>
</tr>
<tr>
<td>Abort current recording, discard anything recorded, and restart</td>
<td>Arm or disarm all input devices</td>
</tr>
</tbody>
</table>
Appendix B - Keyboard Shortcuts

Moving/Zooming Controls

| - | Move cursor to start of marked clips or edit home, | | Move cursor to end of marked clips or edit end |
| | Scroll up to top of tracks | | Scroll down to bottom of tracks |
| | Move to the previous marker | * | Move to the next marker |
| | Scroll tracks up | | Scroll tracks down |
| | Scroll tracks left | | Scroll tracks right |
| | Vertical zoom-in | | Vertical zoom-out |
| | Select the item above the current selection | | Opt + up arrow |
| | Select the item below the current selection | | Opt + down arrow |
| | Select the item to the left of the current selection | | Opt + left arrow |
| | Select the item to the right of the current selection | | Opt + right arrow |
| | Zoom in | | Zoom out |
| | Zoom in to show a few seconds around the cursor | | F5 |
| | Zoom in to show the marked region | | F7 |
| | Zoom to show the selected clips | | Shift + N |
| | Expand or contract the current track height | | Z |
| | Rescale all tracks to fit on-screen | | F6 |
| | Set all tracks to the default track height | | Shift + Z |
| | Expand or collapse folder track | | Show or hide the big input-meters |
| | Show or hide the inputs section | | Shift + Opt + Cmd + X |
| | Select all | | Deselect all |
| | Undo | | Redo |
| | Nudge selected clips left | | Nudge selected clips right |
| | Nudge selected clips up | | Nudge selected clips down |
| | Split selected clips at cursor | | Insert space in the marked region into Edit |
| | Move start of selected clips to the cursor position | | J |
| | Move end of selected clips to the cursor position | | K |
| | Auto-Crossfade selected clips | | X |
| | Mute selected clips | | E |
| | Group selected clips | | Ungroup selected clips |
| | Pitch up 1 semitone | | Pitch down 1 semitone |
| | Pitch up 1 octave | | Pitch down 1 octave |
| | Mute selected tracks | | Solo selected tracks |
| | Move selected clips to back of z-order | | Change selected plugin to its previous preset |
| | Change selected plugin to its next preset | | Change to the previous take for a looped clip |
| | Change to the next take for a looped clip |

Editing Functions

| - | Delete | delete, backspace |
| | Cut | Cmd + X |
| | Copy | Cmd + C |
| | Paste | Cmd + V |
| | Paste inserting | Cmd + I |
| | Duplicate | D |
| | Copy and paste selected clips directly into current edit | Delete the selected clips and their source audio files |
| | Select all | Cmd + A |
| | Deselect all | Esc |
| | Undo | Cmd + Z |
| | Redo | Cmd + Y |
| | Nudge selected clips left | Shift + left arrow |
| | Nudge selected clips right | Shift + right arrow |
| | Nudge selected clips up | Shift + up arrow |
| | Nudge selected clips down | Shift + down arrow |
| | Split selected clips at cursor | / |
| | Insert space in the marked region into Edit | Move start of selected clips to the cursor position |
| | Move end of selected clips to the cursor position | K |
| | Auto-Crossfade selected clips | X |
| | Mute selected clips | E |
| | Group selected clips | Ungroup selected clips |
| | Pitch up 1 semitone | Pitch down 1 semitone |
| | Pitch up 1 octave | Pitch down 1 octave |
| | Mute selected tracks | Solo selected tracks |
| | Move selected clips to back of z-order | Change selected plugin to its next preset |
| | Change selected plugin to its previous preset | Change to the previous take for a looped clip |
| | Change to the next take for a looped clip |
| | Reset all level meter overload indicators | \ |

| Lock/Unlock the properties panel | Insert a new MIDI clip into the selected track | G |
| Insert a new Step clip | Insert a new track into the edit | T |
| Insert a new folder track into the edit | Insert a tempo change at the current cursor position | Opt + T |
| Insert a time signature at the current cursor position | Opt + S |
| Insert a pitch change at the current cursor position | Opt + P |
| Import an audio or MIDI file | Launch an external wave editor for the selected clip |
| Show clipboard contents | Show the MIDI
controller mappings window | Show or hide the video window | Show the search side pane | Turn lock automation to clip on/off | shift + Cmd + A | Rename the selected track

Markers

| - | Set In-marker | I | Set Out-marker | O | Put the markers around the currently selected clips | A | Jump to the mark-in point | J | Jump to the mark-out point | T | Toggle the marker view mode | F10

MIDI Editor Controls

| - | Show or hide midi editor | ctrl + P | MIDI selection tool | Opt + Cmd + 1 | MIDI pencil tool | Opt + Cmd + 2 | MIDI eraser tool | Opt + Cmd + 3 | MIDI line tool | Opt + Cmd + 4 | MIDI melody paint tool | Toggle the ‘velocities’ panel in MIDI editor | Opt + Cmd + V | Toggle the ‘controllers’ panel in MIDI editor | Opt + Cmd + C | Mute/Unmute MIDI note echo in the MIDI editor | Opt + Cmd + E | Enable/disable step-editor mode | Opt + Cmd + S | Insert a rest when in MIDI step-entry mode | ‘ | Toggle auto display of MIDI toolbar | Opt + Cmd + T | Move midi notes up one octave | Cmd + O | Move midi notes down one octave | shift + Cmd + O | Nudge selected note start | left arrow | Nudge selected note start | right arrow | Nudge selected note end left | Nudge selected note end Right | Fit selected notes on screen | Cmd + F | Create Triad | Cmd + 3 | Create Seventh | Cmd + 7 | Invert Chord Up | Cmd + T | Invert Chord Down | shift + Cmd + T | Merge Notes | Cmd + M | Split Notes | Cmd + / | Randomise Velocity | Legato Notes | shift + L | Mute Notes

Windows Default Keyboard Shortcuts

These are the standard keyboard short Waveform shortcut assignments for Windows.

General

<table>
<thead>
<tr>
<th>Description</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flip between edit/project screens</td>
<td>F3</td>
</tr>
<tr>
<td>Go to project screen</td>
<td></td>
</tr>
<tr>
<td>Go to edit screen</td>
<td></td>
</tr>
<tr>
<td>Go to settings screen</td>
<td></td>
</tr>
<tr>
<td>Save the current edit</td>
<td>Ctrl + S</td>
</tr>
<tr>
<td>Save the current edit as</td>
<td>shift + Ctrl + S</td>
</tr>
<tr>
<td>Quit the application</td>
<td>Ctrl + Q</td>
</tr>
</tbody>
</table>

Help
Show Tracktion’s help documentation
Enable/Disable the popup help
Show popup help for whatever the mouse is currently over F1

Transport Controls

| - | Start/stop playing | spacebar | Start playing | Stop playing | Stop edit and loops playing | Forward right arrow | Back left arrow | Record | R | Abort current recording, and discard anything recorded | F4 | Abort current recording, discard anything recorded, and restart | Arm or disarm all input devices | Ctrl + R | Toggle safe record | Stop safe recording | shift + Alt + Ctrl + R | Panic reset the audio engine | Turn looping on/off | L | Turn snapping on/off | Q | Turn click track on/off | C | Turn punch-in on/off | P | Turn scrolling on/off | S | Turn MIDI timecode chasing on/off | Toggle timecode between bars/seconds | Turn playback-in-stop on/off | Punch out of automation record mode | U | Punch out of automation record mode, clearing any subsequent curve data | Ctrl + U | Toggle automation write mode | Y | Toggle automation read mode | H

Moving/Zooming Controls

| - | Move cursor to start of marked clips or edit home | W | Move cursor to end of marked clips or edit end | end | Scroll up to top of tracks | Ctrl + home | Scroll down to bottom of tracks | Ctrl + end | Move to the previous marker | * | Move to the next marker | = | Scroll tracks up | Scroll tracks down | Scroll tracks left | Scroll tracks right | Vertical zoom-in | Ctrl + down arrow | Vertical zoom-out | Ctrl + up arrow | Select the item above the current selection | Alt + up arrow | Select the item below the current selection | Alt + down arrow | Select the item to the left of the current selection | Alt + left arrow | Select the item to the right of the current selection | Alt + right arrow | Select the item at the top of the current selection | Alt + home | Select the item at the bottom of the current selection | Alt + end | Zoom out up arrow | Zoom out to fit the entire edit on-screen | F5 | Zoom to fit horizontally and vertically | N | Zoom in to show a few seconds around the cursor | F8 | Zoom in to show the marked region | F7 | Zoom to show the selected clips | shift + N | Expand or contract the current track height | Z | Rescale all tracks to fit on-screen | F6 | Set all tracks to the default track height | shift + Z | Expand or collapse folder track | Show or hide the big input-meters | F12 | Show or hide the inputs section | shift + F12 | Show or hide the filters section | M | Show or hide the left pane | B | Show or hide the control section | F11 | Show or hide the inputs, filters and controls | shift + F11 | Show or hide of the global track | F9 | Show or hide mixer panel | ctrl + M

Editing Functions

| - | Delete | delete, backspace | Cut | Ctrl + X | Copy | Ctrl + C | Paste | Ctrl + V | Paste inserting | Ctrl + I | Duplicate | D | Copy and paste selected clips directly into current edit | Delete the selected clips and their source audio files | shift + Alt + Ctrl + X | Select all | Ctrl + A | Deselect all | Esc | Undo | Ctrl + Z | Redo | Ctrl + Y | Nudge selected clips left | shift + left arrow | Nudge selected clips right | shift + right arrow | Nudge selected clips up | shift + up arrow | Nudge selected clips down | shift + down arrow | Split
selected clips at cursor | / | Insert space in the marked region into Edit | Move start of selected clips to the cursor position | J | Move end of selected clips to the cursor position | K | Auto-Crossfade selected clips | X | Mute selected clips | E | Group selected clips | Ungroup selected clips | Pitch up 1 semitone | Ctrl + = | Pitch down 1 semitone | Ctrl + * | Pitch up 1 octave | Shift + Ctrl + = | Pitch down 1 octave | Shift + Ctrl + * | Mute selected tracks | Shift + M | Solo selected tracks | Shift + S | Move selected clips to back of z-order | Shift + Alt + Ctrl + Z | Clear marked region of selected clips | Ctrl + K | Delete marked region of selected clips, and move up selected | Ctrl + L | Delete marked region of selected clips, and move up all on track | Ctrl + J | Enable/Disable selected plugins | F | Change selected plug into its next preset | , | Change to the previous take for a looped clip | Ctrl + , | Change to the next take for a looped clip | Ctrl + . | Reset all level meter overload indicators |

| Lock/Unlock the properties panel | Insert a new MIDI clip into the selected track | G | Insert a new Step clip | Insert a new track into the edit | T | Insert a tempo change at the current cursor position | Alt + T | Insert a time signature at the current cursor position | Alt + S | Insert a pitch change at the current cursor position | Alt + P | Import an audio or MIDI file | Launch an external wave editor for the selected clip | Show clipboard contents | Show the MIDI controller mappings window | Show or hide the video window | Show the search side pane | Turn lock automation to clip on/off | Shift + Ctrl + A | Rename the selected track

**Markers**

| Set In-marker | I | Set Out-marker | O | Put the markers around the currently selected clips | A | Jump to the mark-in point | [ | Jump to the mark-out point | ] | Toggle the marker view mode | F10

**MIDI Editor Controls**

| Show or hide midi editor | Ctrl + P | MIDI selection tool | Alt + Ctrl + 1 | MIDI pencil tool | Alt + Ctrl + 2 | MIDI eraser tool | Alt + Ctrl + 3 | MIDI line tool | Alt + Ctrl + 4 | MIDI melody paint tool | Toggle the `velocities` panel in MIDI editor | Alt + Ctrl + V | Toggle the `controllers` panel in MIDI editor | Alt + Ctrl + C | Mute/Unmute MIDI note echo in the MIDI editor | Alt + Ctrl + E | Enable/disable step-editor mode | Alt + Ctrl + S | Insert a rest when in MIDI step-entry mode | | Toggle auto display of MIDI toolbar | Alt + Ctrl + T | Move midi notes up one octave | Ctrl + O | Move midi notes down one octave | Shift + Ctrl + O | Nudge selected note start | Left arrow | Nudge selected note start | Right arrow | Nudge selected note end left | Nudge selected note end Right | Fit selected notes on screen | Ctrl + F | Create Triad | Ctrl + 3 | Create Seventh | Ctrl + 7 | Invert Chord Up | Ctrl + T | Invert Chord Down | Shift + Ctrl + T | Merge Notes | Ctrl + M | Split Notes | Ctrl + / | Randomise Velocity | Legato Notes | Shift + L | Mute Notes
Appendix C - New Features

New in Waveform 8 (2017)

- Mixer view that can be undocked to a separate tab or monitor
- MIDI Editor that can be undocked and enlarged
- Edit multiple over-layed MIDI clips
- Show a reference Waveform from an Audio clip
- Enhanced MIDI editing
- Note entry shortcuts
- Easy Velocity/controller shaping and scaling Assignable MIDI note split action
- Improved MIDI note expression editing and MPE generation
- Easy chord entry in the MIDI Editor
- MIDI musicality tools
- MIDI Chord Player plugin to simplify playing chords with using one or two notes
- Pattern Generator to aid in composing MIDI parts including melodies, chords, bass lines, and arpeggios
- Master Mix mastering plugin is directly integrated into Waveform
- FM Synth virtual instrument is directly integrated into Waveform
- Improved MIDI note expression editing and MPE generation
- Optimized user interface for improve look and responsiveness
- More color schemes
- Double the number of track and clip colors
- Clips can optionally follow track colors
- MIDI Key commands:
  - create triad chord: command + 3
  - create 7th chord: command + 7
  - invert chord up: + command + T
  - invert chord down: command + shift + T
  - fit notes: command + F
  - transpose up octave: command + O
  - transpose down octave: command + shift + O
  - merge notes: command + M
  - split notes: command + /
  - legato notes: shift + L
  - Keypad numbers to enter chord numbers
• Technical Improvements
• Improved crash recovery
• Automatic disabling of problematic plugins

**New in Tracktion T7 (2016)**

• New Interface Look
• Use Low-Contrast Interface
• Compact Toolbar - See Chapter 8
• Browser Position - See Chapter 9
• Multiple Browser Panes - See Chapter 9
• Synchronized Previews - See Chapter 9
• Quick Zoom Tool - See Chapter 5
• Project Tab Three Column View - See Chapter 5b
• Project Tab Edit Previews - Chapter 5b
• Project Tab Get Demo Songs - See Chapter 5b
• Drag to Set In-marker & Out-marker - See Chapter 10
• Automatically Hide and Show Panels - See Chapter 6
• Visual Plugin Selector - See Chapter 39
• Group Clips - See Chapter 12
• Linked Clips - See Chapter 12
• Automation Patterns - See Chapter 35
• Automation Ramps - See Chapter 35
• Plugin Sidechains - See Chapter 29
• First Run Setup Progress - See Chapter 2
• Scroll Behaviour - See Chapter 5
• Track LFOs - See Chapter 40
• Clip Layer Effects - See Chapter 41.
• Updated Plugin Racks - See Chapter 43
• Mastering with CloudBounce - See Chapter 36